Licensed Third-Party Technology Information

Certain PTC software products contain licensed third-party technology: Rational Rose 2000E is copyrighted software of Rational Software Corporation. RetrievalWare is copyrighted software of Convera Corporation. VisualCafé is copyrighted software of WebGain, Inc. VisTools library is copyrighted software of Visual Kinematics, Inc. (VKI) containing confidential trade secret information belonging to VKI. HOOPS graphics system is a proprietary software product of, and is copyrighted by, Tech Soft America, Inc. G-POST is copyrighted software and a registered trademark of Intercim. VERICUT is copyrighted software and a registered trademark of CGTech. Pro/PLASTIC ADVISOR is powered by Moldflow technology. Moldflow is a registered trademark of Moldflow Corporation. The JPEG image output in the Pro/Web.Publish module is based in part on the work of the independent JPEG Group. DFORMD.DLL is copyrighted software from Compaq Computer Corporation and may not be distributed. METIS, developed by George Karypis and Vipin Kumar at the University of Minnesota, can be researched at http://www.cs.umn.edu/~karypis/metis. METIS is © 1997 Regents of the University of Minnesota. LightWork Libraries are copyrighted by LightWork Design 1990-2001. Visual Basic for Applications and Internet Explorer is copyrighted software of Microsoft Corporation. Adobe Acrobat Reader is copyrighted software of Adobe Systems. Parasolid © Electronic Data Systems (EDS). Windchill Info*Engine Server contains IBM XML Parser for Java Edition and the IBM Lotus XSL Edition. Pop-up calendar components Copyright © 1998 Netscape Communications Corporation. All Rights Reserved. TECHNOMATIX is copyrighted software and contains proprietary information of Technomatix Technologies Ltd. Apache Server, Tomcat, Xalan, and Xerces are technologies developed by, and are copyrighted software of, the Apache Software Foundation (http://www.apache.org/) - their use is subject to the terms and limitations at: http://www.apache.org/LICENSE.txt. UnZip (© 1990-2001 Info-ZIP, All Rights Reserved) is provided "AS IS" and WITHOUT WARRANTY OF ANY KIND. For the complete Info-ZIP license see
ftp://ftp.info-zip.org/pub/infozip/license.html. Gecko and Mozilla components are subject to the Mozilla Public License Version 1.1 at http://www.mozilla.org/MPL/. Software distributed under the MPL is distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, either express or implied. See the MPL for the specific language governing rights and limitations. Technology "Powered by Groove" is provided by Groove Networks, Inc. Technology "Powered by WebEx" is provided by WebEx Communications, Inc. Acrobat Reader is Copyright © 1998 Adobe Systems Inc. Oracle 8i run-time, Copyright © 2000 Oracle Corporation. The Java™ Telnet Applet (StatusPeer.java, TelnetIO.java, TelnetWrapper.java, TimedOutException.java), Copyright © 1996, 97 Mattias L. Jugel, Marcus Meißner, is redistributed under the GNU General Public License. This license is from the original copyright holder and the Applet is provided WITHOUT WARRANTY OF ANY KIND. You may obtain a copy of the source code for the Applet at http://www.mud.de/se/jta (for a charge of no more than the cost of physically performing the source distribution), by sending e-mail to leo@mud.de or marcus@mud.de-you are allowed to choose either distribution method. The source code is likewise provided under the GNU General Public License. GTK+The GIMP Toolkit are licensed under the GNU LPGL. You may obtain a copy of the source code at http://www.gtk.org/, which is likewise provided under the GNU LPGL. zlib software Copyright © 1995-2002 Jean-loup Gailly and Mark Adler.

UNITED STATES GOVERNMENT RESTRICTED RIGHTS LEGEND
This document and the software described herein are Commercial Computer Documentation and Software, pursuant to FAR 12.212(a)-(b) (OCT'95) or DFARS 227.7202-1(a) and 227.7202-3(a) (JUN'95), is provided to the US Government under a limited commercial license only. For procurements predating the above clauses, use, duplication, or disclosure by the Government is subject to the restrictions set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software Clause at DFARS 252.227-7013 (OCT'88) or Commercial Computer Software-Restricted Rights at FAR 52.227-19(c)(1)-(2) (JUN'87), as applicable.

Parametric Technology Corporation, 140 Kendrick Street, Needham, MA 02494 USA
Contents

Change Record ........................................................................................................... xi

About This Guide .................................................................................................. xiii
  Related Documentation ........................................................................................... xiii
  Technical Support ................................................................................................... xiii
  Documentation for PTC Products .......................................................................... xiv
  Comments ............................................................................................................... xiv
  Documentation Conventions .................................................................................... xiv

Getting Started with Windchill ProjectLink ...................................................... 1-1
  Before You Begin .................................................................................................... 1-3
    Web Browser and Java Plug-In Version ................................................................. 1-3
    ActiveX Settings .................................................................................................. 1-4
    Pop-Up Blocker Interference ................................................................................ 1-4
    Bootstrap Loader Installation .............................................................................. 1-5
    Windchill Visualization Services ......................................................................... 1-6
    Available Software Downloads ......................................................................... 1-7
    Setting User Preferences ..................................................................................... 1-8
    Using Special Characters in Windchill ProjectLink .............................................. 1-14
  Initial Concepts ...................................................................................................... 1-14
    Projects ............................................................................................................... 1-15
    Project Actions .................................................................................................... 1-16
    Team and Role Management .............................................................................. 1-17
    Access Control to Project Information ............................................................... 1-17
    Communication and Collaboration ..................................................................... 1-20
    Subscriptions ....................................................................................................... 1-21
    Action Items ........................................................................................................ 1-21
    Meetings .............................................................................................................. 1-22
    Notebook ............................................................................................................ 1-23
  Advanced Concepts ................................................................................................ 1-23
    Document Management ...................................................................................... 1-23
    Visualization ....................................................................................................... 1-24
    Product Structure ............................................................................................... 1-24
    Workspaces ......................................................................................................... 1-24
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updating Quantity</td>
<td>4-12</td>
</tr>
<tr>
<td>Removing a Part from a Product Structure</td>
<td>4-12</td>
</tr>
<tr>
<td><strong>Visualizing Data in Windchill</strong></td>
<td>5-1</td>
</tr>
<tr>
<td>Overview</td>
<td>5-2</td>
</tr>
<tr>
<td>Accessing Visualization</td>
<td>5-2</td>
</tr>
<tr>
<td>ProductView Features</td>
<td>5-5</td>
</tr>
<tr>
<td>Viewing Data</td>
<td>5-5</td>
</tr>
<tr>
<td>Navigating ProductView</td>
<td>5-6</td>
</tr>
<tr>
<td>Annotating Files</td>
<td>5-7</td>
</tr>
<tr>
<td>Measuring Dimensions and Distance</td>
<td>5-7</td>
</tr>
<tr>
<td>Publishing Visualization Data to Windchill</td>
<td>5-8</td>
</tr>
<tr>
<td>Setting Preferences</td>
<td>5-9</td>
</tr>
<tr>
<td><strong>Working with CAD Data</strong></td>
<td>6-1</td>
</tr>
<tr>
<td>About CAD Documents</td>
<td>6-2</td>
</tr>
<tr>
<td>About the Workspace</td>
<td>6-2</td>
</tr>
<tr>
<td>Workspace Features</td>
<td>6-2</td>
</tr>
<tr>
<td>Workspace Configuration</td>
<td>6-3</td>
</tr>
<tr>
<td>Workspace Actions</td>
<td>6-4</td>
</tr>
<tr>
<td>Saving CAD Data to Windchill ProjectLink</td>
<td>6-5</td>
</tr>
<tr>
<td>Creating a Workspace for Your Context</td>
<td>6-5</td>
</tr>
<tr>
<td>Registering Your Server and Workspace in Pro/ENGINEER Wildfire</td>
<td>6-7</td>
</tr>
<tr>
<td>Setting Your Primary Server and Active Workspace</td>
<td>6-9</td>
</tr>
<tr>
<td>Creating CAD Documents with Pro/ENGINEER Wildfire CAD Data</td>
<td>6-12</td>
</tr>
<tr>
<td>Checking CAD Documents into Windchill ProjectLink</td>
<td>6-14</td>
</tr>
<tr>
<td>Creating Part Structures for CAD Data</td>
<td>6-16</td>
</tr>
<tr>
<td>Associating CAD Documents to Enterprise Parts</td>
<td>6-17</td>
</tr>
<tr>
<td>Setting the Preference to Display the Workspaces Sub-navigation</td>
<td>6-23</td>
</tr>
<tr>
<td><strong>Communication Tools In Windchill ProjectLink</strong></td>
<td>7-1</td>
</tr>
<tr>
<td>Communication Tools</td>
<td>7-2</td>
</tr>
<tr>
<td>Meetings</td>
<td>7-2</td>
</tr>
<tr>
<td>Subscriptions</td>
<td>7-5</td>
</tr>
<tr>
<td>Discussion Forums</td>
<td>7-6</td>
</tr>
<tr>
<td>File Routing Information</td>
<td>7-7</td>
</tr>
<tr>
<td><strong>Searching in Windchill ProjectLink</strong></td>
<td>8-1</td>
</tr>
<tr>
<td>About Search</td>
<td>8-2</td>
</tr>
<tr>
<td>About Keyword Searches</td>
<td>8-2</td>
</tr>
<tr>
<td>About the Advanced Search Page</td>
<td>8-3</td>
</tr>
<tr>
<td>Specifying Search Criteria</td>
<td>8-3</td>
</tr>
</tbody>
</table>
Exporting a Plan to Microsoft Project ................................................................. 9-52
Editing a Plan in Microsoft Project ................................................................. 9-52
About Project Templates .................................................................................. 9-54

Managing Context Teams .................................................................................. 10-1
About Context Teams ....................................................................................... 10-2
Creating and Modifying Teams ....................................................................... 10-2
Team Member and Group Information Pages .................................................. 10-4
Roles and Groups ............................................................................................. 10-4

Using Integrated Windchill Capabilities - Windchill ProjectLink and Windchill
PDM ................................................................................................................ 11-1
Overview ......................................................................................................... 11-2
Making PDM Data Available to Your Project Team ............................................ 11-3
  Sharing PDM Objects to a Project ................................................................. 11-4
  Refreshing a Project ...................................................................................... 11-7
  Checking Out PDM Objects to a Project ....................................................... 11-8
Using Actions and Icons .................................................................................. 11-11
Examining a Usage Scenario ............................................................................ 11-11
  Setting Up Your Environment for This Scenario ........................................... 11-11
  Task 1. Creating a Product From an Existing Product .................................... 11-12
  Task 2. Creating and Working in a Collaborative Project ................................ 11-25
  Task 3. Collaborating with an External Supplier ............................................ 11-28
  Task 4. Making Design Changes in the PDM System ...................................... 11-33
  Task 5. Updating a Collaborative Project ....................................................... 11-35
  Task 6. Reviewing Changes and Publishing Updates to the ERP System ........ 11-37

Using Integrated Windchill Capabilities - Windchill ProjectLink and Windchill
PDM ................................................................................................................ 12-1
Overview ......................................................................................................... 12-2
Making PDM Data Available to Your Project Team ............................................ 12-3
  Sharing PDM Objects to a Project ................................................................. 12-5
  Refreshing a Project ...................................................................................... 12-7
  Checking Out PDM Objects to a Project ....................................................... 12-8
Using Actions and Icons .................................................................................. 12-11
Examining a Usage Scenario ............................................................................ 12-11
  Setting Up Your Environment for This Scenario ........................................... 12-12
  Task 1. Creating a Product From an Existing Product .................................... 12-12
  Task 2. Creating and Working in a Collaborative Project ................................ 12-22
  Task 3. Collaborating with an External Supplier ............................................ 12-26
  Task 4. Making Design Changes in the PDM System ...................................... 12-31
  Task 5. Updating a Collaborative Project ....................................................... 12-33
Task 6. Reviewing Changes and Publishing Updates to the ERP System .................. 12-35

Available Project Templates ................................................................. A-1
Microsoft Project Object Mapping......................................................... B-1
## Change Record

### Table 1 Changes for Release 7.0

<table>
<thead>
<tr>
<th>Change</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, <em>Before You Begin</em></td>
<td>This new section discusses the steps you need to perform to successfully run Windchill ProjectLink on your local machine.</td>
</tr>
<tr>
<td>Chapter 1, <em>Using Special Characters in Windchill ProjectLink</em></td>
<td>This new section discusses the characters that should not be used when you enter information in Windchill ProjectLink pages.</td>
</tr>
<tr>
<td>Chapter 2, <em>Beginning a Project</em></td>
<td>This new chapter includes the basic concepts for beginning a project and setting up an initial team.</td>
</tr>
<tr>
<td>Chapter 3, <em>Managing Documents</em></td>
<td>This new chapter describes the functionality used to create and manage documents. It also explains the new Windchill Desktop Integration functionality.</td>
</tr>
<tr>
<td>Chapter 4, <em>Managing Parts and Product Structures</em></td>
<td>This new chapter describes the functionality used to create and manage parts and product structures.</td>
</tr>
<tr>
<td>Chapter 5, <em>Visualizing Data in Windchill</em></td>
<td>This new chapter discusses the visualization features available in Windchill.</td>
</tr>
<tr>
<td>Chapter 6, <em>Working with CAD Data</em></td>
<td>This new chapter explains using the HTML user interface to manage CAD data.</td>
</tr>
<tr>
<td>Change</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Chapter 7, <strong>Communication Tools In Windchill ProjectLink</strong></td>
<td>This chapter replaces the chapter formerly known as Collaborating in Windchill ProjectLink. It explains the use of certain tools within Windchill ProjectLink that enhance team communication.</td>
</tr>
<tr>
<td>Chapter 8, <strong>Searching in Windchill ProjectLink</strong></td>
<td>This new chapter explains the new search functionality available in Windchill ProjectLink.</td>
</tr>
<tr>
<td>Chapter 9, <strong>Managing a Project Plan</strong></td>
<td>This new chapter details the best approaches to project plan management in Windchill ProjectLink.</td>
</tr>
<tr>
<td>Chapter 10, <strong>Managing Context Teams</strong></td>
<td>This new chapter explains how to set up and manage a context team.</td>
</tr>
<tr>
<td>Chapter 11, <strong>Using Integrated Windchill Capabilities - Windchill ProjectLink and Windchill PDMLink</strong></td>
<td>This new chapter provides conceptual information and an extensive usage scenario for working in an integrated Windchill environment, in which Windchill ProjectLink and Windchill PDMLink are co-installed on a single server.</td>
</tr>
<tr>
<td>Chapter 12, <strong>Using Integrated Windchill Capabilities - Windchill ProjectLink and Windchill PDM</strong></td>
<td>This new chapter provides conceptual information and an extensive usage scenario for working in an integrated Windchill environment, in which Windchill ProjectLink and Windchill Foundation &amp; PDM are co-installed on a single server.</td>
</tr>
<tr>
<td>Appendix A: <strong>Available Project Templates</strong></td>
<td>This new appendix lists and briefly describes the out-of-the-box project templates available in Windchill ProjectLink.</td>
</tr>
<tr>
<td>Appendix B: <strong>Microsoft Project Object Mapping</strong></td>
<td>This new appendix details the object mapping with information exchanges between Microsoft Project and Windchill ProjectLink.</td>
</tr>
</tbody>
</table>
About This Guide

The Windchill ProjectLink User’s Guide provides useful information about the user interface and more detailed information about the functionality of Windchill ProjectLink. This book is intended for end users of Windchill ProjectLink.

Related Documentation

The following documentation may be helpful:

- The Windchill ProjectLink end user online help
- The Windchill ProjectLink Comprehensive List of Features

If books are not installed on your system, see your system administrator.

Technical Support

Contact PTC Technical Support via the PTC Web site, phone, fax, or e-mail if you encounter problems using Windchill.

For complete details, refer to Contacting Technical Support in the PTC Customer Service Guide enclosed with your shipment. This guide can also be found under the Support Bulletins section of the PTC Web site at:

http://www.ptc.com/support/index.htm
The PTC Web site also provides a search facility that allows you to locate Technical Support technical documentation of particular interest. To access this page, use the following link:

http://www.ptc.com/support/support.htm

You must have a Service Contract Number (SCN) before you can receive technical support. If you do not have an SCN, contact PTC License Management using the instructions found in your PTC Customer Service Guide under Contacting License Management.

**Documentation for PTC Products**

PTC provides documentation in the following forms:

- Help topics
- PDF books

To view and print PDF books, you must have the Adobe Acrobat Reader installed.

All Windchill documentation is included on the CD for the application. In addition, books updated after release (for example, to support a hardware platform certification) are available from the Reference Documents section of the PTC Web site at the following URL:

http://www.ptc.com/cs/doc/reference/

**Comments**

PTC welcomes your suggestions and comments on its documentation—send comments to the following address:

documentation@ptc.com

Please include the name of the application and its release number with your comments. For online books, provide the book title.

**Documentation Conventions**

Windchill documentation uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Item</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Names of elements in the user interface such as buttons, menu paths, and window titles. Required elements and keywords or characters in syntax formats.</td>
<td>Click OK. Select File &gt; Save. Create Part window create_&lt;tablename&gt;.sql</td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>Variable and user-defined elements in syntax formats. Angle brackets (&lt; and &gt;) enclose individual elements.</td>
<td><strong>create_&lt;tablename&gt;.sql</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td><strong>Monospace</strong></td>
<td>Examples</td>
<td>JavaGen &quot;wt.doc.*&quot; F true</td>
</tr>
<tr>
<td></td>
<td>Messages</td>
<td>Processing completed.</td>
</tr>
<tr>
<td><strong>&quot;Quotation marks&quot;</strong></td>
<td>Strings</td>
<td>The string &quot;UsrSCM&quot; . . .</td>
</tr>
<tr>
<td><strong>⚠️</strong></td>
<td>The CAUTION symbol indicates potentially unsafe situations which may result in minor injury, machine damage or downtime, or corruption or loss of software or data.</td>
<td>When you add a value to an enumerated type (for example, by adding a role in the RolesRB.java resource file), removing that value can result in a serious runtime error. Do not remove a role unless you are certain there is no reference to it within the system.</td>
</tr>
</tbody>
</table>
This chapter explains the basic concepts necessary for understanding Windchill ProjectLink.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before You Begin</td>
<td>1-3</td>
</tr>
<tr>
<td>Initial Concepts</td>
<td>1-14</td>
</tr>
<tr>
<td>Advanced Concepts</td>
<td>1-23</td>
</tr>
<tr>
<td>Navigating Windchill ProjectLink</td>
<td>1-26</td>
</tr>
</tbody>
</table>
Windchill ProjectLink provides a comprehensive, project collaboration and project management environment for all members of an extended product development team. It facilitates innovation by providing Web-based, virtual spaces with all the tools necessary to pull globally dispersed design team members together as if working in the same room. The following is a high-level list of included capabilities:

- Create a browser-accessible web portal to project status and information for team members
- Share documents and parts and manage their changes
- Search within and across projects for information
- Define a team of roles and groups and control access to information based on role or group membership
- Route documents and parts for review and approval
- Manage a schedule of milestones and activities
- Manage project deliverables to completion
- Create scheduled and instant web-based and peer-to-peer meetings with project team members
- Visualize and mark up CAD and other data formats using embedded view and markup tools
- Discuss project issues, proposals and so on through web-based discussion forum topics and postings
- Manage reference links and attachments for documents, parts, activities and so on
- Manage project risks and issues as action items
- Subscribe to documents, parts, activities, and forum topics and receive notifications when subscribed items are changed.
- Seamlessly publish CAD models to projects and iterate on designs with CAD authoring teams.
- Identify project resources and track resource costs

The purpose of this chapter is to provide an overview of the concepts and navigation in Windchill ProjectLink. This chapter includes the following sections:

- Before you begin
- Initial concepts
- Advanced concepts
- Navigating Windchill ProjectLink
Tip: To view step-by-step procedures for any of the functionality, click ? on the corresponding Windchill ProjectLink window. You can also access overview help by clicking Help in the upper right corner of the Windchill ProjectLink screen. Windchill ProjectLink also provides a number of tutorials. You can access functionality-specific tutorials by clicking ? on the corresponding Windchill ProjectLink window. You can access a complete menu of available tutorials by clicking Learn in the upper right corner of the Windchill ProjectLink screen.

Before You Begin

Before you begin using Windchill ProjectLink, the following steps are recommended for you to successfully run the application on your local machine:

- Ensure that you have the correct Web browser and plug-in version.
- Ensure that your ActiveX settings are configured to allow thumbnail viewing.
- Ensure that your pop-up blockers do not interfere with Windchill ProjectLink functionality.
- Run the bootstrap loader, if necessary.
- If Windchill ProductView Standard Edition has been purchased and installed at your site, and you desire the additional advanced visualization capability it provides, download and install Windchill ProductView Standard Edition.

The following sections explain these steps in more detail.

Web Browser and Java Plug-In Version

Ensure that you are using a Web browser and Java plug-in version that is supported by Windchill ProjectLink. Supported browsers and plug-ins are listed in the PTC software matrix.

The software matrix lists the combinations of platforms, operating systems, and third-party products that are certified for use with this release on Windows and UNIX operating systems.
To obtain a copy of the software matrix, use the following URL. This URL will direct you to the PTC Online Support Web page for reference documents. For your document search criteria, select Windchill ProjectLink from the product drop-down list. Select the software matrix for this release from the returned document list.


Product and version matrix information is updated periodically to adjust to environment changes. If you cannot access the software matrix, see your System Administrator for this information.

**ActiveX Settings**

If you are using Internet Explorer, ensure that the ActiveX settings for your browser are enabled to allow viewing of images, such as object thumbnails.

Use the following steps to ensure that your ActiveX settings are properly enabled:

1. Select **Tools** > **Internet Options**.
2. On the **Security** tab, in the **Security level for this zone section**, click **Custom Level**.
   
   The **Security Settings** window opens.
3. Make sure that the following settings are set to **Ensure** or **Prompt**:
   
   – Download signed ActiveX controls
   
   – Run ActiveX controls and plug-ins
4. Click **OK** to accept the settings and close the **Security Setting** window.
5. Click **OK** to close the **Internet Options** window.

For additional information, contact your System Administrator.

**Pop-Up Blocker Interference**

Many Web browsers and third-party applications offer pop-up blocker capabilities to prevent unwanted pop-ups from being opened on your local machine. This can interfere with some Windchill ProjectLink operations that automatically open new windows, keeping you from being able to complete certain functions, such as downloading object content.

This interference can be avoided by designating your Windchill server domain as an allowed site. This means that if your Windchill home page URL begins with "http://www.mycompany.com/Windchill", you would add "mycompany.com" to the list of allowed sites.
For example, in Netscape 7.1, you would do this by selecting **Edit>Preferences**, and under **Privacy and Security**, select **Popup Windows**. Click the **Allowed Sites** button. In the **Allow popups from the following websites** field, enter "mycompany.com". Click **Add**, then click **OK**.

**Tip:** Be sure to recheck your pop-up blocker settings if you install a new Web browser. Installing additional Web browsers (for example, installing Mozilla in addition to Netscape) can change your existing pop-up blocking settings.

For purposes of popup blocking, Netscape treats port numbers as part of the host name. If your Windchill server is listening on a non-default port number, and you are using Netscape as your Web browser, you must add the host name, including the port number, to your list of allowed sites. This means that if your Windchill home page URL begins with "http://mycompany.com:8080/Windchill" or "https://mycompany.com:8080/Windchill", you would add "mycompany.com:8080" to the lists of allowed sites.

For additional information or assistance with pop-up blocker settings (including port numbers), contact your System Administrator.

**Bootstrap Loader Installation**

The bootstrap loader allows Windchill applets to work on computer networks which do not allow applets to communicate directly with the Windchill server. If you are experiencing difficulties with your Windchill access, contact your System Administrator to determine if you need to install the bootstrap loader.

For example, the bootstrap loader may be needed to facilitate the create multiple documents action and several administrative functions.

Use the following procedure to install the bootstrap loader, if necessary.

1. From the **Home** tab, navigate to the **Utilities** page, and click the **Software Downloads** link.
   
   If prompted, read the license agreement, and click **Accept**.

2. On the **Software Downloads** page, click the **Bootstrap Loader Installation** link in the **Setup and Installation 7.0** section.
   
   The bootstrap installation wizard opens.

3. Follow the instructions on each page of the wizard. When you are done, click **Finish**.

4. Close and restart your Web browser session.
Windchill Visualization Services

Windchill Visualization Services provide you with the ability to view, annotate, and collaborate on data stored in Windchill. An embedded visualization tool and its necessary plug-ins are included in Windchill ProjectLink to view 3D CAD data, drawings, and images, and is automatically downloaded when required. To view or annotate some documents or ECAD data, the appropriate viewing option must be purchased and installed.

Windchill ProductView Standard Edition provides advanced features such as electronic interference checking, animation tools, and real-time, peer-to-peer collaboration. If it has been purchased and installed at your site, you can download and install it on your local machine.

To download and install Windchill ProductView Standard Edition, use the following procedure:

1. From the Home tab, navigate to the Utilities page, and click the Software Downloads link.
   If prompted, read the license agreement, and click Accept.
2. On the Software Downloads page, click the ProductView Installation link in the Setup and Installation 7.0 section.
   The Download ProductView window opens.
3. Follow the provided instructions to open the Windchill ProductView setup program and complete the installation.
4. Restart your browser.

Windchill ProductView is now ready to use. You may now download additional special use Windchill ProductView executables.

Additional Downloads

The following additional downloads may be available from the Download ProductView window:

- PVHelp_all.exe - Installs the online help for Windchill ProductView Standard Edition. Optional, but recommended.
- PVCClientImportFilters.exe - Adds options to the File Open dialog to open additional file formats from other applications, such as Pro/ENGINEER, DGN, GBF, IGES, STL, and VRML files. This download is optional.
- PVSimulationViewer.exe - Adds components needed to view DIVISION MockUp files. This download is optional, and is available only for Windows systems.
- PVECADview.exe - Adds electronic CAD capabilities, including viewing circuit designs and other electronic drawings. This download is optional, and available only if it has been purchased and installed at your site.
• acrobat60_<language>.exe - Provides Adobe Acrobat 6.0 functionality for use with the document viewing option. Available only if the document viewing option has been purchased and installed at your site. There are multiple versions of this executable available, supporting different languages, for example acrobat60_efg.exe supports English, French, and German languages. Your System Administrator installs the version appropriate for your site. If you already have Adobe Acrobat 6.0 installed on your machine, you do not need this download to use the document viewing functionality.

• PVPDFPlugin.exe - Provides ability to markup PDF files. Required for document viewing option.

Available Software Downloads

The Utilities page of the Home tab includes links to software provided for maximum usage of Windchill ProjectLink. While navigating through the software pages, the License Agreement page may appear. If you accept the terms, click Agree.

For up-to-date information concerning supported versions, see your site administrator.

For more information on some of the available software options, particularly those associated with Visualization, see the Before You Begin section at the beginning of this chapter.

Downloads are provided for the following:

• Microsoft Project integration
• Visualization
• CAD management

Microsoft Project Integration

To enable integration between the Windchill ProjectLink plan and Microsoft Project, Windchill ProjectLink provides a Microsoft Project plug-in. If you have Microsoft Project 2000 installed, and if you download and install the Microsoft Project plug-in, you can exchange plan date between Microsoft Project 2000 and your project plan in Windchill ProjectLink.

You can download the plug-in from the Utilities page of the Home tab. Once there, click Software Downloads.
Visualization

Any project team member with the appropriate access can view CAD data stored in Windchill ProjectLink. When CAD data is stored in a ProjectLink project, a viewable version of the file is created using Visualization Services. Visualization Services is a Windchill ProjectLink service that converts CAD data into a neutral file format—a process referred to as publishing. To enable visualization of CAD data by viewers without CAD authoring tools, Windchill ProjectLink provides a downloadable viewable called Windchill ProductView which can be easily used to view CAD data and 2D engineering formats. With Windchill ProductView, you can view and mark up documents and CAD parts, as well as save your markups in Windchill ProjectLink.

CAD Management

Windchill ProjectLink provides CAD managers that integrate directly into your CAD application. When you download and install a CAD manager, menus are added to your CAD application's user interface that provide you with a simplified way to interact between a Windchill ProjectLink project and your CAD system. From your CAD application, you can publish and retrieve CAD components, assemblies, and drawings to and from Windchill ProjectLink.

Windchill ProjectLink currently supports the following CAD managers:

- Pro/ENGINEER
- Pro/DESKTOP and Pro/DESKTOP Express
- AutoCAD
- CATIA
- I-DEAS
- Unigraphics
- SolidWorks

Windchill ProjectLink also provides the Pro/DESKTOP Express CAD tool.

Setting User Preferences

To access the User Preferences page, click Preferences on the Utilities page of the Home tab.

Windchill ProjectLink has five categories of user preferences, so you can define certain aspects of your functionality.

- Display
- Content
- Search
- Tables
• Visualization

**Note:** Your preferences may differ, depending on the settings at your site.

Always click the **OK** or **Apply** button to submit preference information instead of pressing ENTER on your keyboard.

**Display Preferences**

To customize how certain items of your screen display, click the **Display** tab. A more detailed description of each preference is available when you click the preference link.

```
Edit User Preferences

- Display
- Content
- Search
- Tables
- Visualization

Show Clipboard Messages
Display clipboard messages when copying items to the clipboard.

Truncate Display Names
Specify a maximum length for display names in certain instances by entering a character length at which to truncate the name. If a name is truncated, it is appended with a localized “...”. The system default is No truncation.

Set Local Time Zone
Choose your Time Zone. The system default is the time zone your server has set.

Actions Menu Display
Choose to display actions menu in tables as a drop-down list or as a menu in a pop-up window.

Automatically Start Project (Check Box)
Choose the default value of the Automatically Start Project check box on the Create Project wizard. If the check box is selected, the project is started and invitations are sent to project members once the project is created. If it is not selected, the project owner can later select an action to start the project. The system default is that the check box is selected.

Return to Project
Choose whether to return to the last project you had visited when you had logged in previously.

Choose Preferred Content Cache Site
Choose Preferred Content Cache Site.
```

**Cancel**
Content Preferences

To customize your document check-out process, click the Content tab. A more detailed description of each preference is available when you click the preference link.

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default Local Directory</strong></td>
<td>Choose a default directory for uploading and downloading primary files.</td>
</tr>
<tr>
<td><strong>Download Operation Type</strong></td>
<td>Choose to have primary file opened or saved to disk.</td>
</tr>
<tr>
<td><strong>Content Download Upon Document Checkout</strong></td>
<td>Choose whether primary content file is downloaded when you check out a document.</td>
</tr>
<tr>
<td><strong>File Not Found Behavior</strong></td>
<td>Choose behavior if local file is not found.</td>
</tr>
<tr>
<td><strong>Unchanged File Behavior</strong></td>
<td>Choose behavior if local file has not changed.</td>
</tr>
<tr>
<td><strong>Changed File Behavior</strong></td>
<td>Choose behavior if local file has changed.</td>
</tr>
<tr>
<td><strong>Desktop Integration File Download Option</strong></td>
<td>Choose whether to use Desktop Integration to download files for editing.</td>
</tr>
<tr>
<td><strong>Desktop Integration Plug-In Auto Detect Behavior</strong></td>
<td>Choose whether auto detection of a missing Desktop Integration plug-in will cause a prompt for plug-in installation.</td>
</tr>
<tr>
<td><strong>Java Applet File Download Option</strong></td>
<td>Choose whether to use Java applet to download files for editing.</td>
</tr>
<tr>
<td><strong>Java Applet Plug-In Auto Detect Behavior</strong></td>
<td>Choose whether auto detection of a missing Java plug-in will cause a prompt for plug-in installation.</td>
</tr>
<tr>
<td><strong>Compress Contents</strong></td>
<td>Choose to receive compressed data over HTTP.</td>
</tr>
</tbody>
</table>
Search Preferences

To customize your search process, click the Search tab. A more detailed description of each preference is available when you click the preference link. For information on search modes, see Using Search Modes in Chapter 8, Searching in Windchill ProjectLink.

**Note:** You must enable the thumbnail option on the Visualization tab before choosing to display thumbnails on your Thumbnail Display in Search Results preference on the Search tab.
Tables Preferences

To customize how information displays in the tables in Windchill ProjectLink, click the Tables tab. A more detailed description of each preference is available when you click the preference link.

![Edit User Preferences](image)

- **Overview Table Size**: Home Tab Number of Rows to Display
- **Table Results Paging**: Choose the number of search results to display per page. The system default will be 16 results per page.
- **View All Table Size Limit**: View All Table Size Limit
Visualization Preferences

To customize your visualization options, click the Visualization tab. A detailed description of each preference is available when you click the preference link. If you choose to display thumbnails, small images of the objects can be viewed from the search results and details pages. Thumbnails give you a visual image to associate with the details information of a part. You can also launch ProductView by clicking the thumbnail icon. However, displaying thumbnails will increase the time needed for pages to load.

<table>
<thead>
<tr>
<th>Edit User Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
</tr>
</tbody>
</table>

- **Thumbnail Display in Search Results**
  Choose whether thumbnail images display in search results.

- **Thumbnail Display on Properties Pages**
  Choose whether thumbnail images display on Properties pages.

- **Loading ProductView Data**
  Choose how to load files into ProductView.

- **Tool Tips Display**
  Choose whether tool tips display on Visualization pages.

- **Select Viewing Tool**
  Choose either ProductView Standard Edition or ProductView Lite Edition as the Viewing tool.

- **Visualization Collection**
  Enable Visualization Collection for use with ProductView.

  [Cancel]

Miscellaneous Table Preferences

Aside from table preferences set on the Utilities page, each Windchill ProjectLink table has a set of tools that allow you to customize the way the table information is displayed. Most tables have a Current View drop-down list at the top right corner of the table, which offers a selection of views. These views are specific to the table content and determine how the table content is displayed. When a view is chosen, the information is displayed accordingly.

You can also sort the table content of most tables using the table columns. For example, if you want to view all of the projects according to their status, click the Status column title. The information is refreshed to display all of the projects sorted by their status.

Some tables include Collapse All and Expand All buttons which allow you to close or open all of the folders in that table.
Tables such as the **Folders** table allow you to organize the information using cut, copy, and paste. You must have the appropriate permissions to move an object, such as a folder or document.

However you choose to display a particular table, your preferences are saved until you change them.

**Using Special Characters in Windchill ProjectLink**

The following characters have special meaning in HTML and should be avoided when entering information in the fields on pages in Windchill ProjectLink:

- `<`
- `>`
- `"`
- `'
- `&`
- `&`

The following actions are not recognized by HTML and should be avoided when entering information in the fields in Windchill ProjectLink:

- Adding more than one space between letters.
- Pressing ENTER.

The following should not be used in UNIX file names:

- `\`
- The extension "..LNK" or ".lnk"

**Initial Concepts**

Efficient use of Windchill ProjectLink depends on several core concepts. This section explains the following concepts:

- Projects
- Team and role management
- Access control to project information
- Communication and Collaboration
- Notebook
Projects

A project is a Web-based space into which you invite people to collaborate as a project team. Team members can access the space, using it to find, store, and share documents, CAD files, links to important Web pages, or other information. You can set up a schedule, or plan, for the project as well as assign project deliverables to team members. You can also schedule team meetings and host online project discussions. Team members can mark up and view CAD files, create new iterations of an existing part or document, and route files to other team members for review or approval.

See Chapter 2, Beginning a Project, for more detailed information about creating a project and setting up a team.

A project state is an indicator of the project's stage of operation and activity. A Windchill ProjectLink project supports some capabilities and access permissions which are influenced by the project state. For example, if the project state is set to Completed, the project plan cannot be updated. Project managers can change the state of the project by selecting the corresponding action from the drop-down list next to the project name on the Projects List page or the project Details page.

The following four states are available:

• Defined -- Initial state of a project. When a project is in the Defined state, only the project creator (who is by default, the project manager) can access the project to add and organize information, invite people to the project team, and establish the project schedule. The project is only accessible to other team members assigned the role of project manager.

• Running -- State of the project during normal operations. Invitations to project members are sent, and access to the project is opened to all project members. During this state, all project members may access the project and participate in all project operations.

• Completed -- State of the project when the project is finished. When the project state is set to Completed, all members may still access the project to retrieve information, but no information may be added or removed.

• Cancelled -- State of a project that is no longer active. Only a project manager may choose to change the project state to Cancelled. A canceled project no longer appears in the project list of any project members.

Setting Up a Project

When you create a project, you are automatically assigned the role of project manager. The project manager is able to create, update, and organize administrative items within a project. The project manager is also responsible for inviting team members and assigning the necessary roles.

See Chapter 2, Beginning a Project, for basic concepts concerning project and team set up.
Tip: If you do not see the Create Project button located on the Projects List page or on any page next to the Recent Projects drop-down list, you are not authorized to create a project. See your organization administrator to obtain authorization.

The Create Project window includes the following steps to create a new project:

- Create a project
- Select the team
- Compose invitation
- Define details

In the first step, you define the project identity attributes such as name, description, and duration. You can select a project template which sets up the project with default folders and roles. For examples, choosing the Basic template, sets up the following folders for the project: Designs, General, and Specifications. It also provides the following roles for the project team: Project Manager, Reviewer, Observer, and Guest. For more information about the available out-of-the-box templates, see Appendix A, Available Project Templates.

During Step 2 of the project, you define the project team. The project team is described later in this chapter.

Step 3 of the Create Project window allows you to write a specific message for the invitation to the project that is sent to all team members.

In Step 4, you can define project details such as project number, site, and budget as well as designate the level of project execution control. Project execution options are described in greater detail in Chapter 2, Beginning a Project, and Chapter 9, Managing a Project Plan.

Project Actions

A number of project actions are available to you depending on your permissions. The following actions are available if you are the project manager. These actions are discussed in greater detail in Chapter 2, Beginning a Project.

- Cancel
- Complete
- Update
- Delete
- Save as new project
- Save as project template
- Import from Microsoft Project plan
• Export plan to Microsoft Project plan
• Edit plan in Microsoft Project

The following project actions are available to both project managers and team members. These are described in greater detail in Chapter 2, Beginning a Project.
• Details
• Import from file
• Export to file

Team and Role Management

A team is a group of people from one or more organizations that have access to a project. An organization is a corporate division, such as Research and Development, or an entire company.

Team members are invited through e-mail invitations that are sent when the project is started. Once you visit the project, your status becomes active. Your permissions, and therefore the extent of your participation in a project, depend on the role or roles that were assigned to you by the project manager.

You initially select the team during the creation of the project. You can select users from your organization, and you can invite team members outside of your organization by using their e-mail addresses.

In addition to adding team members to the project team, you can assign these members to specific roles within the project. A role relates people in the project with information and activities managed in that project. The default roles available are project manager, member, and observer. However, you can add additional roles to the project and assign your team members to these roles. Team members may have different roles in each project in which they are participants. In one project, you may be the project manager while in another project, a member.

Project managers can continue to modify the team throughout the life of the project from the Team page of the Project tab.

Common roles are project manager, member, and guest.

For more detailed information concerning team set up, see Chapter 2, Beginning a Project. For more information about team management, see Chapter 10, Managing Context Teams.

Access Control to Project Information

Access to project information is controlled in two ways:

• Restrictions associated with the roles assigned to team members or organizations
• Access control permissions set for individual objects within the project

Roles are briefly described previously in this chapter and are described in more detail in Chapter 10, Managing Context Teams. In addition to setting overall permissions with role assignments, you can set specific access control permissions for a particular object, such as a part, document, or folder. You can set access control rules during the creation of the object or by selecting **Access Control** from the actions list next to the object name.

If you set specific access control rules for a folder, by default, the access control rules for any objects stored in that folder are based on the access control rules for that folder. You can then change the access control rules on a per object basis if necessary.
The **Access Control** window displays all of the roles and groups in the project and their default or current permissions.

### Access Control

<table>
<thead>
<tr>
<th>Groups</th>
<th>Full</th>
<th>Update</th>
<th>Read</th>
<th>None</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Members</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>Guest</td>
<td></td>
<td>☑</td>
<td></td>
<td>☑</td>
</tr>
<tr>
<td>Members</td>
<td></td>
<td>☑</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ril-qa</td>
<td></td>
<td>☑</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Guest User</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can choose to give team members assigned to these roles the following types of permissions:

- **None** - Allows the role or group no access to the information. The information is not displayed in any listing nor can the information be returned in the search results or change logs.
- **Read** - The folder, document, or part is displayed. Users can view the details pages, find the information in a search, and open the folder, document, or part for viewing only.
- **Update** - Users have read access plus the ability to add new iterations of the information.
- **Full** - Users have the complete ability to read, update, and delete the information.

**Note:** If a user is a member of more than one access control role or group, the user is granted the highest level of access among the roles and groups of which the user is a member.
Communication and Collaboration

Companies often face the challenge of communicating clearly and effectively while located in multiple sites and working with different companies. Windchill ProjectLink provides functionality which increases the efficiency of team communication and collaboration. This section describes the following communication and collaboration functionality. Most of this functionality is described more completely in Chapter 6, Communication Tools in Windchill ProjectLink.

- Routing
- Subscriptions
- Action items
- Discussion forums
- Meetings

File Routing

It may be necessary to notify team members of the existence of a part or have a document or part reviewed by a number of the team members. In Windchill ProjectLink, creators or owners of documents or parts have the ability to send a file through a process, or route. Windchill ProjectLink provides the following out-of-the-box routing process options. Additional routing options may be defined and provided by your site.

- Approval
- Notify
- Release
- Review

Routing is available for parts, documents, and CAD documents that are stored in the project. If you are the object creator, you can route a file by selecting Route from the drop-down list next to the file name. You can select the type of route, the participants, and supply any additional instructions for the tasks. E-mail notifications are sent to those specified team members who need to access the file. Any tasks are sent as e-mail notifications. Tasks also appear in the team member's task list on the Assignments pages of the Home and Project tabs. As the file progresses through the route, the status changes. You can view the route status on the file's details page where you can also update the route or terminate it. File routing is described in greater detail in Chapter 7, Communication Tools In Windchill ProjectLink.
Discussion Forums

Discussion forums are accessible from the Forum page on the Project tab. A discussion forum works like a message or chat board that you may encounter on the World Wide Web. All team members can participate in discussions. A forum is composed of a topic, or folder, which contains postings, or messages. You can create a posting under any topic, as well as reply to existing postings. Each project contains a project-level discussion forum, and each part or document in the project also has an object-specific forum associated with it.

Discussion forums are described in greater detail in Chapter 7, Communication Tools In Windchill ProjectLink.

Subscriptions

Subscribing to an object means that you are notified by e-mail when certain events or actions occur on that object, for example, when a document is checked in or the status of a milestone changes. You can subscribe to specific events for various information types in a project including documents, CAD documents, parts, forums, and deliverables. All of your subscriptions are accessible from the Subscriptions page on the Home tab.

Subscriptions enable you to keep track of changes to project information without constant monitoring. Whenever you want to cease receiving e-mails about a particular event, simply delete the subscription.

Subscriptions are described in greater detail in Chapter 7, Communication Tools In Windchill ProjectLink.

Action Items

Action items are used to capture project issues that must be resolved or items that must be accomplished that are not formally tracked in a project plan. Action items are useful to identify and track supporting work that must be accomplished either prior to or as part of a formal project activity.

Action items are similar to tasks in that they record a job that needs to be done. However, tasks are generated automatically by workflows for routing, project management, and other processes whereas action items are created by team members. Action items are displayed on the Assignments pages of the Home and Project tabs.
Action items can be created to record steps that must be taken to accomplish assigned work. A meeting creator can associate action items to a meeting to record actions that resulted from a discussion in the meeting. Meeting action items can be viewed on the meeting's information page.

To resolve an action item, select **Update** from the actions list next to the action item name.

**Meetings**

Windchill ProjectLink provides a flexible solution to the varieties of meetings conducted throughout the life of a project. You can create one of the following types of meetings in Windchill ProjectLink:

- **Standard** -- A meeting that includes an agenda, meeting participants, and the meeting details, such as date, time, and telephone information.

- **Web-based** -- A meeting that includes all the features of a standard meeting, but is conducted through WebEx in order to share meeting presentations or other materials in real time.

**Note:** WebEx is not supported in the Korean language.

- **ProductView** -- A meeting that includes all features of a standard meeting, but with the ability to share two or more sessions of ProductView with meeting participants. ProductView meetings are peer-to-peer meetings that do not require access to the Windchill ProjectLink server after the session is initiated.

**Note:** To host or join a ProductView meeting, you must have the ProductView client application installed on your system.

Meetings can be created for specific projects or independently of project context. Existing meetings can be viewed either within the project context or by a particular user wanting to view all meetings to which he or she has been invited. Project-specific meetings are created and viewed on the **Meetings** page of the **Project** tab. All meetings can be viewed on the **Meetings** page of the **Home** tab. From this page, you can also create meetings that are independent of any project context.

Meetings are described in greater detail in **Chapter 7, Communication Tools In Windchill ProjectLink**.
Notebook

The Notebook allows you to collect and organize links to data within a project or necessary to a project. A link is a URL to something either inside or outside the boundaries of Windchill ProjectLink. You can also create a link to an object, such as a part or document, that exists within a project of which you are a member. You can organize these links into folders which may already be established or which you create.

You can also upload files from your local machine into your notebook. Click **Upload File** on the **My Notebook** table.

The first time you open your notebook, it contains the default folders and links that are set for each new user at your site.

Links that are created within a particular notebook folder have a details page and an actions list associated with them. Click **[ ]** to view the details page. This personal collection of data provides quick and easy access to all data and resources relevant to your work in the projects of which you are a member.

Advanced Concepts

This section explains the following concepts:

- Document Management
- Visualization
- BOMs
- Workspaces
- Project Management and Execution
- Microsoft Project Integration
- Reports

Document Management

Windchill ProjectLink provides functionality to create and manage documents. When you create a document, you are uploading a file that you have authored, for example, in Microsoft Word. You can create single document, multiple documents, or select a template from which to create a document. Once documents are created, modifications are managed with a check-out and check-in process.

Document management is described further in [Chapter 3, Managing Documents](#).
Visualization

ProductView, the Windchill visualization tool, allows users to view data from a variety of sources without requiring access to the application that created the data. Users can analyze the product design, annotate files to indicate review comments, obtain information about parts of a product structure, and collaborate dynamically with others regarding design or document content.

ProductView allows you to view and annotate 3D models, 2D drawings, documents, images, and ECAD files. In addition, you can measure and analyze 3D data, which can come from a variety of different CAD systems. The viewable data is stored in Windchill as a compact representation. Each representation can have markups associated, and ProductView allows users to view, edit, and save this information back to Windchill. For more information, see Chapter 5, Visualizing Data in Windchill.

Product Structure

Windchill ProjectLink provides functionality to create product structures with the parts that have been created in the folders manually or which have been published to project folders using a CAD authoring application and a Windchill CAD manager publishing plug-in. To initiate a product structure, navigate to the information page of the part and select BOM from the actions list. Then you can add child parts in a hierarchical view to create the structure.

Product structures are described further in Chapter 4, Managing Parts and Product Structures.

Workspaces

Windchill ProjectLink provides workspace functionality, allowing you to create a private area associated with a project context to create and manage multiple objects and perform basic PDM (Product Data Management) operations. Workspace actions are enabled automatically when you download a CAD manager or when you register a project with a Pro/ENGINEER Wildfire CAD client.

For more information on workspaces, see Chapter 6, Working with CAD Data.

Project Plan Management

Windchill ProjectLink provides the capability to create and manage a project plan. You can define a plan hierarchy of activities, milestones, sub projects, and associated deliverables and manage the execution of the plan. A project manager can create and update this information. Team members can view the page to track the progress of the project.

This information is described in detail in Chapter 9, Managing a Project Plan.

On the Plan page, you can view a timeline that is displayed across the top of the page and highlights the milestone dates for quick reference.
Windchill ProjectLink also provides tasks and sub projects to assist in project plan management. Tasks are assigned as the plan progresses if the project execution is set to automatic. The extent that tasks play in a project plan is determined by the level of project execution control set at project creation.

Sub projects, or child projects, are added on the Plan page of the Project tab. A sub project is another project which contains information that is relevant to your project. For example, a sub project might contain deliverables or milestones upon which your project is dependent. Adding that project as a sub project allows you to efficiently monitor the project's progress from within the context of your project.

This functionality is described in further detail in Chapter 9, Managing a Project Plan.

**Project Execution**

Windchill ProjectLink provides the following out-of-the-box methods of executing a project and its plan:

- Manual control of project execution - Allows you to control every aspect of the project execution. You manually execute the activities when they are ready to begin, and create and assign tasks to the team members associated with the activities. In manual mode, no project management tasks are created.

- Automatic execution of activities - The system automatically executes and manages project activities that are created. You manually create and assign tasks to team members associated with the activities. No project management tasks are created.

- Automatic execution of activities and delivery of tasks - The system automatically executes and manages project activities. It also creates tasks for activities and delivers e-mail notification concerning created tasks to the associated resources.

For more detailed information on project execution, see Chapter 2, Beginning a Project and Chapter 9, Managing a Project Plan.

**Microsoft Project Integration**

Windchill ProjectLink provides a plug-in that enables integration between Microsoft Project 2000 and the Windchill ProjectLink plan. This integration allows you to exchange plan information between the two applications.

This integration is described in further detail in Chapter 9, Managing a Project Plan.
Reports

Windchill ProjectLink provides several out-of-the-box reports to enable quick assessments of project progress. The Reports page on the Home tab displays a report table that allows you to execute reports across all projects in which you are a team member, only returning items for which you are the owner. The same report types are available on the Reports page within each project; however, these reports return information specific to the current project regardless of ownership (all of the reports have the same titles except without the word "my.").

Reports are described in further detail in Chapter 9, Managing a Project Plan.

Navigating Windchill ProjectLink

When you access Windchill ProjectLink, two tabs appear at the top of your page. These tabs provide two different ways to navigate to information. The following information describes each tab.

The Home Tab

Information displayed on the Home tab is usually specific to you, as an individual user, and encompasses all projects of which you are a member. When you first access the Home tab, Overview is the default page displayed. To view other information, click the links that appear below the Home tab.

Overview

The Overview page displays a short list of the most recent objects in the following tables:

- Assignments
- Updates
- Checked-Out Work

A View All link appears in the bottom-left corner of the table, allowing you to view all items on the corresponding page of the Home tab. You can also click the link for each table below the Home tab to view only that table, and all of the objects contained in it.

Assignments

The Assignments page displays all of the work items assigned to you, including workflow and project management tasks, action items, deliverables, milestones, and activities.
For more information about an item assigned to you, click the link in the Name column of the table, or select Details from the actions list in the Actions column. The information page displays the details you need to complete the assignment. If an object, such as a part or document, is associated with the assignment, a link to the information about the object appears in the Subject column of the table. From the object's information page, you can view all available information for and perform actions on the object. Various actions, such as Update, are available from the Actions column for each assignment.

If the assignment is a task, you can complete the task, after having finished the assigned work, by clicking the Task Complete button on the page. The task is then removed from your Assignments list, and the process moves forward. If you need to reassign the task or update the deadline, those options are available in the Actions column of the table.

You can choose to alter the view of the table content by selecting one of the following options from the Current View drop-down list in the top right corner of the table:

- Open - displays all currently open assignments
- Open by Due Date - displays all currently open assignments organized by deadline
- Closed - displays all resolved action items and completed deliverables, activities, summary activities, and milestones that are assigned to you
- Deliverables - displays all uncompleted deliverables assigned to you
- Milestones - displays all uncompleted milestones assigned to you
- Activities - displays all uncompleted activities and summary activities assigned to you
- Action Items - displays all uncompleted action items assigned to you
- Tasks - displays all uncompleted tasks assigned to you

Updates

The Updates page lists objects that you have recently modified. For example, you may check out a document in order to edit the text, and then check in the document with your corrections. If, the next day, the document needs additional editing, you can easily access it from your Updates page rather than have to search for the document or locate it within the folders of the project.

Checked Out Work

The Checked-Out Work page lists any items that you currently have checked out. At the time of a check out, a working copy is made available to you. The working copy is a duplicate of the original object and becomes the copy that you modify. This copy of the object appears in your Checked-Out Work list. Check out locks the original object to prevent changes by others.
Once you have finished modifying an item, you can check in the item from this table by using the **Check In** action available from the **Actions** column. Your working copy with all of its attributes and associations supersedes the present iteration of the object, and the item is removed from your **Checked-Out Work** list.

**Workspaces**

The **Workspaces** page is available if you have downloaded a CAD manager for a CAD authoring application or if you have registered a project with a Pro/ENGINEER Wildfire client application. The **Workspaces** page displays a listing of workspaces, if any, that have been created from all projects to which you have access. A workspace provides a useful framework that allows you to work with many CAD documents and parts at the same time. Selecting Workspace from the **Project** tab displays a listing of the workspaces associated with that particular project.

From the **Workspaces** page, you can create a new workspace, delete an existing workspace, or by clicking the link in the **Name** column, go to an existing workspace.

Workspaces are described in greater detail in Chapter 6, Working with CAD Data.

**Meetings**

The **Meetings** page displays all of the meetings you have created or to which you have been invited across all projects of which you are a member. From this page, you can view the details of a meeting by clicking the meeting name.

You can also cancel existing meetings and create new meetings that are independent of a specific project. Other actions are available from the **Actions** column.

**Notebook**

The **Notebook** page displays links you have created and organized into folders and subfolders. It is similar to a favorites list in your Web browser. The first time you open your notebook, it contains the default folders and links that are set for each new user at your site.

**Subscriptions**

The **Subscriptions** page displays all of the object events to which you have subscribed. There is a different entry for each event even if it is the same object. You can delete any existing subscriptions from this page.
Reports

The Reports page allows you to execute reports across all projects in which you are a participant. To run a report, select the report name from the Current View drop-down list. Only items for which you are the owner are displayed in the results. The report table displays up to twenty-five results per page. If the number of results exceeds twenty-five, a page navigation link appears at the bottom of the page, allowing you to navigate among the listings.

Utilities

The Utilities page provides access to items used to change or enhance your interaction with Windchill ProjectLink. For example, links to Setting User Preferences, security settings, and software downloads appear on this page. See also the information in the Before You Begin section at the beginning of this chapter for information about options that appear on the Utilities page.

The Project Tab

The Project tab provides access to information that is specific to a particular project, such as files, tasks, and the project plan. You can only access projects which you have created or to which you have been invited. If you accessed Windchill ProjectLink through a project invitation, you will be directed to the Project tab.

The top of each project page contains a project information bar which displays key information for the current project, including the name of the project, its description, status, and state. If you have the appropriate permissions, an Update Project button appears next to the project name. In addition, the Recent Projects drop-down list, located next to the project name, allows you to switch to another recently visited project at any time.

If you have create permissions, you can create a new project by clicking the Create Project button located next to the Recent Projects drop-down list.

If you first access the Project tab through a project invitation, the Details page is displayed. On any subsequent visits to the project, you are directed to the last page you viewed. To view other project information, click the links below the Project tab.
Projects List

The **Projects List** page displays all of the projects of which you are a team member or to which you have been invited. You can view key information and access the project through the hyperlinked project name.

Details

The **Details** page displays information concerning the project currently being viewed. From this page, you can perform a number of project-level actions, depending on your permissions, and view details concerning the project, the project plan, and any associated child projects.

Folders

The **Folders** page provides the ability to organize and control access to all data in a particular project, such as folders, documents, parts, and links. You can access object-specific actions and object content from this page.

Plan

The **Plan** page displays project schedule information, such as activities, summary activities, milestones, and sub projects associated with the current project. You can chose from a number of available views to focus the organization of the plan information.

You can also view and manage a timeline of the project plan on this page. The timeline appears after the first milestone has been created or after the first plan item has been added to the timeline. You can add and remove plan items from the timeline as the project progresses.

Team

The **Team** page displays all users currently invited to the project. If a team member has accepted the invitation, the joined status is Yes, and a link to his or her e-mail address is activated. If a team member has not accepted the invitation, the joined status is No. The following user information is also displayed: e-mail address, telephone number, organization, and role. If you are a project manager in the project, you can perform a number of actions from this page, such as adding roles and members and removing members.

Resources

The **Resources** page shows the resources allocated to a project. A resource is something necessary to the completion of the project, such as a person, facility, piece of equipment, or particular material. Resources are tracked as part of the project budget and status.
Meetings

The **Meetings** page displays all of the meetings scheduled for this project. The information is similar to that displayed on the **Meetings** page of the **Home** tab except that it is project-specific.

Assignments

The **Assignments** page within each project displays project assignments for all team members in a particular project. The assignment information is similar to the information displayed on the **Assignments** page of the **Home** tab except that it is project-specific and displays everyone's assignments, rather than those of a particular individual. Assignments which are not assigned to you are not actively linked.

Forum

The **Forum** page displays any ongoing discussions concerning the project. All team members may participate in a discussion.

BOM

The **BOM** page displays information relevant to a particular part or assembly. If you have not yet viewed the product structure of a part, the **BOM** page does not appear in the list of pages beneath the **Project** tab.

If you have viewed product structures before, the most recently viewed product structure is displayed.

To view the product structure of a part, select **BOM** from the actions list next to a part on the **Folders** page.

Workspace

The **Workspace** page displays a listing of the workspaces associated with the current project. A workspace provides a useful framework that allows you to work with many CAD documents and parts at the same time.

From the **Workspace** page, you can create a new workspace, delete an existing workspace, or by clicking the link in the **Name** column, go to an existing workspace.

Reports

The **Reports** page within each project displays the same reports available on the **Reports** page of the **Home** tab; however, these reports return information specific to the current project regardless of ownership (all of the reports have the same titles except without the word "my").
Templates

The Templates page is only available to project managers. It allows project managers to manage document and CAD document templates.

Using the Header Links

The following links as well as a Copy Page button and a search field appear in the Windchill header:

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn</td>
<td>Displays Windchill tutorials which walk through procedures for completing Windchill actions.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for the tab you are viewing.</td>
</tr>
<tr>
<td>Tip</td>
<td>To view online help for a table, click ? in the upper right corner of the table.</td>
</tr>
<tr>
<td>Publications</td>
<td>Displays the Publications page which provides links to all Windchill manuals to which you have access.</td>
</tr>
<tr>
<td>E-mail Page</td>
<td>Launches a new window that allows you to e-mail the current URL to another user.</td>
</tr>
<tr>
<td>Hot Links</td>
<td>Opens the Hot Links folder of your Notebook under the Home tab. Hot Links are URLs of the Windchill pages you access most frequently. The Add to Hot Links button appears throughout Windchill to allow you to save the link to your Hot Links.</td>
</tr>
</tbody>
</table>

Copy Page

The Copy Page button copies the URL of the current page to the Windchill clipboard. The URL you have copied can be pasted into any table that accepts links or into a text field that has a paste action associated with it.
This chapter explains the basic concepts necessary for creating an initial project and setting up a team.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Projects</td>
<td>2-2</td>
</tr>
<tr>
<td>Creating a Project</td>
<td>2-2</td>
</tr>
<tr>
<td>Setting Up a Project</td>
<td>2-7</td>
</tr>
<tr>
<td>Project Actions</td>
<td>2-7</td>
</tr>
<tr>
<td>States and Phases</td>
<td>2-8</td>
</tr>
<tr>
<td>Team and Role Management</td>
<td>2-10</td>
</tr>
</tbody>
</table>
Projects

As stated previously, a project is a Web-based space into which you invite people to participate as a project team. This team can access the space and store and share documents, CAD files, links to important Web pages, or other information. You can set up a schedule, or plan, for the project as well as assign project deliverables to team members. You can also schedule team meetings and host online project discussions. Team members can mark up and view CAD files, create new iterations of an existing part or document, and route files to other team members for review or approval.

More detailed information about creating a project, setting up a team, and different project options is included in this chapter. For more detailed information concerning project plans, see Chapter 9, Managing a Project Plan.

Creating a Project

You are the project manager and owner of any projects you create. You may choose to assign others to assist you in the project manager function, or you may delegate the role completely to someone else. A project manager is able to create, update, and organize activities, milestones, deliverables, and templates within a project. A project manager is also responsible for inviting team members and assigning the necessary roles.

You can create a project by clicking the Create Project button from the Project tab. If you do not see the Create Project button located on the Projects List page or on any page next to the Recent Projects drop-down list, you do not have the necessary permissions to create a project. See your organization administrator if you feel that you should be able to create projects.

The Create Project window includes the following steps to create a new project. For more detailed information about each of the fields, see the online help accessible from the Create Project window.

- Create a project
- Select the team
- Compose invitation
- Define details

Step 1, Create a Project

In the first step, you define the project identity attributes, such as name, description, and duration. You also select a project template which defines some details of the project, such as initially created folders and available roles. For more details on the available project templates, see Appendix A, Available Project Templates.
**Tip:** Do not enter a value for the duration if you want it to be automatically calculated by the system.

Only project team members are granted access to a project by default. A project to which only team members have access is called a *private project*. Access groups with policies that extend access beyond the immediate project team can be defined, and you can select from any of these defined access groups.

It is also possible to customize the system and define project types and type-specific project attributes that capture key information that is important to projects in your business. Any defined custom project types are automatically displayed in the project types list.

You can choose to allow project members to share information in the project with other projects by selecting the **Allow sharing to other projects** check box. Sharing is useful when you have a few documents in a project that need to be referenced by members in other projects who are not also members of your project.

You can choose to start the project as soon as it is created. When you select the **Start project and send invitations to team** check box, the project is started as soon as the create is complete, and invitations are sent to the team members. The team members are then able to access the project from their projects lists.
Tip: If you want to first organize and ready the project, clear this check box. You can then define the team and organize the project without anyone else accessing the project. When you are ready to begin the project and invite the team members, select **Start** from the project actions list. The project is then set to Running, the invitations are sent, and all team members have access to the project.

Note: When you leave the first step (either by clicking on one of the other steps or by clicking **Next**), the project is created based on the chosen template. Subsequent steps in the **Create Project** window modify the newly created project. You cannot return to Step 1 of the window. However, should you decide to change some project attributes, such as the name or description, you can update the project by selecting **Update** from the actions list.

Step 2, Select the Team

During Step 2 of the project, you choose the team members and roles for the initial project team. You can choose to overlook this step and later define the team from the **Team** page of the **Project** tab. The project team is described in the **Team and Role Management** section later in this chapter.

Step 3, Compose Invitation

Step 3 of the **Create Project** window allows you to write a specific message to be included in the project invitation that is sent to all team members. The invitation message can include formatted HTML, including URL references. You can modify this invitation when updating the project or from the **Team** page of the **Project** tab.
Step 4, Define Details

In Step 4, you can define project details, such as project number, site, and budget as well as designate the level of project execution control. You can only designate the project execution during this step. You cannot update the project execution level later.

Project Execution Options

In Windchill ProjectLink, there are three options for project management, or project execution. These options affect how the project plan is managed. Project execution includes the assigning and delivering of tasks related to activities and deliverables to team members in order to complete the work of the project. The philosophy behind choosing how you will manage your project plan is described in Chapter 9, Managing a Project Plan.

You chose one of the following options during Step 4 of the creating a project process. You cannot change or update your choice.

- Manual control of project execution - Allows you to control every aspect of the project execution. You manually execute the activities when they are ready to begin. In manual mode, no project management tasks are created.
• Automatic execution of activities - The system automatically executes and manages project activities that are created. No project management tasks are created.

• Automatic execution of activities and delivery of tasks - The system automatically executes and manages project activities. It also creates tasks for activities and delivers e-mail notification concerning created tasks to the associated resources.

Automatic Execution

When project activities are created and assigned precedence relationships and a start date, the tasks associated with each of the resources assigned to the activities are automatically generated and delivered at the point at which the activity can start. Activities are started once the precedence activities are completed and the start date is reached.

This behavior is especially useful in automating the delivery and execution of project tasks among a distributed team. Each resource in the project is delivered its assigned tasks when, and only when, the tasks are ready to be started. This automated execution and project management facilitation adds great value beyond project planning tools.

Activities can also be suspended so that no tasks can be completed and delivery of subsequent tasks is prevented until issues are resolved. Once any problems have been resolved, the activities can be resumed.

Automatic versus Manual Execution of a Project

If you have enabled the automatic project execution mode to automatically execute activities and deliver tasks, project management tasks are automatically generated and delivered to each of the resources assigned to an activity. Each resource updates the effort or percentage complete in the delivered task. The task values are calculated for the activity, the activity values for summary activities, and finally for the project as a whole.

If you are automatically executing a project and tracking cost, then the planned and actual effort is defined in each of the tasks, and the cost for the activity is calculated from the resource rates.

Tip: The automatic execution of activities and task delivery is best for project types where the same steps must be efficiently executed for each project. Automated execution is not appropriate when frequent changes need to be made to a plan in the course of execution.
Setting Up a Project

After you have created the project, you can start organizing and using it. The Folders page initially contains folders and documents defined by the project template. You can add and delete folders to suit your project's needs. You can also create subfolders. For example, if you have a folder titled Plans, you may also want to create subfolders titled Design Plans, Documentation Plans, and Development Plans. When you create the folder, you can set the access control permissions.

To create a folder, click  on the Folders page. To create a subfolder, select the folder which you want to contain the new folder. Then click  . Or select Create Folder from the folder’s actions list. For more detailed instructions, click the  on the corresponding windows.

You can add data to the project in the following ways:

- Create documents - upload files or documents from your local machine
- Create parts - create new parts and upload visual files from your local machine
- Create document templates - create new templates for team members to use as a simple format for common documents
- Create documents from templates - create new documents for the project based on the format of the document templates you have created
- Create links - create links to information outside the project, such as a Web site that contains useful information

You can also set the access control at the object-level for each of these data types.

Project Actions

A number of project actions are available to you depending on your permissions. Some of the project actions, such as cancel and suspend, affect the state of the project. The following actions are available if you are the project manager.

- Cancel
- Suspend
- Complete
- Update
- Delete
- Save as new project
- Save as project template
• Import Microsoft Project Plan
• Export Plan to Microsoft Project
• Edit Plan in Microsoft Project

The following project actions are available to both project managers and team members:

• Details - Displays the information page of the project
• Import from file - Allows you to import project information into the current project
• Export to file - Allows you to export project information for use in another project. You can only export information to which you have read access.

**States and Phases**

Windchill ProjectLink provides the capability to define states for projects, parts, and documents. It also provides the capability to define phases for projects. These states and phases assist in the managing of the project and its information. For more information about project and plan states, see Chapter 9, Managing a Project Plan.

**Part and Document States**

A state is a description of the maturity of documents and parts stored in a project. The owner of a document or part can change the state of the object from its information page. A change in state indicates a change in the maturity, or completion, of the object. When a document or part is linked to a project deliverable, the change in state of the document or part can be used to notify team members or the project manager that a change has occurred.

The object creator, anyone with update permissions, and anyone in the Project Manager role can change the state of an object.

**Project States**

A project state is an indicator of the project’s stage of operation and activity. A Windchill ProjectLink project supports some capabilities and access control which are specific to the project state.

Available project states are as follows:

• Defined - initial state of a project. This state is helpful when setting up a project takes time and you do not want others to start using the project until the setup is complete. When a project is in the Defined state, only the project creator can access the project to add and organize information, invite people to the project team, and establish the project schedule. Only project managers have access to the project when it is in this state.
• Running - state of the project during normal operations. Invitations to project members are sent and access to the project is opened to all project members when a project manager changes the state to Running by selecting the Start action for the project. During this state, all project members may access the project and participate in all project operations.

• Completed - state of the project when the project is finished. When the project state is set to Completed, all members may still access the project to retrieve information, but no information may be added or removed. The project manager can restart the project, if necessary.

• Cancelled - state of a project that is no longer active. A project manager may choose to change the project state to Cancelled by selecting the Cancel action for the project. A project manager can still access project information and restart the project, if necessary. The project plan of a canceled project is also canceled.

• Suspended - state of the project whose work has been suspended. The project plan of a suspended project cannot be updated.

Project Phases

The project phase is used to indicate a project’s maturity to the organizations using the project and all project members. The project phase is set by a Project Manager for that project. The project phase is not linked to any of a Windchill ProjectLink project's specific capabilities or access control features.

The following is a list of some of the project phases that Windchill ProjectLink provides out of the box. Additional phases are provided and can also be defined by your site. The meaning of a phase is determined by your site.

• Kickoff
• Scoping
• Planning
• Assignment
• Development
• Wrap Up
• Completed
• Port Mortem
• Review
Team and Role Management

A team is a set of roles and members representing users and group from one or more organizations that have access to a project. Team management is described in more detail in Chapter 10, Managing Context Teams.

Team members are invited through e-mail invitations that are sent when the project is started. The project also appears in your list of projects. Once you visit the project, your status becomes active. Your permissions, and therefore the extent of your participation in a project, depend on the role or roles that were assigned to you by the project manager.

A project manager initially selects the team during the creation of the project. Project managers can select users from their organization and can invite team members using their e-mail addresses.

In addition to adding team members to the project team, you can assign these members to specific roles within the project. A role relates people in the project with information and activities managed in that project. The default roles available are project manager, member, and guest. However, you can add additional roles to the project and assign your team members to these roles. Team members may have different roles in each project in which they are participants. In one project, you may be the project manager while in another project, a member.
As a project manager, you can continue to modify the team throughout the life of the project from the Team page on the Project tab. The following actions are available:

- Add members
- Add roles
- Replace members
- Remove members
- Remove roles
- Update Invitation

Common roles are project manager, member, and guest.

- Project manager - The project manager role is automatically assigned to the project creator. However, if you, as the project creator, want others to share in the manager responsibilities, you can assign this role to other team members. The project manager is responsible for selecting and maintaining the team, creating and managing the plan, and managing the overall project. Only the project manager can change the state, phase, and status of the project.

- Member - Most team members are assigned the role of member. Whatever other roles may be assigned to them are in addition to this role. Members can access the project, view any project information available (although access control set on specific objects can hide information from people in specific roles or organizations), and participate by adding data to the project. Members are usually responsible for only those items of which they are the owner or creator. For example, members can only update deliverables of which they are the owners. They can also only update or delete objects that they have created.
- Guest - Team members assigned to the role of guest have view, or read-only, privileges to all of the data in the project. They cannot perform any actions within the project. Guest members do not receive an invitation to the project nor does the project appear in the list of projects of which the user is a member. The purpose of the guest role is to provide access to users and groups who may need to search the project for information but who are not active participants in the project.
### 3
### Managing Documents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Document Management</td>
<td>3-2</td>
</tr>
<tr>
<td>Creating Documents</td>
<td>3-3</td>
</tr>
<tr>
<td>Viewing Documents</td>
<td>3-7</td>
</tr>
<tr>
<td>Modifying Documents</td>
<td>3-7</td>
</tr>
<tr>
<td>Managing Documents with Windchill Desktop Integration</td>
<td>3-9</td>
</tr>
<tr>
<td>Options for Downloading Documents</td>
<td>3-12</td>
</tr>
</tbody>
</table>
Understanding Document Management

The document management functions allow you to create, view, modify, and manage documents.

You can access these functions within Windchill ProjectLink, or if you install Windchill Desktop Integration, you can access these functions within Microsoft Word, Excel, or PowerPoint. For more information, see Managing Documents with Windchill Desktop Integration.

Within Windchill ProjectLink, documents reside in the folders of a specific project. You can perform document actions from the Folders page in the project or from the tables under the Home tab. A list of actions is available from the Actions column, or icons may be available in the toolbar of the table.

For example, if you select the Actions list from the Updates table on the Home tab, the following window appears. Note that Documents is selected in the Current View drop-down list of the Updates table.

Note: This example displays all actions available if you have both Windchill PDMLink and Windchill ProjectLink installed.
To view the attributes of a document and perform actions on the document, select **Details** and the document details appear.

The online help available on the details pages gives complete descriptions of the attributes, links, and tables shown as well as the actions that can be performed. Additionally, your site may have created custom attributes that appear with the details. For example, your site may want an attribute such as **Proprietary** to indicate whether or not the document can be released outside of the company, or **Required Security Level** to indicate whether or not the document is classified.

The following sections describe how and where, as well as the different ways, you can create and modify a document in Windchill ProjectLink. Information on working with CAD documents is describe in **Working with CAD Data**.

**Creating Documents**

To create a document in a Windchill ProjectLink project, you have the following options:

<table>
<thead>
<tr>
<th>Action</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Document</td>
<td>![Document icon]</td>
<td>Uploads a file that you have created (for example, in Microsoft Word) into the project.</td>
</tr>
</tbody>
</table>
You can complete these create actions in the following locations:

- **Folders** under the project.

The following example illustrates creating multiple documents:

1. From the **Folders** page of the project, click **Create Multiple Documents**:

   ![Create Multiple Documents](image)

   **Tip:** When you use the **Create Multiple Documents** action, the documents need to be of the same type and reside in the same folder location.

   **Note:** If no templates are available for the context, this option will not appear.

2. The **Create Multiple Documents** page appears. Select options in the fields at the top of the page.
**Tip:** The **Type** and **Location** fields apply for all documents created on the page.

3. Use one of the following methods to select the files to be created as documents:
   a. Click **Add Files** to browse for files on your computer.

      **Tip:** Press CTRL to select multiple files.

   Or

   b. Drag and drop files from Windows Explorer or your desktop onto the icon.

4. The documents appear in the table. Enter field information for each document, and click **Next**.
Tip: Fields may have character limitations. See the online help available from the page for the maximum number of characters you can enter in each field.

5. If your site has defined additional attributes for a document type, fields and default values for those attributes appear on the **Define Details** step. You can accept the default or specify a new value. Click **Next**.

6. Set access control for the documents, and click **OK**.

7. The documents are placed in the location you selected. Click the **Last Modified** column to sort the table by that attribute. The documents you created appear at the top of the table.
Viewing Documents

In many cases, you may only need to view the details about or content of a document. If so, you have the following options:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>The information page of the document appears. This page displays all available Windchill ProjectLink status information for the document. You can also perform actions on the document (such as check out) from this page.</td>
<td>• <strong>Folders</strong> page under the project</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Search Results</strong> table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Checked-Out Work</strong> table (on the <strong>Home</strong> tab)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Updates</strong> table (on the <strong>Home</strong> tab)</td>
</tr>
<tr>
<td>View</td>
<td>View the content of the document (for example, the Microsoft Word or Excel file). Opens the document as it appeared when it was most recently checked into the Windchill ProjectLink database. If the document is checked out, you can still view the document; however, keep in mind that the document is in the process of being modified by another user.</td>
<td>• document information pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Folders</strong> page under the project</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Search Results</strong> table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Updates</strong> table (on the <strong>Home</strong> tab)</td>
</tr>
</tbody>
</table>

**Tip:** You can also view the content of a document when you click the file link on the document information page, or click the name of the document in tables throughout Windchill ProjectLink.

**Tip:** If you would like to view a specific document each time it is modified, you can subscribe to the document. For more information see Communication Tools In Windchill ProjectLink.

Modifying Documents

After documents are created in the project, they are managed with check-out and check-in functionality. These actions can be completed from the information page of a document (which appears when you click ⌁ or select the Details action) or
from the **Folders** page of a project. You may also be able to complete these actions on the tables under the **Home** tab:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Out</td>
<td>Locks the document to prevent changes by others. Once you check out a document, the document appears in the <strong>Checked-Out Work</strong> table under the <strong>Home</strong> tab.</td>
</tr>
<tr>
<td>Check Out and Download</td>
<td>Makes a working copy of a document file, which you can download to your computer. The original document in Windchill ProjectLink is locked to prevent changes by others. At the time of check out, the downloaded file (that is, the working copy) duplicates the file most recently checked into the document. Once you check out a document, the document appears in your <strong>Checked-Out Work</strong> table under the <strong>Home</strong> tab.</td>
</tr>
<tr>
<td>Undo Checkout</td>
<td>Reverses a check-out operation. This option avoids creation of a new iteration and appearance of your name in the <strong>Modified By</strong> field, which would occur with a checkin. For example, if you realize that the document you checked out is not the correct one, you can undo the checkout.</td>
</tr>
<tr>
<td>Check In</td>
<td>Replaces the locked, previous version of a document with your working copy. The working copy supersedes the prior iteration of the document. Past iterations are stored in the <strong>Iteration History</strong> table on the document information page.</td>
</tr>
</tbody>
</table>

The check-out and check-in functionality ensures that two people are not modifying the same document at once, and individuals who wish to view a document are made aware that the document is in the process of being changed.

In addition to checking in and checking out documents, you can choose among the following actions to modify documents. These actions can be completed from the information page of a document or from the **Folders** page under the project:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route</td>
<td>Automate the movement of the document through a particular process. For more information see <a href="#">Communication Tools In Windchill ProjectLink</a>.</td>
</tr>
<tr>
<td>Set State</td>
<td>Manually change the state of the document. When a document is created, it is in the <strong>In Work</strong> state. Select this option to change the state of the document, for example, to <strong>Released</strong> or <strong>Cancelled</strong>. This action is available only if the document has not been routed.</td>
</tr>
<tr>
<td>Update</td>
<td>Modify the attributes of the document.</td>
</tr>
</tbody>
</table>
Managing Documents with Windchill Desktop Integration

With Windchill Desktop Integration, you can complete many of the previously mentioned document management actions without leaving Microsoft Word, Excel, or PowerPoint. This means that once a document is created in the Windchill system, you do not need to open Windchill ProjectLink to complete document management tasks. After installing Windchill Desktop Integration, you connect to a server to complete document management functionality in the Microsoft application. For a list of available functionality, see Windchill Menu Options.

Important Tip for Netscape Users: Windchill Desktop Integration downloads content by using a file called "data.wcdti." The first time you download content, you may get a dialog asking what you want to do with the file. If you prefer not to get this dialog with future downloads of this file, you should select the option, "Open it with the default application," and ensure that the check box labeled "Always show this dialog before handling files of this type" is not selected, before clicking the OK button.

Installing Windchill Desktop Integration

The installation for Windchill Desktop Integration is available under the Home tab. Click the Utilities link below the tab, and then click Software Downloads. After you accept the license agreement, the Software Downloads page appears. Under Setup and Installation 7.0, click Windchill Desktop Integration 2.0 Installation.

Note: Windchill Desktop Integration supports Microsoft Office 2000 and later versions.

To uninstall Windchill Desktop Integration, use the standard Microsoft Add/Remove Programs.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Control</td>
<td>View or modify the access permissions for this document.</td>
</tr>
<tr>
<td>Discuss</td>
<td>Opens the Discussion page where you can discuss topics that relate to the document. Team members can reply to existing postings or start new discussions about the same document.</td>
</tr>
<tr>
<td>Delete</td>
<td>Remove the document from the project.</td>
</tr>
</tbody>
</table>
Windchill Menu Options

Windchill Desktop Integration provides the functionality to modify documents, but not to create them. For information on creating documents in Windchill ProjectLink, see Creating Documents.

After Windchill Desktop Integration is installed, a Windchill menu appears on the toolbar of the following Microsoft Office applications: Word, Excel, and PowerPoint. The menu also appears when you right-click on a document from Windows Explorer or your desktop.

These menu options are meant to coincide with Microsoft functionality. As a result, some of the terminology is different from the terms you may see within Windchill ProjectLink.

The following options appear in the Windchill menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Active Server</td>
<td>Connects to Windchill ProjectLink. Many of the menu options listed in this table are not available until you connect to Windchill ProjectLink. Your site may have more than one server that appears when you select this option from the menu. See your system administrator for information on the correct server for your use.</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Disconnects the Microsoft Office application from Windchill ProjectLink.</td>
</tr>
<tr>
<td>Search</td>
<td>Locates documents in the Windchill ProjectLink database.</td>
</tr>
<tr>
<td>Check Out</td>
<td>Makes a working copy of a document while locking the original document to prevent change by others. At the time of check out, the working copy duplicates the original object.</td>
</tr>
<tr>
<td>Cancel Checkout (Undo Checkout)</td>
<td>If you realize the document you checked out is not the correct one, undo the checkout. This option avoids creating a new iteration and your name appearing in the Updated By field, which would occur with a checkin.</td>
</tr>
<tr>
<td>Check In</td>
<td>Replaces a locked, original version of a document with your working copy. The working copy supersedes the original iteration of the document.</td>
</tr>
<tr>
<td>Rename</td>
<td>Allows you to enter a new name for a document. This changes the document name for all versions and iterations of the document (and could make it difficult for others to find the document if they are searching by name.)</td>
</tr>
</tbody>
</table>
Although the Windchill menu options appear when you right-click any document in Windows Explorer or on your Desktop, the Revert to Windchill Copy option is enabled if the document is a not Windchill-owned object (meaning, Windchill ProjectLink does not recognizes the document in the database).

In addition, the action menu options, from Check Out to Delete, are enabled only if the document is a Windchill-owned object and you have modify permission for the document.

### Exchanging Attributes between Windchill and Microsoft Office

When you edit a document in a Microsoft Office application with Windchill Desktop Integration installed, you can use Microsoft Office functionality to place the Windchill attributes as fields within the content of the document file.

The following attributes are mapped to Microsoft Office from Windchill:

- Title
- Description
- Primary Content URL
- Name
• Number
• Type
• Context
• Version Info
• Life Cycle State
• Obid

**Note:** The Obid field should not be edited. This attribute retains the document’s relationship to Windchill.

Select **File>Properties** from the menu of the Microsoft application to view these attributes. The title and description attributes appear under the **Summary** tab. The remainder of the attributes appear under the **Custom** tab.

If your site defined additional attributes for a document, these attributes are also mapped to the Microsoft Office applications and appear under the **Custom** tab. These attributes are distinguished with the prefix "IBA".

The online help within the Microsoft application describes detailed steps for placing these attributes as fields within the text of the document file.

In Microsoft Word, search the online help for "DocProperty field."

In Microsoft Excel and PowerPoint, search the online help for "custom file properties."

### Options for Downloading Documents

This section provides more detailed information on the downloading options available under the content preferences. To view these preferences, click **Utilities** below the **Home** tab. On the **Utilities** page, click **Preferences**. Click the **Content** tab. For more information on the other preferences, see [Getting Started with Windchill ProjectLink](#).

### Desktop Integration File Download Option

If you are using Windchill Desktop Integration for authoring documents, set the **Desktop Integration File Download Option** preference to **Always use Desktop Integration to download the primary file of a Windchill document**. This selection

• allows the Microsoft Office authoring tools to embed the Windchill information into the download file.

• supports download preferences. However, this selection does not always give you the option to cancel any downloads, download multiple files at once, or choose a download location other than the **Default Local Directory** selected in that content preference.
Desktop Integration Plug-In Auto Detect Behavior

If you selected "always" in the previous preference, and you only login from a single workstation, set the Desktop Integration Plug-In Auto Detect Behavior preference to Prompt to install Desktop Integration plug-in if it is not detected on your machine. As a result, when you get a new workstation, you will be reminded to install the plug-in again.

If you login from other workstations that may or may not have Windchill Desktop Integration installed, set this preference to Automatically use the standard browser and applet downloads if the Desktop Integration plug-in is not detected on your machine. As a result, you will not be prompted each time you login to a different machine that does not have the Desktop Integration plug-in installed. If you do get prompted on a different machine, and decline the installation of the plug-in, Desktop Integration would no longer be used automatically for downloading when you return to your other machines.
Managing Parts and Product Structures

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Part Management</td>
<td>4-2</td>
</tr>
<tr>
<td>Creating Parts</td>
<td>4-3</td>
</tr>
<tr>
<td>Viewing Parts</td>
<td>4-5</td>
</tr>
<tr>
<td>Modifying Parts</td>
<td>4-7</td>
</tr>
<tr>
<td>Creating Parts in a Product Structure</td>
<td>4-8</td>
</tr>
<tr>
<td>Modifying a Product Structure</td>
<td>4-11</td>
</tr>
</tbody>
</table>
Understanding Part Management

Windchill ProjectLink allows you to create, view, modify, and manage parts and product structures. You can work with parts and product structures independent of or in coordination with information checked out or shared from Windchill PDM or Windchill PDMLink.

This functionality accommodates the exploration of new product concepts and the pursuit of changes to supplied assemblies in collaboration with suppliers.

Exploring New Product Concepts

In Windchill ProjectLink, you can create the concept parts and structure of a product without the restrictions of processes and controls used in a PDM system. The project environment facilitates open collaboration so that you can freely develop the concept and explore several iterations without making any commitments to a product. When a concept matures to the point at which you wish to formally pursue the concept as a product, then the parts and structures created in Windchill ProjectLink can be checked into a PDM system and formally released.

Pursuing Changes To Supplied Assemblies

In Windchill ProjectLink, you can provide limited access to product information to your partners and suppliers without giving them direct access to the product data in your PDM system.

As a parent manufacturer, you
1. Create a project in Windchill ProjectLink.
2. Check out the assembly from the PDM system to the project.
3. Invite suppliers and partners to the project, so they can view and update just the essential assembly information. (This limited access is important both from a security perspective and to provide focus for the suppliers.)

Then the supplier and manufacturer team members can modify the assembly, exploring design variations including the creation of new parts. The new parts may be added to the assembly or replace existing parts. Later, some of the parts created in the project may be discarded in design iterations. Once the assembly changes are complete in the project, the final list of parts and the assembly structure can be checked into the PDM system, sent through the change process, and, then, be formally released in the PDM system.

Navigating Part Information

Within Windchill ProjectLink, parts reside in the folders of a specific project. You can perform part actions from the Folders table under the project, from the tables under the Home tab, or from the information page for the part. A list of actions you can perform on parts is available in the Actions list. In addition, icons may be
available in the toolbar of the table. Once parts are created in Windchill ProjectLink, you can create a product structure. This chapter describes the actions relating to parts and product structures.

Creating Parts

In Windchill ProjectLink, you can manually create parts, or you can automatically publish parts and structure to a project from a CAD application (using a CAD manager plug-in for your CAD authoring clients). Commonly you will define parts in a CAD authoring client and then publish the structure to a project. For more information, see Working with CAD Data.

You may also find it useful to manually define a part structure in order to construct a skeleton that is populated with specific assembly elements over the course of a design.

1. To manually create a part in a Windchill ProjectLink project, use the following procedure: From the Folders page of the project, click Create Part:

2. The Create Part page appears. Enter information in the attribute fields, and click Next.
Tip: Fields may have character limitations. See the help available on the page for the maximum number of characters you can enter in each field.

3. If your site has defined additional attributes for a part, fields and default values for those attributes appear. You can accept the default or specify a new value. Click Next.

4. Set access control for the part, and click OK.

By default, the access control set for an object stored in a specific folder will be based on the access control for that folder. The window displays all of the
roles and groups in the project. For more information, see Access Control to Project Information in the Getting Started chapter.

Tip: If you need to create another part, click Apply. The Create window will remain open after the part has been created in the system. When you click OK, the Create window closes after the part is created.

5. The part is placed in the location you selected.

Viewing Parts

If you want to view information about a part, click Details or select Details from the Actions list.

This option is available from the following locations:
The information page of the part appears.

This page displays all available Windchill ProjectLink status information for the part. You can also perform actions on the part (such as check out) from this page.

The online help available on these pages gives complete descriptions of the attributes and tables shown and the actions that can be performed. Your site may have also created custom attributes that appear on the information page.
Modifying Parts

After parts are created in the project, they are managed with check-out and check-in functionality.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>Available Locations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check Out</strong></td>
<td>Locks the part to prevent changes by others. Once you check out a part, the part appears in the <strong>Checked-Out Work</strong> table under the <strong>Home</strong> tab.</td>
<td>• Part information page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Folders</strong> page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Updates</strong> table under <strong>Home</strong> tab</td>
</tr>
<tr>
<td><strong>Undo Checkout</strong></td>
<td>Reverses a check-out operation.</td>
<td>• Part information page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Folders</strong> page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Checked-Out Work</strong> table under <strong>Home</strong> tab</td>
</tr>
<tr>
<td><strong>Check In</strong></td>
<td>Replaces the locked, original version of a part with your working copy.</td>
<td>• Part information page</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You must check out an object before you can check it in.</td>
<td>• <strong>Folders</strong> page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Checked-Out Work</strong> table under <strong>Home</strong> tab</td>
</tr>
</tbody>
</table>

The check-out and check-in functionality ensures that two people are not modifying the same part at once, and individuals who wish to view a part are made aware if the part is in the process of being changed.

Each time a part is checked into a project, a new iteration is created; that is, the working copy of the part supersedes the iteration currently stored in the database, and the iteration identifier is incremented. Past iterations are stored in the **Iteration History** table on the part information page. Selecting **Undo Checkout** avoids creating a new iteration and your name appearing in the **Updated By** field, which would occur with a checkin.

In addition to checking in and checking out parts, you can complete the following actions to modify parts. These actions can be completed from the information page of a part or the **Folders** page under the project:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Route</strong></td>
<td>Automate the movement of the part through a particular process. For more information see <a href="#">Communication Tools In Windchill ProjectLink</a>.</td>
</tr>
</tbody>
</table>
Creating Parts in a Product Structure

Once parts have been created in Windchill ProjectLink, you can create a product structure. This enables you to organize assembly parts in a hierarchical view.

You can create a product structure two ways:

• Using the Create Child from Search action
• Using the clipboard functionality

Using the Create Child from Search Action

The following example illustrates creating a product structure

1. Navigate to the part information page for the part you want at the top level of the product structure. Select BOM (Bill of Materials) from the Actions list.

   The Product Structure-Assembly table appears on the BOM page:

   ![Product Structure-Assembly table](image)

   - **Set State**: Manually change the state of the part. When a part is created, it is in the In Work state. Select this option to change the state of the part to Released or Cancelled. This action is available only if the part has not been routed.
   - **Rename**: Modify the attributes of the part.
   - **Access Control**: View or modify the access permissions for this part.
   - **Delete**: Remove the part from the project.
2. Place the first child part in the structure by selecting **Create Child from Search** in the **Actions** list.

The **Add Child from Search** page appears:

![Add Child from Search](image)

3. Enter information in the attribute fields, and click **Search**.

**Tip:** Clicking **OK** will close the window without performing the search.

4. From the **Search Results** table that appears, select the part, and click **OK**.

5. The part now appears as a child part in the product structure:

![Product Structure - Assembly](image)
Using the Clipboard Functionality

Just as you used the Create Child from Search action to place a child part in the product structure, you can also use the Copy/Add Child from Clipboard functionality:

The following example illustrates creating a product structure

1. Navigate to the part information page for the part you want at the top level of the product structure. Select BOM (Bill of Materials) from the Actions list.

   The Product Structure-Assembly table appears on the BOM page:

   ![Product Structure-Assembly Table](image)

2. Navigate to the desired part on the Folders table.

3. Select the check box next to the part, and click Copy.
4. Select the BOM link under the Project tab.

The Product Structure table appears:

5. Select the check box next to the part under which you want to add the child part, and select Add Child from Clipboard.

6. The part now appears as a child part in the product structure:

On the information pages for parts Test2 and Test3, a Used By table now appears, informing you that these parts are used in a product structure. In this example, part Test2 is used by Test1, and Test3 is used by Test2.

**Modifying a Product Structure**

You can complete the following actions to modify the parts in a product structure.

- Update quantity/units
- Remove
Updating Quantity

To update the quantity of a part used in a product structure, select **Update Quantity/Units** in the **Actions** list of the part, on either the part information page or the **Folders** table.

Removing a Part from a Product Structure

To remove a part from a product structure use the following procedure:

1. Navigate to the **Product Structure** table on the **BOM** page.

   **Tip:** You may need to click **Expand** in order to view all of the parts in the structure.

2. Select the check box next to the desired part name, and click **Remove Child**.

   The part is removed from the structure but not from the Windchill ProjectLink system.
Visualizing Data in Windchill

This chapter discusses the visualization features available in Windchill ProjectLink.

### Topic Page

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>5-2</td>
</tr>
<tr>
<td>Accessing Visualization</td>
<td>5-2</td>
</tr>
<tr>
<td>ProductView Features</td>
<td>5-5</td>
</tr>
<tr>
<td>Publishing Visualization Data to Windchill</td>
<td>5-8</td>
</tr>
<tr>
<td>Setting Preferences</td>
<td>5-9</td>
</tr>
</tbody>
</table>
Overview

ProductView, the Windchill visualization tool, allows users to view data from a variety of sources without requiring access to the application that created the data. Users can analyze the product design, annotate files to indicate review comments, obtain information about parts of a product structure, and collaborate dynamically with others regarding design or document content.

ProductView allows you to view and annotate 3D models, 2D drawings, documents, images, and ECAD files. In addition, you can measure and analyze 3D data, which can come from a variety of different CAD systems. The viewable data is stored in Windchill as a compact representation. Each representation can have markups associated, and ProductView allows users to view, edit, and save this information back to Windchill.

The default viewer for Windchill solutions is a lightweight visualization tool called ProductView Lite Edition, which is described in this chapter. ProductView Standard Edition, an additional option available for purchase, provides expanded visualization functionality beyond the capabilities of ProductView Lite Edition.

When you first choose to visualize data from Windchill, the ProductView Lite Edition viewer is installed automatically.

Accessing Visualization

Windchill provides compressed, viewable representations of product data, which are displayed as thumbnails. Thumbnails provide a high-level glance at the data. You can view the thumbnail image and, for 3D data, you can spin it to change the viewpoint. To visualize the data in more detail, click the thumbnail to launch ProductView.

There are several ways to access ProductView from Windchill:

- Part details page (also called properties page).

  To access this page, from the Folders tab, click beside a file name. The Details page displays a 3D thumbnail of the part. You can click the thumbnail to display the part in ProductView.
Search Results table: In the upper right corner of the main page in Windchill, you see the search tools. You can use these tools to search and display a Search Results table, shown below. The Actions column of this table contains various icons for performing tasks. You can click the View in ProductView icon to launch ProductView, where you can visualize the part. For more information on searching, see Searching in Windchill ProjectLink.

Folders view (Windchill PDMLink and Windchill ProjectLink only): In the Folders table, the part name is hyperlinked. Click this link to open the part in ProductView.
Visualization Collection: The Visualization Collection allows you to combine different data sets into one viewable representation for the current browser session. You can create a representation of a part or document based on the current contents of the Visualization Collection. You can combine different data types, such as a drawing and a model, or you can combine the same data types to view the result.

To display the Visualization Collection, click the icon directly beneath the thumbnail area on the details/properties page.

In the Visualization Collection, you can click View All to combine all of the listed data sets and view them as one representation in ProductView. You can also click individual thumbnails in the Visualization Collection to open ProductView.
• **Representations** table: On the part details/properties page, directly below the thumbnail area, you can click the third icon to display the **Representations** table. In this table, you can click a thumbnail image to launch ProductView and visualize that part.

Or, if you want to upload data from your local machine to Windchill to create a representation, you can click **Create Representation** at the top of the **Representations** table. This creates a thumbnail and adds the data to the **Representations** table, as shown in the graphic below:

![Representations Table Graphic]

In addition to 3D parts, you can also visualize documents, drawings, images, and ECAD data.

**Note:** To view documents in ProductView, you must purchase and install the Document Collaboration option. To view ECAD printed circuit boards and schematics in ProductView, you must purchase and install the ECAD Viewing option.

**ProductView Features**

ProductView provides the following basic features:

- Viewing
- Navigation
- Annotation
- Measurement

These features are described next. For detailed descriptions of a feature, refer to the ProductView online help.

**Viewing Data**

ProductView lets you visualize product data. You can open a 3D assembly in the viewer. You can also view documents, images, drawings, and ECAD files associated with a product structure. All of these files open in a view window that provides various visualization features.
When viewing 3D data, you can click to select and move components in the view. This is called *translating* the component. You might do this to examine individual components, or to temporarily move them out of the way if they are obscuring the view of other components. You can also spin or rotate components to view them from different perspectives. To do this, you toggle between translation and rotation modes using buttons on the toolbar.

You can show or hide components in the viewer. In addition, you can specify the rendering of 3D components as shaded, wireframe, or hidden lines removed.

All of these visualization features allow you to control your view of the data, and are explained in detail in the ProductView online help.

**Navigating ProductView**

You can use the mouse and keyboard to easily navigate in ProductView. There are two navigation modes: *fly-through* and *inspection*.

- *Fly-through* allows you to interactively fly around a 3D component to view that object from different depths and angles. You can think of this like moving your head, where a slide to the left moves the head to the left, with the object in the view moving to the right. You use the middle mouse button (or ALT + right mouse button for a two-button mouse) to fly.

- *Inspection* is like holding an object in your hand and viewing it from different angles. You use the right mouse button to spin the viewed object.

You can use switch navigation modes during fly-through or inspection by using the following mouse and keyboard combinations. Note that the ALT key is used to access certain navigation features when you have a two-button mouse.

<table>
<thead>
<tr>
<th>Mouse Button</th>
<th>Default Mode</th>
<th>+ Shift</th>
<th>+Ctrl</th>
<th>+ ALT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Select</td>
<td></td>
<td>Multi-select</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Let's you select components or specify a translation or rotation grab handle.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Right</td>
<td>Spin</td>
<td>Zoom</td>
<td>Pan</td>
<td>Fly (two-button mouse)</td>
</tr>
<tr>
<td>Middle</td>
<td>Fly</td>
<td>Pitch</td>
<td>Slide</td>
<td>Spin (two-button mouse)</td>
</tr>
</tbody>
</table>
• In pan mode, the object moves in the same direction as the mouse.
• In zoom mode, move the mouse down to zoom in and mouse up to zoom out.
• In fly mode, you move the mouse to change the view direction, moving the mouse up to fly forward, and down to zoom out or fly away in the view.
• In slide mode, the mouse movement implies a change in position to the view, not the object.
• Fly and slide are differential, meaning that the further you move the mouse, the faster the change in viewpoint. The camera continues to move until the mouse button is released or returned to the original position where the button was pressed.
• For translation, you can use the SHIFT key to set a grab point, which lets you zoom in for precise movement. When you set the grab point, translation moves to that point and you see the arrows used to move the component when you zoom in.
• Holding the SHIFT key while moving the mouse (without pressing any mouse buttons) displays information on the part under the cursor. In select mode, this highlights the object bounding box. In measurement mode, it highlights features available to measure.

Annotating Files

ProductView provides the ability to view and create annotations for all file types. You can use annotation to insert text comments and draw shapes in the view to highlight specific items, as needed.

Annotation sets appear as thumbnails along the left side of the ProductView Lite Edition window. Click a thumbnail in the annotation list to load that annotation set into the viewer.

Use the various annotation toolbar buttons to create annotations, such as note, line, or circle. Annotation toolbar commands vary based on the type of file you are viewing. When you have created an annotation, you can select that item and choose Annotation Properties to change the appearance of the annotation. When you are finished, you can upload the annotation set or markup to the server.

ProductView also provides expanded document annotation tools for PDF files, if you have the Document Collaboration Option installed. For example, you can highlight text, or track and reply to comments. These features allow you to manage collaborative, interactive reviews of PDF files.

Measuring Dimensions and Distance

ProductView provides powerful tools for measuring dimensions or distance between 3D parts. When measurement mode is active, you can hover the mouse over items in the view to highlight faces and curves that are available for measurement, then click to select the item or items you want to measure.
To take a measurement, you first activate measurement mode by selecting **Distance** or **Dimension**, depending on the type of measurement you want to take. Double-click to select components for measurement, and single-click to select surfaces.

When measurement mode is active, items available for measurement are highlighted as you move the mouse pointer over the view. For curves or lines, the end, middle, and center points are highlighted for selection. Faces are also highlighted when measuring 3D models. You can also measure angles using this feature (see distance measurement).

- **Dimension measurement**: Click any highlighted item in the view to display the dimensions for that object. Double-click to measure the dimensions of component, and single-click to measure a surface. Dimensions appear in a label callout. For example, you can click on a cylinder to display the height, radius, and area. Or, you can click on an arc to display the length and radius.

- **Distance measurement**: You can measure the distance between two components or surfaces. Double-click to select components, and single-click to select surfaces. If you want to measure a third item, such as a three point angle, press CTRL before the second mouse pick, and pick the second and third points to include in the measurement. By default, distance measurement is based on two mouse clicks.

**Note:** Any distance measurement that is not a specific point-to-point measurement will be minimum distance.

**Publishing Visualization Data to Windchill**

Most viewable data comes from managed CAD data; however, you can add visualization data, such as prepublished viewables, drawings, or EDZ files, directly into Windchill from your hard disk using the **Representations** table.

To do this, go to the details/properties page for a part and click the **View Representations** icon which appears directly under the 3D thumbnail area. This displays the **Representations** table. In this table, you can click **Create Representation** to upload the data to Windchill and create a thumbnail of the data.

When you submit a representation to be created in Windchill, the **Publish Monitor** dialog box displays the status of your published data in Windchill.

In order to publish documents, you must have the Document Collaboration Services option installed on the server. If you have this option installed, you can upload a Microsoft Word document or Microsoft Excel spreadsheet and automatically publish this file to PDF. In order to view or annotate the published PDF document, you must have the Document Collaboration Option installed.
Setting Preferences

You can set preferences for visualizing data in Windchill. To do this, click the Utilities link on the Home tab. From the Utilities page, you can click the Preferences link to view and set preferences. The preference tab, called Visualization, is shown next, followed by descriptions of the options:

- **Thumbnail Display in Search Results**: You can choose to display thumbnail images in the search results for viewable files. Search results load more quickly if thumbnail images are not displayed. The default is to not display thumbnails in search results.

- **Thumbnail Display on Properties Pages** (also called Details pages): You can choose to display thumbnail images on details pages for viewable files. Details pages load more quickly if thumbnail images are not displayed. The default is to not display thumbnails on details pages.

- **Loading ProductView Data**: Choose how to load files from Windchill into ProductView. You can load all related files as a single EDZ file, which is best for viewing a large assembly. Or, you can choose to load files on an as-needed basis, which is best for viewing a small assembly or pieces of a large assembly. The default is to load files as needed.

- **Tool Tips Display**: Choose whether or not to display tool tips on the visualization pages when the mouse cursor is over an icon. Tool tips are not available for the Publish Monitor page. The default is to display tool tips on visualization pages.

- **Select Viewing Tool**: Choose to use either ProductView Standard Edition or ProductView Lite Edition as the visualization client. ProductView Lite Edition is the default.
• **Visualization Collection:** Choose whether to make the Visualization Collection available for use. The Visualization Collection allows Windchill items to be copied to ProductView.

**Tip:** You can use the Related Preferences box, which is highlighted in the graphic shown below, to quickly open a different visualization preferences page.

You can also set preferences within ProductView Lite Edition. For more information, refer to the ProductView Lite Edition online help.
This chapter introduces you to CAD data management in Windchill ProjectLink. First, CAD documents, the containers of CAD file information, are described. Next, you are introduced to the workspace, a private area that allows you to view and manage CAD information. Later sections take you step-by-step through the processes of saving CAD data to Windchill ProjectLink and creating enterprise part structures from CAD data.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About CAD Documents</td>
<td>6-2</td>
</tr>
<tr>
<td>About the Workspace</td>
<td>6-2</td>
</tr>
<tr>
<td>Saving CAD Data to Windchill ProjectLink</td>
<td>6-5</td>
</tr>
<tr>
<td>Creating CAD Documents with Pro/ENGINEER Wildfire CAD Data</td>
<td>6-12</td>
</tr>
<tr>
<td>Creating Part Structures for CAD Data</td>
<td>6-16</td>
</tr>
<tr>
<td>Setting the Preference to Display the Workspaces Sub-navigation</td>
<td>6-23</td>
</tr>
</tbody>
</table>
About CAD Documents

A document is a database object containing files in application format. CAD documents are Windchill objects that are used to store and manage CAD information files (the output of CAD authoring applications).

A CAD document typically has content and attributes that are relevant to the external application only, such as Pro/ENGINEER files (3-D models, drawings, viewable images, analyses, and so on). It can contain both primary content (for example, a 3-D CAD model file), and secondary content (for example, a drawing).

CAD documents have the following additional characteristics:

- Ability to be related to other CAD documents to allow representation of the complex dependencies created and maintained by the authoring CAD system (for example, model-to-model in a Uses/Used by relationship, or model-to-drawing in a secondary relationship).

- Required dependents, which are other CAD documents whose file information is needed to fully represent the total structure of the original CAD Document (those documents with file information necessary to regenerate the model in Pro/ENGINEER Wildfire).

- Ability to be related to enterprise parts so that a CAD document can Describe the associated enterprise part. The part is said to be Described By the CAD document, that is, by the primary content (often a 3-D CAD model) and optional secondary content (drawings, layouts, CAD tool-generated reports, analyses) that it contains.

As described later in this chapter, the CAD document structure of related CAD documents can be used by the Windchill build rule to build a product structure of associated enterprise parts.

About the Workspace

The workspace is a private area where you can manage multiple objects and perform basic Product Data Management (PDM) operations. Technically, the workspace is a folder in your personal cabinet in Windchill ProjectLink, but it is one that allows you to conveniently view and perform actions on both enterprise parts and CAD documents.

Workspace Features

Some of the special features of a workspace include the following:

- At its creation, a workspace is associated with a Windchill context. Commands available in the workspace are appropriate for its context, and object creation, storage, and retrieval actions are, by default, within the confines of a context.
• Workspace functionality varies, depending on whether or not the workspace is your active workspace (that is, your designated workspace for PDM operations while working with Pro/ENGINEER Wildfire), or it is being used in standalone mode.

• The workspace holds data for the objects referenced in it by the use of baselines.

• The workspace holds references to configuration specifications, folders, and life cycles applicable to parts and documents, and views for parts.

• Objects in the workspace can be sorted by the principal attributes that form the column headers in the **Object List** table.

• You can filter object types for display. For example, you can choose CAD documents only, or parts only, or specify a custom filter defined according to a chosen object attribute.

• The workspace has an event console, available from the **View** menu, to view system messages that report on the success or failure of your PDM actions.

• The status of objects in the workspace relative to the database is reported both by a column in the **Object List** table and a graphical symbol on the type icon of the object.

**Workspace Configuration**

You can configure your workspace so that the objects you work with can inherit certain properties by default. For example, you can:

• Set values for common attribute sets, such as team or life cycle.

• Assign storage folders

• Assign configuration specification for CAD docs and enterprise parts
Workspace Actions

Once enabled, the **Workspaces** sub-navigation link on the **Project** context tab takes you to the **My Workspaces** page, where you can view a list of existing workspaces, as well as create or delete workspaces.

Note: By default, the **Workspaces** sub-navigation in Windchill ProjectLink is unavailable prior to creating a workspace via Pro/ENGINEER Wildfire, or setting a user preference to display the link. See [Setting the Preference to Display the Workspaces Sub-navigation](#), later in this chapter.

Clicking the hyperlink for an existing workspace in the **Workspace Name** column takes you to that workspace.

Once you enter a new or existing workspace you have the ability to perform the following PDM actions:

- Download database objects to the workspace (obtain a read-only copy)
- Check out objects (obtain a working copy for modification)
- Create new objects
- Upload and check in objects during modification
- Undo checkout of objects
• Associate objects, either explicitly, or by using the autoassociate function (which automatically creates and associates an enterprise part for a CAD document).

• Search or browse the database for objects. Search and browse functionality is integrated with most workspace actions.

• Revise objects to be the start of a new branch of development

• Update objects with the latest database version

• Move objects to new storage locations

• Remove objects from workspace

• Set the life cycle state of an object

• Select an organization for an object

• Access an object details page

• Delete objects from the database

Detailed information about performing all of the above actions is available in the online help topics that can be accessed from the workspace and its action pages.

**Saving CAD Data to Windchill ProjectLink**

This section explains how to capture Pro/ENGINEER Wildfire CAD data in your Windchill ProjectLink system. The steps can be summarized as follows:

1. Create or open a project context workspace

2. Register the Windchill ProjectLink server and workspace in Pro/ENGINEER Wildfire.

3. Set your primary server and active workspace

4. Create or retrieve CAD data in Pro/ENGINEER Wildfire.

5. Upload CAD data to your workspace and check into Windchill ProjectLink.

**Note:** This is a sample workflow for illustrative purposes. Alternate workflows (for example, creating the workspace after registering your Windchill ProjectLink server in Pro/ENGINEER Wildfire) are also possible. The interaction with other CAD tools may be different. If you are working with a CAD tool other than Pro/ENGINEER Wildfire, be sure to consult the user’s guide for the appropriate Workgroup Manager.

**Creating a Workspace for Your Context**

Typically, product development begins with an idea for a product. Even before an initial sketch is made, it can be beneficial to establish a container or location for
all information that relates to that product’s development and implementation. A Windchill ProjectLink context, for example, a project, is just such a common location. When you create a workspace, you associate it with a context, which by default enables object creation, storage, and retrieval actions to be within the confines of the context.

Use the following procedure to create a workspace for your context:

1. Click the **Project** tab, and then select the **Workspaces** subnavigation link. The **My Workspaces** page for the context appears, displaying a list of existing workspaces. You can also access the commands to create or delete workspaces.

2. Click **Create Workspace**.

   The **Create New Workspace** window opens.

   ![Create New Workspace](image)

   *Workspace name and Context are required.*

3. In the **Name** field, specify a unique name for the workspace.

4. Optionally, in the **Description** field, enter a description for the workspace.

5. Select a context for the workspace from the choices available in the **Context** drop-down list.
6. Click **Ok**. You receive a confirmation message that the new workspace has been created and the new workspace page appears in the browser window.

**Note:** Preferences for document and part life cycles, team, view, and folders are set on the **Edit Workspace Options** page. To set or modify these values, select **Edit > Workspace Preferences** on the workspace page.

### Registering Your Server and Workspace in Pro/ENGINEER Wildfire

When you register your server and workspace in Pro/ENGINEER Wildfire you can access them through the embedded browser in a Pro/ENGINEER Wildfire session.

Use the following procedure to register your workspace:

1. From the Pro/ENGINEER Wildfire menu bar, select **Tools > Server Registry**.
The **Server Registry** dialog box opens.

2. On the **Servers** tab, click **Add**. The **Register new server** dialog box opens.

3. Specify the server name to appear in the Pro/ENGINEER Wildfire **Folder Navigator**.
   
   **Note:** You can enter any name for the server.

4. Enter the URL to the Windchill ProjectLink server location.

5. Click **Check** to validate the server location.
6. Enter the user name and password in the authentication dialog box.

7. Select your workspace from the **Workspace->Context** drop-down list.

8. Click **OK**. The Windchill ProjectLink server is added to the Pro/ENGINEER Wildfire **Folder Navigator** and is available from the **File Open** dialog box.

The procedure just described registers your server and workspace in Pro/ENGINEER Wildfire. At this point you have access to your new workspace and your other workspaces and files located on the registered server. To designate the new workspace as your default workspace for PDM operations while working with Pro/ENGINEER Wildfire, you need to set it as the active workspace on your primary server.

### Setting Your Primary Server and Active Workspace

Use the following procedure to set your workspace as the active workspace on your primary server:

1. In Pro/ENGINEER Wildfire, select **Tools > Server Registry** to bring up the **Server Registry** dialog box.
2. Select the server you want to make primary and click Set.

3. Click the Workspaces tab. The workspaces for your primary server are listed. The currently active workspace is shown with an active workspace icon.

After a moment, the red primary server indicator arrow appears next to your chosen server.
4. Select the workspace you want to be active and click **Activate**.

Your chosen workspace is now indicated as the active workspace, both in the **Server Registry** dialog box and in the **Folder Navigator**.
Creating CAD Documents with Pro/ENGINEER Wildfire

CAD Data

You, or your design team, can create CAD data for your product using Pro/ENGINEER Wildfire. In your workspace, you can create CAD documents and assign CAD files as the primary and secondary content of the CAD documents.

To create a CAD document with a primary content file, do the following:

1. In your workspace, select File > New > CAD Document or click Create CAD Document.
The **Create CAD Document** page appears.

2. Enter or select entries for the following fields:

   - **Number** -- The number you enter must be unique.
     
     **Note:** If the site preference to use auto-numbering is set, this field is inactive and you cannot enter a number manually.

   - **Context** -- Select a context from the drop-down list provided. Your workspace context is entered by default.

   - **Name** -- Enter a name for the new document. The default name is the same as the number.

   - **File Name** -- Enter the CAD file name that the new document will reference (include the file extension). Typically, this is a Pro/ENGINEER PRT or ASM file.

   - **Type** -- Select the type of object.

   - **Location** -- Enter the path or browse to a folder within your selected context where the CAD document will be saved. Click **Browse** to display the **Select Cabinet or Folder** page and select a cabinet location on the server. You can also create a new folder.

   **Note:** **Number** is a required field unless autonumbering is on. If autonumbering is on, **File Name** is a required field.
Note: If the site preference to display organization information is set, you can also set a value for Organization ID. If you select an external organization, the Number field accepts a manual entry even if autonumbering is on.

3. If you want to simultaneously create an associated part, select the Create and Associate Part check box.

Note: It is recommended that you associate a part with a CAD document at object creation, not when you create a structure. For this chapter’s introduction to the process, however, we will describe associating parts to documents in a separate section to follow.

4. Click Ok.

You can repeat this process for whatever number of CAD files you need to represent your product.

Note: CAD documents can be created from Pro/ENGINEER Wildfire session by simply saving the models to the active workspace. Secondary content (for example, images, transfer files, and ZIP files) can be created and attached to the CAD document from Pro/ENGINEER Wildfire, as well.

**Checking CAD Documents into Windchill ProjectLink**

CAD documents newly created in your workspace are not visible to other users until they are checked in. Use the check in command to remove the lock on an object and make it available for check out by other users.

To check in an object:

1. In the active workspace, select the object(s) that you want to check in
2. Select **File > Check In** or click **Check In**. The **Check In** page appears.

3. On the **Check In** page, clicking the following icons in the **Object List** tool bar enables the following described options:

   - **Location** (also available in the **Location** column) -- Opens the **Select Cabinet or Folder** window to allow you to select the context and storage location for the selected object.

     **Note:** The context of an object is defined at first upload. You cannot move objects between contexts.

   - **Include Drawing** -- Selects for check in all parent drawings associated with the selected object.

   - **Include Parts or Documents** -- Selects for check in any parts or CAD documents associated with the selected object.

   - **Keep Checked Out** -- Toggles whether or not to check in the contents of the selected object to the server and immediately recheck out the object to your workspace.

   - **Included/Exclude** -- Includes or excludes the selected object from being checked-in. Excluded items are struck-through with a red line.

     **Note:** You cannot exclude children of objects to be checked in without excluding the parent. Error messages are shown in the text area above the list.
4. Selecting **Create Baseline** creates a baseline with a default number with your log on name, date, and time.

5. Selecting **Design Complete** allows you to undo check out for the unmodified dependents of the items selected for check in. This removes your lock on the set of the objects when your work is complete.

6. If the items selected for check in or items added to the list based on dependencies include incomplete objects, an **Auto resolve incomplete objects** check box is available. When selected, the autoresolve functionality handles incomplete objects in two ways, based on settings on the **Check In Options** page:

   - In the default method, the system searches for an object on the server with the same file name. If one is found, the incomplete object is updated by the found file, which means that it is no longer incomplete, and, therefore, available for check in.

     If no object is found to update the incomplete object, the system ignores the incomplete object (which is removed from the check in list).

   - The system can be set to always ignore an incomplete object

   **Note:** On the **Check In Options** page you can set the autoresolve functionality either to attempt to update the incomplete object and ignore the object if updating is not successful, or to always ignore an incomplete object.

   **Note:** Site administrative settings may not allow the ignore option. Required dependents cannot be ignored.

7. Click **Ok**.

   Upon check in, the relationships of CAD files that represent the various components of an assembly are propagated to the CAD documents that reference them. For example, this means that the CAD document for, say, a parent axle assembly, has a Uses relationship with the CAD document for a child wheel assembly. In other words, the physical relationship of parent and child parts is captured in the resulting CAD document structure.

---

**Creating Part Structures for CAD Data**

Once a CAD document structure has been created, a product structure can be created in Windchill ProjectLink by creating and associating an enterprise part to each CAD document in the CAD document structure, and then checking all the objects into Windchill ProjectLink. Upon check in, the Windchill build rule uses the relationships among the CAD documents to build a product structure relating all the enterprise parts.
Associating CAD Documents to Enterprise Parts

It was mentioned in the section on creating CAD documents that a recommended practice is to create and associate enterprise parts with CAD documents at the time of creation. However, there are at least two reasons why that practice might not be followed:

- The CAD documents were created in the workspace by the Save and Upload command in Pro/ENGINEER Wildfire, not using the Create CAD Document window in the HTML UI.

In this case, the workspace provides the Auto Associate Parts command that allows you to select multiple CAD documents, and then create and associate enterprise parts for those documents with a single click. You can also associate documents to existing parts.

- Enterprise parts intended to correspond to the CAD documents have already been created in Windchill ProjectLink.

In this case, the Associate command allows you to select a CAD document and then search or browse for the appropriate enterprise part to which to associate it. The Associate command also allows you to start with a part and find an appropriate CAD document. The use of both commands is detailed in the following sections.

Automatically Associating Parts

The Auto Associate Parts command allows you to automatically find and associate an existing part to a CAD document or, if no matching part currently exists, create a new part and associate it to the CAD document. This functionality operates according to several conditions, and is accomplished using the Auto Associate Parts page.

Note: The exact manner in which the part is searched for, created, named, and numbered depends on preferences set by a site administrator. For more information, see the Windchill System Administrator's Guide.

Auto Associate Conditions

The autoassociate parts functionality works in accordance with the following conditions:

- For a successful association, the document must be checked out and have no existing associations, and the part must be checked out (autoassociate automatically checks out the found or created part to the workspace). Documents and associated parts remain checked out to the workspace after association.

- While searching parts, if more than one part per document is returned, then the Auto Associate Parts command ignores the document and an error message is shown in the event console.
• In multi-selection, if you select parts and checked in documents along with qualified CAD documents, the parts and checked in CAD documents are ignored by the Auto Associate Parts command. If none of the selected objects are valid candidates for the command, then a status message is shown:

None of the selected objects is eligible for the 'Auto Associate Parts' action.

• If you select a newly created drawing document, the system searches for a model for the drawing in the database. If the model is found, the system creates a Described By link between the part and the drawing, and an active association between the part and the model. If the model is not found, a message stating this is reported in the event console.

Auto Associate Page

When you select a CAD document from the workspace and click Auto Associate Parts, the Auto Associate Parts page appears with two object list tables.

The first table, preceded by the message **Following associations will be created to existing parts**, lists documents and existing parts proposed to be associated. If no existing parts are found the table message instead reads **Search found no existing parts**. When parts are found, the information and possible actions are presented in the columns described in the following table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Untitled column</td>
<td>Contains a check box which lets you select the object represented by that row.</td>
</tr>
<tr>
<td>Type</td>
<td>Contains the object icon specific to the document type and its state.</td>
</tr>
<tr>
<td>Doc Number</td>
<td>Displays the number of the selected document, formatted as a hyperlink to document details page.</td>
</tr>
<tr>
<td>Doc Version</td>
<td>Displays the version and iteration of the selected document.</td>
</tr>
<tr>
<td>Part Number</td>
<td>Displays the number of the part found during the search based on the search criteria, formatted as a hyperlink to the part details page.</td>
</tr>
<tr>
<td>Part Name</td>
<td>Displays the name of the part found during search based on the search criteria.</td>
</tr>
<tr>
<td>Existing Association</td>
<td>Displays the current association (active or passive) between the selected document.</td>
</tr>
<tr>
<td>Modify Association</td>
<td>Contains a drop-down list that allows you to modify the current association between the selected document and part.</td>
</tr>
</tbody>
</table>

The second table, titled **Following associations will be created to new parts**, lists documents and proposed new associations. The information
and possible actions are presented in the columns described in the following table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Untitled Column</td>
<td>Contains a check box which lets you select the object represented by that row.</td>
</tr>
<tr>
<td>Type</td>
<td>Contains the object icon specific to the document type and its state.</td>
</tr>
<tr>
<td>Doc Number</td>
<td>Displays the number of the selected document, formatted as a hyperlink to document details page.</td>
</tr>
<tr>
<td>Doc Version</td>
<td>Displays the version and iteration of the selected document.</td>
</tr>
<tr>
<td>Part Number</td>
<td>Contains a field specifying the number of the part associated to the selected document. The field may be editable, depending on the site preference set.</td>
</tr>
<tr>
<td>Name</td>
<td>Contains a field specifying the name of the part associated to the selected document. The field may be editable, depending on the site preference set.</td>
</tr>
<tr>
<td>Location</td>
<td>Contains a text field and folder browse button so that you can browse to and set a folder location for selected parts.</td>
</tr>
<tr>
<td>Source</td>
<td>Contains a drop-down list to specify how the part should be sourced.</td>
</tr>
<tr>
<td>Default Units</td>
<td>Contains a drop-down list for setting the default units for the selected part.</td>
</tr>
<tr>
<td>Association</td>
<td>Contains a drop-down list which allows you to modify the current association between the selected document and part.</td>
</tr>
</tbody>
</table>

To auto associate parts, perform the following steps:
1. In the workspace, select the documents to which you want to auto-associate parts and select **Edit > Auto Associate Parts.** The **Auto Associate Parts** page appears.

2. Examine the associations listed in the table of existing associations, using the **Modify Association** column to change the association type, if desired.

3. Examine the table of proposed associations. If necessary, modify the part number, name, type, or type of association (as allowed by the preference settings of your site).

4. If the auto-numbering preference is set to on and the auto associate policy is custom, you can move rows from the existing parts table to the proposed association table, using the **Move Rows** command in the menu bar of the existing parts table. Only rows having **none** as the existing association can be moved.

5. Use the button in the **Location** column, along with the drop-down lists in the **Source** and **Default Units** columns, and the check boxes in the leftmost column, to set values for one or more rows.

6. Click **OK**.

**Note:** The view assigned is the one specified in the **General** tab of the **Edit Workspace Options** window.

**Associating CAD Documents to Parts.**

Windchill creates structural relationships between WTParts and related CAD documents and maintains the association until it is no longer linked.

The **Associate** command allows implicit checkout of CAD document and WTPart objects, if they are not already checked out. In the case of a CAD document,
checkout is for meta data checkout only; no content is downloaded during this checkout action. The Describes or Described By information in the property sheets of the CAD document and WTPart displays the current relationship between a WTPart and a CAD document, even if the CAD document is not checked in. Before a CAD document is associated, the system performs an implicit (automatic) checkout.

**Note:** Any object checked out implicitly remains checked out even if the association fails to check out the other object.

**Note:** After you associate WTparts with all CAD documents in an assembly, you can see the association; however, Uses links between the WTparts are not visible until after check in, when the Windchill build rule constructs the Uses links.

It is recommended that you associate a WTPart with a CAD document at the time of object creation, not when you create a structure. A CAD document is said to Describe an enterprise part to be included in the bill of materials, and an enterprise part is Described By a CAD document.

To associate a CAD document with a part:

1. Select the CAD document you want to associate with a part in the workspace.

   **Note:** You may select more than one CAD document to associate with a part. In this case, all the documents describe the part; however, only one document can have an active link to the part.

2. Select *Edit > Associate*. The *Associate to* page appears.
3. Search for or browse to the part you want to associate to your CAD document. Your results appear on the Select the Parts to Associate page.

4. Select the part you want to associate with the document and click OK. The selected part is shown in a row on the Associate to page.

5. By default, the system creates an active link between the CAD document and the selected part. If you do not want the CAD document to drive the structure and attributes of the part, select None from the drop-down list in the Active Link field.

6. Click OK.

7. Perform a check in on the objects.

Note: Checking in the newly associated objects completes the association by allowing the Windchill build rule process to create Uses links between the parts of a part structure.

To verify the association, view the details page for either object. Clicking Described By on the details page for a part shows the associated CAD document. Clicking Related Parts on the details page for a CAD document shows the associated part in the Describes table.

Once checked in, the parts you associated to CAD documents have a product structure, which is visible on the Product Structure page for the top-level part.
Setting the Preference to Display the Workspaces Sub-navigation

By default, the Workspaces sub-navigation in Windchill ProjectLink is unavailable prior to creating a workspace via Pro/ENGINEER Wildfire, or setting a user preference to display the link. You can set the display preference using the following procedure:

1. From the Home tab, select the Utilities subnavigation, then the Preferences link. The Edit User Preferences page appears.

2. Click Display, then select the CAD Workspace link. The CAD Workspace area appears.

3. Select the check box to enable the use of the CAD workspace and click OK. The Workspace link now appears as an available context sub-navigation link.
This chapter describes the functionality within Windchill ProjectLink that enables team members to effectively collaborate.

**Topic** | **Page**
--- | ---
Communication Tools | 7-2
Meetings | 7-2
Subscriptions | 7-5
Discussion Forums | 7-6
File Routing Information | 7-7
Communication Tools

Many companies face the challenge of working effectively together when working across multiple sites and with other companies. People usually work in several different ways to develop product concepts, update ideas for the team, and communicate these ideas; however, often issues arise when an update is made, but not clearly communicated. Windchill ProjectLink provides functionality that overcomes these challenges. For example, you can use Windchill ProjectLink in the following ways to communicate clearly with your team:

- Create new iterations of a document and send an e-mail to the team
- Discuss design ideas using a discussion forum
- Keep track of the work you need from other team members by subscribing to changes
- Comment on designs using the markup capabilities in ProductView
- Route the latest version of a document to the team for review
- Set up an online meeting to review proposed design changes using the ProductView or WebEx meeting capabilities

This section describes the following functionality which allow you to collaborate with your team effectively:

- Meetings
- Subscriptions
- Discussion Forums
- File Routing Information

Meetings

Meetings are a common experience in the successful project process. Although some meetings may be conducted by a group of people in a single room, because of multiple site challenges, many meetings are conducted over the telephone. Also, online meetings are conducted to enable people from multiple sites to join a meeting and view the same meeting material. Windchill ProjectLink provides capabilities for all types of meetings.

You can create one of the following types of meetings in Windchill ProjectLink:

- Standard -- A meeting that includes an agenda, meeting participants, and the meeting details, such as date, time, and telephone information. This type of meeting supports those held in a single geographic location and those conducted in multiple sites over the telephone.
• Web-based -- A meeting that includes all the features of a standard meeting but is conducted through WebEx in order to share meeting presentations or other materials in real time. This meeting accommodates team members in multiple sites who all need to view the same materials at the same time.

**Note:** WebEx is not supported in the Korean language.

• ProductView -- A meeting that includes all features of a standard meeting but with the ability to share two or more sessions of ProductView with meeting participants. This meeting enables team members in multiple sites to conduct a meeting during which they need to view and mark up a CAD image over real time. ProductView peer-to-peer meetings allow different team members to take turns controlling the image, enabling real time collaboration.

**Note:** To host or join a ProductView meeting, you must have ProductView installed on your system.

To see all meetings to which you are invited, go to the **Meetings** page on the **Home** tab.

Meetings can be also created for specific projects. For example, to see all meetings scheduled for a particular project, go to the **Meetings** page on the **Project** tab.

To view the information page of a meeting, click on the meeting name. The information page displays the meeting details as well as any meeting minutes or action items.
The following table lists and describes the actions available for meetings:

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create Meeting          | ![Create Meeting](image) | Creates a new meeting instance. If it is a standard meeting, the instance contains the information necessary to attend the meeting, such as site location and telephone number. If it is a WebEx or ProductView meeting, the instance also contains the necessary links to access the meeting.  

**Note:** If you want to be listed as a meeting participant, you must add yourself to the list of participants. If you do not add yourself as a meeting participant, the meeting does not appear in the list of meetings on the Meetings page of the Home tab. |
<p>| Update                  | <img src="image" alt="Update" /> | Updates the details of an existing meeting. Only the meeting creator can update a meeting. Select Update from the actions list next to the meeting name. |
| Join                    | <img src="image" alt="Join" /> | Opens the meeting session in either WebEx or ProductView. Select Join from the actions list next to the meeting name. You can only join a meeting to which you were invited. |
| Host                    | <img src="image" alt="Host" /> | Opens the meeting session in either WebEx or ProductView and establishes you as the meeting controller. Select Host from the actions list next to the meeting name. You can only host a meeting if you are the meeting creator or if the meeting creator designated you as the host. There can only be one host per meeting. |
| Add Meeting Minutes     | <img src="image" alt="Add Meeting Minutes" /> | Creates meeting minutes associated with the meeting. Select Add Meeting Minutes from the actions list next to the meeting name. You can only add meeting minutes if you are the meeting creator. |</p>
<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td></td>
<td>Opens the meeting information page to display the References table where you can associate parts, documents, and links to the meeting. See Chapter 1, Getting Started with Windchill ProjectLink for more details on notebooks and reference lists.</td>
</tr>
<tr>
<td>Cancel</td>
<td>✗</td>
<td>Deletes the scheduled meeting. You can only cancel a meeting if you are the meeting creator.</td>
</tr>
<tr>
<td>List Action Items</td>
<td></td>
<td>Opens the meeting information page to display any action items associated with the meeting. Select List Action Items from the actions list next to the meeting name. If you are the meeting creator, you will be able to create action items from this page.</td>
</tr>
</tbody>
</table>

**Subscriptions**

Subscriptions allow you to be notified of changes to objects within the system without constantly monitoring individual pieces of information stored in the system. You can also subscribe to a discussion forum, topic, or posting as described later in this chapter. You can subscribe to one or more specified events for a particular object, which will result in e-mail notifications concerning a change in that particular event for that object.

All of your subscriptions are displayed on the Subscriptions page of the Home tab.

To subscribe to an object, select Subscribe from the actions list next to the object. If the Subscribe option is not available, the object type does not support subscriptions. When you want to stop receiving e-mail notifications concerning a specific subscription, simply select the subscription and click Delete ✗. For more details about creating and viewing subscriptions, see the online help available from the Subscriptions page.

**Tip:** You cannot update subscriptions. To modify your existing subscriptions, you must delete the unwanted ones and create new ones.
Discussion Forums

The ongoing exchange of ideas between project participants is an expected part of the successful project process. These exchanges sometimes occur over e-mail, in casual hallway conversations, or in impromptu meetings. Unfortunately, this often means that some team members are not involved in the exchange or the decision is not recorded and therefore lost. Discussion forums are particularly useful to asynchronously engage in conversations by posting questions and answers among geographically distributed members that cannot meet in person or even via the telephone because of large time zone differences. Windchill ProjectLink provides discussion forums which enable all team members to participate in discussions about a certain facet of the project, such as a design idea, and which also capture the discussion for future reference.

A discussion forum consists of topics, postings, and replies. The functionality is very similar to that of message or chat boards often encountered in the World Wide Web. These discussions are located on the Forum page of the Project tab.

A topic is represented by a folder icon 📚. The topic determines the focus of the discussion. For example, if the topic is titled Design Ideas, then all of the postings beneath it should relate to design ideas. Within topics, you can either create postings or reply to existing postings. A posting is a message from a team member concerning the topic. After one posting is created, another team member can reply with comments specific to that posting, create a new posting dealing with design ideas, or create a new topic for the team to discuss. Anyone can subscribe to individual topics and postings or to the entire discussion forum.

A discussion forum can be displayed in one of the following views available in the Current View drop-down list:

- Tree view - The default view of all discussion forums. Displays the topics as folders with postings and replies underneath the topic. Allows individual subscribing to topics and postings as well as to the entire discussion forum.

- Table view - Displays all of the postings in a listing regardless of their relationship to other postings or topics. The name of the topic to which a posting may belong is identified in the Topic Name column. In table view, you can only subscribe to the entire discussion forum, rather than to individual topics or postings. You cannot reply to a posting. You can only create additional postings. When a topic is created, it does not appear in the discussion forum table. However, all created topics are available from a drop-down list on the Create Posting window.

Object-Specific Forums

Forums can also be associated with a particular object, such as a document or part. Those forums relate specifically to the part or document and are started by selecting the Discuss action located in the actions list next to the object.
Forum Actions

The following table lists and describes the actions you can perform on the Forum page:

<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Topic</td>
<td>📝</td>
<td>Creates a new topic, or folder, in the discussion forum. All postings concerning this issue are collected under or related to this topic.</td>
</tr>
<tr>
<td>Create Posting</td>
<td>📝</td>
<td>Creates a posting related to an existing topic.</td>
</tr>
<tr>
<td>Reply to Posting</td>
<td>📝</td>
<td>Creates a new posting in response to an existing posting.</td>
</tr>
<tr>
<td>Subscribe</td>
<td>📝</td>
<td>Creates a subscription to the forum, topic, or posting so that an e-mail notification will be sent to you whenever a new posting is created. You can subscribe to the entire forum which means that you will receive e-mail notifications concerning changes to any of the topics and creation of any new topics. You can also subscribe to just a single topic to be notified of any new postings, or a single posting to be notified of any new replies.</td>
</tr>
</tbody>
</table>

File Routing Information

It may be necessary to have a document or part reviewed or approved by a number of the team members. Or perhaps, you only want to let other team members know that your document exists. In Windchill ProjectLink, creators or owners of documents or parts have the ability to send that object through a process, or route. Windchill ProjectLink provides the following routing process options out of the box that enable clear communication among team members:

- Approval - The document or part moves through a process of review and approval by assigned participants. The team members you have assigned to the approver role for this route must review the object and either approve or reject it. Based on the results of the route, you can then decide what steps must be taken.
• Notify - An e-mail is sent to assigned participants notifying them about the part or document. This route allows you to send a mass e-mail to specified team members letting them know that the object exists and might be of interest to them.

• Release - The document or part moves through a process of approval and then official release by the assigned participants. This enables you to track the decision that made the object final.

• Review - The document or part moves through a process of review by the assigned participants. This allows you to gather comments and input necessary to the completion of your document or part.
The following chart is an example of a Review route workflow:

For each process, you can define the team members on the distribution list and also specify instructions for those assigned participants. Assigned team members receive e-mail notifications containing instructions. Also, the task appears in their list of tasks to be completed on the Assignments pages of either the Home or Project tab. The state of the part or document will change based on its status in the route process.

To route a part or document, select Route from the actions list next to that object or select the part or document and click on the Folders page.

You can view the route status of the part or document by clicking Route Status in the actions column next to the object. You can also view the route status on the object's information page. From the Routing History table on the object's information page, you can change the route participants by clicking Update Route. You can also terminate the route from this table by clicking Terminate Route. The Route History table only displays the routing information for the current route in progress, replacing any information from previous routes.

Once a route has been started and completed, a record of that route is maintained in the system. If you route the same object again, a message will appear stating which route has already been applied to the object.

Comments made by route participants are stored in the object’s discussion forum and remain there regardless of the number of times the object is routed. The discussion postings associated with a routing are grouped by the time and date stamp as the discussion topic.
For example, the following figure shows a document being routed for Approval.

Once the document has been routed, the **Route Status** button appears in the actions column on the **Folders** page. The routing status is displayed on the document details page. Tasks related to the route appear in the assigned participant's task list. As the route progresses, the state of the document changes from Under Review to Approved.
This chapter discusses searching for objects within Windchill ProjectLink.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Search</td>
<td>8-2</td>
</tr>
<tr>
<td>About Keyword Searches</td>
<td>8-2</td>
</tr>
<tr>
<td>About the Advanced Search Page</td>
<td>8-3</td>
</tr>
<tr>
<td>About Search Results</td>
<td>8-8</td>
</tr>
<tr>
<td>About Wildcards</td>
<td>8-10</td>
</tr>
</tbody>
</table>
About Search

Searching in Windchill ProjectLink allows you to find objects (such as documents and parts) in your local database by searching the attributes, and possibly the content, of the objects.

Note: This manual and the online help for searching describe the out-of-the-box object types and search fields that are predefined by Windchill ProjectLink. Both may be augmented by customizers at your site. For example, your site may have created additional object types and attributes which can be searched.

You encounter search throughout Windchill ProjectLink, as you perform various actions. For example, when creating a document you can search for the folder in which the document should be located. You can use keywords to search the entire database or search a particular context from within a particular tab. You can also search from the Advanced Search page using multiple criteria to significantly narrow or broaden your search, as needed.

About Keyword Searches

Using a keyword search, you can search for one or more words across multiple attributes, usually the object name and number, at one time. The default is to search the name and number attributes; however, your System Administrator may have selected other fields. Using wildcards broadens the search results returned.

For example, if you do a keyword search for "eng*", then any object whose name or number contains that keyword would be returned. Object names such as "Engine" and "NewEng", and object numbers such as "eng45" would be returned in the search results.

If RetrievalWare is installed on your system, then your search results will return any objects that contain the keyword in either the object attributes or the object content as well. For example, the same keyword search for "eng*" on a system with RetrievalWare would also return documents containing the word "engine" or "engineer" in their text.

Tip: Since there is no visible way to see if RetrievalWare is installed on your system, contact your System Administrator to determine if RetrievalWare has been installed at your site.

You can perform keyword searches from a number of locations within Windchill ProjectLink.

The Search field appears in the upper-right corner of the header of your screens. This field allows you to search for all objects to which you have access.
The **Search within** field limits your search to objects that reside within a particular context. For example, from the **Home** tab, the **Search within my work** field limits your search to only the objects that you created or modified.

You can also limit your search to a specific project by navigating to the desired project, and using the **Search within** field available from the **Project** tab.

You can also perform keyword searches from the **Keyword** field on the **Advanced Search** page.

### About the Advanced Search Page

The **Advanced Search** page allows you to use multiple search criteria to define your search.

**Tip:** When you are searching for data in Windchill, you will find that it is possible to execute a search without specifying any search criteria or by choosing only an object type (for example, Part) on which to search. Because your site is likely to have a great deal of data stored in Windchill, quick and effective searching requires that you specify as many criteria as possible to refine your search.

Click the **Search** link or **Search within** link to open the **Advanced Search** page.

### Specifying Search Criteria

The **Advanced Search** page displays fields for specifying search criteria. These fields correspond to object attributes. Depending on the object type or types you are searching for, different fields are displayed because each object type has different object attributes.

For example, if you select **Part** in the **Search For** field, the **Source** field is among the fields displayed, as source is an attribute of a part. If you select **Document** in the **Search For** field, however, the **Source** field is not displayed. Both parts and documents have the **State** field in common.
Entering search criteria in these fields makes your search more specific. Leaving a field blank returns all available results for that field. If a **Show More Attributes** link appears below the search criteria fields, your site has added additional properties for your search. Click the link to search on those properties.

**Tip:** The more fields in which you specify criteria, the narrower your search will be, and the number of objects returned in your search results is reduced. If you are not seeing the search results you expect, try broadening your search by leaving more fields blank.

If you enter criteria in a field that does not correspond to a specific object, objects of that type are not returned in the search results. For example, if you are searching for all object types, but enter information in the **Name** field, certain objects, like product configurations, that do not have a name attribute will not appear in your search results.

### Special Characters in Search

If RetrievalWare is installed on your system, using the following characters in the **Keyword** field can give unexpected results:

- Wildcard characters: @, #, _, *, \, ?, [], ^
- Separators: ( )
- Characters used in dates: ., -, /

If your site uses these characters in object names or numbers, and you want to search for the exact object name or number, use the **Name** or **Number** field rather than the **Keyword** field for your search.

For example, if you are searching for an object named cad_document.prt in the **Keyword** field, RetrievalWare treats that name as three separate strings: "cad", "document", and "prt". The search results will not return the object you are searching for. To successfully find the object, search from the **Name** field, or use a partial name and wildcards in the **Keyword** field. For example, in the **Keyword** field, searching for "cad\*", "*document\*", or "*prt" would return results which include cad_document.prt.

Alternatively, you can also use the \ character as a wildcard in the **Keyword** field to indicate that the next character should be taken literally. For example, to search for a part named Bracket() in the **Keyword** field, enter "Bracket'()". The \ character tells RetrievalWare to search for the parentheses as literal characters, rather than as characters with special meaning.

For additional information on specifying search criteria for certain fields, see the online help available from the **Advanced Search** page.
Setting Search Preferences

You can customize your search process by setting your search related user preferences. Your available preferences may differ, depending on the settings at your site.

To open the Edit User Preferences window, click the Preferences link on the Advanced Search page, or the Preferences link on the Home tab Utilities page. Click the Search tab.

Through your search preferences you can set the number of search results that appear on a page of the Search Results table, and whether or not thumbnail images are displayed. You can choose whether or not to have the last search you perform always appear in the Saved Searches drop-down list. Depending on your site configuration, you can also choose which available libraries are searched when you perform a keyword search. A detailed description of each preference is available when you click on the link for that preference.

Saving a Search

If your search preference is set to do so, the last search you perform is always saved in the Saved Searches drop-down list. Also, searches performed on the Advanced Search page can be saved for later reuse. This is useful if you perform specific searches multiple times.

Click Save after you perform the search to name and save the query. You can now select your named search from the Saved Searches drop-down list and click Go.
to automatically populate the fields on the Advanced Search page with the search criteria you saved and perform the search.

**Tip:** If you save a search which includes criteria specified in fields accessed by clicking the Show More Attributes link, when you perform the search again, those additional search criteria will be searched upon, though they will not be automatically displayed with the search results. Simply click the Show More Attributes link to view the additional search criteria.

To remove a saved search from the Saved Searches drop-down list, select the search, and click Delete.

**Using Search Modes**

Search modes determine the way in which search interprets the keywords you enter in the Search, Search within, and Keyword fields. You select a search mode through user preferences. The available search modes are described below.

Search modes apply only when RetrievalWare is installed. Contact your System Administrator to determine if RetrievalWare is installed at your site.

**Concept Mode**

Concept mode is useful when you are not sure of exact terminology, because it allows you to search for both words you specify and words with similar meanings. For example, if you search for "part", the word might expand to query related terms such as "parts", "component", or "segment".

In concept mode, you can also specify an expansion to indicate the type of related concepts you want to retrieve. The simple variations expansion type, which is the default, retrieves variations in case, gender, number, tense, person, mood, and voice.

**Boolean Mode**

Use boolean mode to search for specific words and phrases, using standard boolean operators. If you select boolean mode and do not specify any operators, an AND operator is assumed.

For example, if you searched for "gear shaft not rotor" the search results would return those objects which include the words "gear" and "shaft", but not those objects which contain the word "rotor".
The following table explains the boolean operators used with the boolean search mode.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>()</td>
<td>(word1</td>
<td>word2) &amp; 3</td>
</tr>
<tr>
<td>not</td>
<td>not word1</td>
<td>Word1 must not be found.</td>
</tr>
<tr>
<td>^</td>
<td>^ word1</td>
<td>Word1 must not be found.</td>
</tr>
<tr>
<td>and</td>
<td>word1 and word2</td>
<td>Both word1 and word2 must be found. (This is the default operator.)</td>
</tr>
<tr>
<td>&amp;</td>
<td>word1 &amp; word2</td>
<td>Both word1 and word2 must be found. (This is the default operator.)</td>
</tr>
<tr>
<td>but</td>
<td>word1 but word2</td>
<td>Word1 must be found; word2 must not be found.</td>
</tr>
<tr>
<td></td>
<td>word1 but not word2</td>
<td>Word1 must be found; word2 must not be found.</td>
</tr>
<tr>
<td>within</td>
<td>word1 word2 within N</td>
<td>Word1 must be found within N words of word2.</td>
</tr>
<tr>
<td>wi</td>
<td>word1 word2 wi N</td>
<td>Word1 must be found within N words of word2.</td>
</tr>
<tr>
<td>adj</td>
<td>word1 word2 adj N</td>
<td>Word1 must be found within N words of word2, and word1 must precede word2.</td>
</tr>
<tr>
<td>between</td>
<td>word1 between word2 and word3</td>
<td>Word1 must be found between word2 and word3.</td>
</tr>
<tr>
<td>or</td>
<td>word1 or word2</td>
<td>Either word1 or word2 must be found.</td>
</tr>
<tr>
<td></td>
<td>(pipe)</td>
<td></td>
</tr>
</tbody>
</table>

**Pattern Mode**

Pattern mode is useful when you are not sure of the exact spelling of a word because it allows you to search for both words that you specify and words with similar spellings. For example, searching in pattern mode for the keyword "colour" can return results which include "color", "coloured", and "colorized".
Pattern mode also makes it easier to search OCR (scanned) documents, since spelling errors that sometimes result from document scanning are tolerated by the search.

**About Search Results**

When you perform a search from the Search field, the Search within field, or the Advanced Search page, the objects matching your search criteria are displayed in the Search Results table on the Advanced Search page. The number of objects displayed per page of the Search Results table is determined by your search preferences. Also, your search preferences determine whether thumbnail images are displayed in the table. Only those objects to which you have at least read access are included.

For example, if you performed a search for "a*" in the Name field, with your preference set to not display thumbnails, the search results returned would be similar to the following:

You can perform a number of actions from the Search Results table, including sorting the results, viewing the object details, and refining your search. Using **Copy to Clipboard** you can copy selected objects from your search results to paste in other locations. Using **Add to Project**, you can also add selected objects to a particular project.

**Tip:** If you manually sort the search results (using the Sort Ascending and Sort Descending arrows at the top of each sortable column), you need to perform your sort each time you search. If you have a particular sorting order you prefer, set that order through your user preferences.

Clicking on the hyperlinked object name or in the Actions column displays the object information page. From the information page you can view the object and...
perform a number of object related actions. For objects that have thumbnail images, clicking in the **Actions** column displays the thumbnail image.

Clicking in the **Actions** column allows you to view other object visualization information.

If your search preference is set to display thumbnail images in search results, the same search would return results similar to the following:

Existing thumbnail images are displayed in the **Thumbnail** column. If an object is capable of having a thumbnail, but no thumbnail has yet been created, then an icon is displayed which allows you to view the object’s visualization information. For example, in the above search results, the part named ALTERNATOR does not have an existing thumbnail image. Clicking displays the default configuration specification for the object type in ProductView. For additional information on visualization and ProductView, see [Chapter 5, Visualizing Data in Windchill](#).

If you do not see the results you expected, and you would like to modify the search criteria, click **Refine Search** above or below the **Search Results** table. This returns you to the top of the search page where you can review and modify the search criteria you entered.

For additional information, see the help available from the **Search Results** table.
About Wildcards

Wildcards allow you to modify your search. Without wildcards, search results are limited to the objects that exactly match the word or words you enter in the search field. The most common wildcard, an asterisk (*), indicates that one or more characters can appear in a position and can be used in any search field.

For example, to retrieve a document with the word "design" in the name, you would enter "*design*" in the search field. The asterisks indicate that the word could be preceded or followed by one or more characters.

Results like the following would be returned:

- Joe's design prototype
- A Design For Development
- Designing Engine Parts

The percent symbol (%) and underscore (_) can be used in object attribute fields (such as Name and Number) and in all search fields when RetrievalWare is not installed. The percent symbol works in the same way as the asterisk does, indicating that one or more characters can appear in a position. The underscore indicates that only one character can appear in that position.

For example, to retrieve a document with the word "design" followed by one character only, enter design_ in the search field.

Results like the following would be returned:

- designs
- DesignB

When RetrievalWare is installed, different wildcards apply in the following fields:

- The Search field at the top of your screen.
- Any Search within field.
- The Keyword field on the Advanced Search page.

Contact your System Administrator to determine if RetrievalWare is installed at your site. If RetrievalWare is installed, use the following wildcards in the previously mentioned fields:

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>@</td>
<td>Match exactly one alphabetic character.</td>
<td>c@are</td>
</tr>
<tr>
<td>#</td>
<td>Match exactly one numeric character.</td>
<td>#600</td>
</tr>
<tr>
<td>Wildcard</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>\</td>
<td>Indicates that the next character should be taken literally (the next character is not an operator).</td>
<td>service@mycompany.com</td>
</tr>
<tr>
<td>*</td>
<td>Match any character(s).</td>
<td>spec*</td>
</tr>
<tr>
<td>?</td>
<td>Match exactly one character.</td>
<td>g?dget</td>
</tr>
<tr>
<td>[]</td>
<td>Match only one character within the brackets. You can include a hyphen to</td>
<td>199[1-6]</td>
</tr>
<tr>
<td></td>
<td>indicate a range of numbers or letters.</td>
<td></td>
</tr>
<tr>
<td>[^]</td>
<td>Match any character except the character specified. You can include a hyphen to indicate a range of numbers or letters.</td>
<td>199[^1-3]</td>
</tr>
</tbody>
</table>
This chapter describes the details and best practices of setting up and executing a project plan.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Plan Management</td>
<td>9-2</td>
</tr>
<tr>
<td>Planning a Project</td>
<td>9-4</td>
</tr>
<tr>
<td>Executing a Project</td>
<td>9-27</td>
</tr>
<tr>
<td>Exchanging Information with Microsoft Project</td>
<td>9-41</td>
</tr>
<tr>
<td>About Project Templates</td>
<td>9-54</td>
</tr>
</tbody>
</table>
About Plan Management

Design Philosophy

The Windchill ProjectLink system is especially designed to support product development projects with teams that are distributed both geographically and organizationally. In this respect, it is ideal for companies that manage product development projects as part of a virtual, global product development company.

While Windchill ProjectLink supports planning functions, it is optimized to facilitate the execution and collaboration needs of a project team. Windchill ProjectLink takes advantage of Microsoft Project's planning strength through its support for importing and exporting a Microsoft Project plan. It complements Microsoft Project's planning by providing project plan execution and team collaboration capabilities.

There is also extensive support for templates in Windchill ProjectLink. You can take advantage of templates to maximize the reuse of information and enforce process and data consistency within and across organizations. Furthermore, templates quickly and consistently populate a project with plan, team, deliverable and process information that might require hours of definition work by a project manager. Templates are especially powerful for companies that repeatedly start and execute projects that are similarly structured and executed.

Management Options

Windchill ProjectLink can be employed in many different ways to manage a project.

It is usually best to use the most simple project management approach possible. If you manage the project at a high level and provide just enough elements to capture the essential progress, you can avoid the common mistake of adding too much detail and attempting to incorporate too much dependency information in the plan. It is often best to let the project team members manage the detailed activities and dependencies without including that information in the plan, because each additional level of detail can dramatically increase the maintenance associated with keeping the plan up-to-date. In a collaborative setting, the key value of the plan is to communicate progress and to capture dependencies with the actual work accomplished by the project team members. For example, plan items should generally not include multiple, detailed tasks for a single person resource unless there are dependencies with other team members on the individual steps or a formal deliverable output is associated with the step.

Following is an outline of the primary ways in which projects can be managed in Windchill ProjectLink in order of increasing complexity. Choose an approach that provides just enough information to the team without burdening the team leaders and contributors with non-essential information that requires constant monitoring and updating.
Managing a Project Plan by Schedule Milestones

In this basic approach, a project is used to define and track progress against key events, or milestones. Milestones typically represent a point in time started or completed by a key project event. If the schedule is the most important facet to manage and communicate in a project and if there are not dependencies that must be propagated from milestone to milestone, then the use of milestones alone may be sufficient to communicate project schedule goals and track progress against the scheduled goals.

Manage a Project Plan by Deliverables

If the tangible outputs are the most important aspect of the project, you can define deliverables to manage these outputs and focus the project around tracking progress against the deliverables. Each deliverable is created, assigned an owner, provided a due date, and associated with a part or document skeleton that must be completed as part of the deliverable output. A document deliverable might represent a report or specification that must be completed. A part deliverable might represent a node of an assembly that must be designed or for which a prototype must be built. The part or document associated with a deliverable may be supplied as a skeleton based on a template at the time the deliverable is created or attached later when it is partially or fully completed. Deliverables may be optionally associated with a milestone event or a plan activity. Also, a milestone can be constrained so that it is not complete until the associated deliverables are completed. When associated with an activity, the deliverables represent the output of the activity.

Manage a Project by a Work Breakdown Structure Plan

If you have a complex project with many resources and dependencies, you may need to define a work breakdown structure that defines a hierarchy of interrelated activities. Each activity in the hierarchy may have a parent, or summary activity, and a dependency relationship with preceding or following activities in the hierarchy. The hierarchy enforces precedence relationships so that a child activity cannot start until the summary activity starts and a summary activity cannot complete until all child activities have completed.

Note: This is enforced by the system only if you have chosen the automatic project execution mode. See Chapter 2, Beginning a Project for more detailed information about project execution modes, or see the Project Execution Options section later in this chapter to see how the execution mode affects the project plan.

Dependency relationships can also be defined among children of the same summary activity or across summary activities. Activities can be optionally associated with one or more deliverables. Windchill ProjectLink supports finish to start precedence constraints.
A work breakdown structure can be imported from and exported to Microsoft Project. The work breakdown plan can include references to child project, or *sub project*, plans that roll up status and other information from the sub project to the parent project.

**Planning a Project**

Windchill ProjectLink is focused to effectively support the execution of a project and includes all the necessary plan creation and editing capabilities; however, it can be more efficient to create an initial plan in Microsoft Project and to then import it into Windchill ProjectLink for execution. If you execute the same type of projects frequently, you can define a reusable project template that incorporates a pre-defined plan structure. You can then make the few modifications for each project instance directly in Windchill ProjectLink. See [About Project Templates](#) later in this chapter for more information.

**Defining the Project**

You can define a project either by selecting a project template during the creation of the project or by saving an existing project as a new project. Templates can pre-define team roles, members, folder structure, folder contents, links, document templates, document instances, milestones, deliverables, resources, and even a complete project plan hierarchy.

The following figures illustrate the steps in creating a new project.

![Create Project](image)

**Tip:** Out-of-the-box and site defined project templates are available to all members of your organization.
The **Estimated Start Date** is the date at which you plan to start the project rather than the actual start date.

The **Duration** is the planned duration of the project. If the project plan includes activities, it is best not to set this value manually but to let it be calculated by the system.

The **Deadline** is the date by which the project must be completed in order to meet any and all time constraints.

A project is automatically started and invitations are delivered to the team if the **Start project and send invitations to team** check box is selected. If you do not select this check box, you can create all the information and structure in the project before actually initiating it and inviting the team.

**Tip:** A team member can be assigned to one or more roles, and a single role may include one or more team members.

You can define a team using any of the roles that are pre-defined for your organization or you can define new roles that are specific to a particular project.

**Tip:** There is no explicit means within Windchill ProjectLink of associating responsibilities with roles; however, you can create a document in the project that identifies the responsibilities of each of the team roles or members.

The project creator is automatically assigned to the role of project manager and is the project owner by default. The project manager role can include more than one member. The project owner can be updated at a later point if the primary responsibility for the project deliverables changes. Only members of the project manager role can update the team roles and add, remove, or replace members. All members of the project can view the project team. For more information about team management, see Chapter 10, Managing a Team.
**Tip:** You can create placeholders for members that are needed but unknown at the time the context is created. For example, if you have a role called designers and you know that you need three designers but have identified only one at the time a project is created, you can define placeholders using fictitious e-mail addresses to represent the unknown designers. As soon as resources are identified for these members, you can replace the placeholder user with the actual user.
The invitation message is included in the e-mail invitation delivered to each member that is added to the project team. The message is sent to invited members both at the time when the project is first started and at any later point when the team is modified and members are added. You can update the project invitation while updating the project or from the **Team** page of the **Project** tab.

**Tip:** The **Project Number** may be entered to reference an organization project number used in a financial reporting system. You determine the project number for your purposes; it is not set by the system.

The **Business Unit** and **Site** can be entered by the project manager for reference and reporting.

The **Priority** is a numerical value that can be used for reporting and managing resource focus.

The **Budget** is a numerical value that is defined in the currency established on the server level and can be used to compare with the planned and actual costs in the project.

The **Category** list contains a set of categories that is unique to an organization and can be used to sort projects.
The **Scope** description can be brief and include a reference to a comprehensive scoping document in a project folder or a link to a scoping document in the corporate intranet.

The **Track project cost** check box should be selected only when the project estimated and actual effort (hours) and/or costs must be tracked. When this option is selected, the time (hours) associated with each resource can be entered for activities and milestones, and the percentage complete is calculated based on the planned and actual time values entered. For more information on tracking cost, see [Reporting and Monitoring Effort and Cost](#) later in this chapter.

The **Roll Up Status by** option allows you to choose whether the status variables are calculated from deliverable to associated milestone or from child activity to summary activity. The default option is to roll up the percentage complete and health status from child activities to summary activities rather than through deliverables. The option to roll up status through deliverables should only be used when only milestones and deliverables are managed in a plan.

The **Link deliverables with project activities** option allows you to calculate status from associated deliverables and activities. It is typically best to associate a single deliverable with a single activity. With this option, any status update that is made in the activity is reflected in the associated deliverable. Likewise, any status updates made in the deliverable are reflected in the associated activity. All date and status variables of the two objects, such as percentage complete, deadline, health status, risk status, and risk value, are linked.

The **Execution Control** options determine how the project activities are started and delivered to resources. These project execution options are detailed in [Chapter 2, Beginning a Project](#). For more information about how these options affect a project plan, see [Project Execution Options](#) later in this chapter.

The **Projects List** page displays the newly created project. You can view the details of the project or update it using the corresponding action available in the actions list. You can also sort on any of the columns in this table. When you sort on a column, the sorting is saved as a preference and the next time you visit the page, it will be displayed according to your last sorting.
When you select **Details** from the actions list or click **Details** on the navigation bar below the **Project** tab, the project information page displays an overview of all the top-level project information, including all status information, the percentage complete, costs, and overall estimated and actual values.

The information page also lists all of the sub projects associated with the project.

**Project Execution Options**

You can choose to manually or automatically execute a plan by choosing a project execution control option. You must choose this option when you create the project.

**Manual Plan Execution**

In manual project plan execution, the activities in the plan hierarchy must be explicitly started, updated, and completed by the owner or assignee. The owner of an activity that is dependent on the completion of a preceding activity must either manually visit the plan to view the progress of the preceding activity or subscribe to the completion of a preceding activity in order to know when to start the dependent activity for which the he or she is responsible. Manual plan execution is the default option when creating a project.

**Tip:** This approach is appropriate for plans that are undergoing constant change and where the precedence relationships are "soft" so that work can begin on activities even if preceding activities have not completed.

**Automatic Plan Execution**

In automatic project plan execution, the project manager still defines a work breakdown structure for the project plan, but the execution of the plan is automated by the system. The plan activities are automatically started when the date and precedence constraints are satisfied. Also resources are automatically delivered individual tasks with which they are required to complete forms to update status, report effort, and ultimately complete the task. When all the tasks associated with an activity are completed, the activity is automatically completed by the system. Any activities that were dependent on the completion of that activity are then automatically started, and the tasks for these activities are automatically created and delivered to the assigned resources for the activities. In this way the plan progression from start to finish is automatically orchestrated by the system. An automatically executing plan cannot be as easily changed or controlled as a manual plan, so this approach is generally best for plans based on a fixed template where no or few changes are expected in the course of execution.

**Tip:** This approach is best suited for repetitive projects where there is little or no variation in the plan but where it is essential that the plan is carefully executed to completion to meet tight deadline and cost constraints.
For example, a company that makes custom engineered components may create and ship hundreds of these components each month. If it is to ensure that all the steps from handling the initial order through final testing are all completed and expedited as quickly as possible with as little human management as necessary, the company can derive great benefit from automatic delivery and execution of the steps.

Defining Project Deliverables

Deliverables represent the tangible or measurable output of a project. They might represent design models, specification documents, prototypes, tooling modifications, and reports. In many cases, deliverables are the most important piece of project information to manage and track. Most project activities are ultimately created and executed to support the completion of the project deliverables.

The deliverable subject is the document or part (stored in a project folder) that represents the tangible project output. A deliverable can be optionally associated with an activity or a milestone that carries schedule information. The deliverable owner is the person responsible for seeing that the deliverable is completed by the deadline date.

You cannot directly relate deliverables to each other, and you cannot sequence them or define them as part of a hierarchy. They are discrete outputs that must be completed before the project can be considered complete. In some cases, the deliverables may be the only item of interest in a project.

Tip: If deliverables must be related or sequenced, you can define a plan as a hierarchy of activities and then associate the deliverables to activities.
Only team members assigned to the project manager role can create deliverables. This limitation enables project managers to control project outputs that must be formally tracked. The creator of the deliverable becomes the owner by default, but any project member can be assigned as a deliverable owner.

The creator of the deliverable can define notifications of key events for the deliverable when the deliverable is created. You cannot update deliverable notifications after a deliverable is defined.

**Tip:** If you need to modify the notifications associated with a deliverable, create a new deliverable with the necessary notification and associate the new deliverable with the subject of the old deliverable. Then delete the old deliverable.

In the example above, the project manager and owner will be notified 5 days before the deliverable is due and 2 days after it is due (if not completed by that time). The system will also deliver an e-mail notification to project managers if the deliverable health status is changed to red and another notification when the deliverable is completed.

**Tip:** Because participants can become overwhelmed with notifications and because it is not possible to easily modify the notifications after a deliverable is created, it is prudent to carefully identify the necessary notifications when you first create the deliverable.
A list of the project’s deliverables is displayed on the **Assignments** page of the **Project** tab. The deliverable state directly reflects the state of the subject document or part. In the following example, the state of the deliverable is **In Work** which is the state of the subject part, Panel Layout Design. When you update the state of a document or part that is the subject of a deliverable, the deliverable status is simultaneously updated.

### Defining Project Milestones

Milestones represent key events in time in the project. Milestones may indicate the date a prototype demonstration is to be given to a customer, a date at which a product is to be delivered to a customer, or the date at which a design is to be released to manufacturing.

A project may be managed entirely through milestones. Milestones alone often provide a sufficient level of detail for tracking and involve the least amount of effort to keep the plan current and accurate. You can pre-define milestones in a project template if the same milestones are used for many projects.
**Tip:** You can create a sequence of milestones by identifying the preceding milestone as a predecessor.

If you have a sequence of milestones, do not set an **Estimated Start** date for the milestones unless the work associated with a milestone cannot start until the specified date.

Set the **Duration** only if you want the milestone finish date to be automatically determined based on the finish date of a predecessor milestone or activity.

Set the **Deadline** when the milestone is associated with a fixed date. For example, if a prototype is being developed for a trade show, the prototype must be completed no later than when the trade show begins. The deadline date is also the trigger date used for overdue and approaching deadline notifications.

**Tip:** If you want a milestone to represent a fixed point in time, enter the desired end date as the milestone estimated start date and enter a zero for the duration. Do not enter any predecessor milestones or activities. In this case, the start date will be shaded with a gray background to indicate that it is fixed, and the start and finish date will be equal.

**Associating Deliverables with Milestones**

A milestone may also have associated deliverables that must be completed in order to reach the milestone. Many projects can be most effectively managed by defining the key milestones along with the associated key deliverables.
You can add one or more deliverables to a milestone by selecting **Add Deliverable** from the actions list next to a milestone or during the create or update of a deliverable.

When you select **Add Deliverable** from the milestone actions list, you can search for a deliverable to associate with the milestone.
When you create or update a deliverable, you can associate a milestone to the deliverable by specifying the sequence ID of the milestone in the plan or by clicking the **Select** button to choose from a list of existing milestones.

The milestone information page shows a list of the deliverables associated with a milestone.
When deliverables are associated with milestones, the **Deliverable** icon is displayed next to the milestone on the **Plan** page. You can click this icon to view the deliverable’s information page.

The finish date for the milestone will be pushed out to the latest finish date of any associated deliverable.

The percentage complete for the milestone will reflect the percentage complete of any associated deliverables. The milestone percentage complete is calculated using a simple average of the percentage complete values for the associated deliverables. See the example in the following table:

<table>
<thead>
<tr>
<th>Object</th>
<th>% Done</th>
<th>Health Status</th>
<th>Deliverable Weighting Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliverable A</td>
<td>50%</td>
<td>Yellow</td>
<td>.50/3 = .1667</td>
</tr>
<tr>
<td>Deliverable B</td>
<td>25%</td>
<td>Red</td>
<td>.25/3 = .0834</td>
</tr>
<tr>
<td>Deliverable C</td>
<td>75%</td>
<td>Green</td>
<td>.75/3 = .2500</td>
</tr>
<tr>
<td>Parent Milestone</td>
<td>50%</td>
<td>Red</td>
<td>(.1667 + .0834 + .2500)*100% = 50%</td>
</tr>
</tbody>
</table>
The milestone health status is always calculated using a "pessimistic" approach. If any associated deliverable is red, then the milestone is red. If no deliverable is red but one or more is yellow, then the health status of the associated milestone is yellow. If the health status of all its associated deliverables is green, then the milestone is green.

Tip: You cannot define a hierarchy of milestones the way you can with activities (through summary activities and sub projects), that is, you cannot define a milestone as a child of a parent milestone. Instead, use a summary activity and child activities for this purpose.

Creating the Project Plan

Manually Creating a Plan

When you create a plan, it is often best to start by creating the deliverables or work output of the plan. You can then create the plan hierarchy of activities necessary to manage the completion of the deliverables. Relate the deliverables to the activities and start the plan.

Do not add any more plan detail than is required to communicate progress and to manage dependencies among the various members of the project team. If a set of activities are all assigned to a single resource and if the steps are well-known, adding the detail to the plan and managing the creation and update of the activities can be more tedious than helpful.

It is typically more efficient to create all the activities at once (including summary activities) without initially defining the plan hierarchy. That is, create all the activities and summary activities at the same hierarchy level and define the hierarchy later.
Tip: Click Apply after you enter the information for each activity. After you click Apply, the activity is created, but the Create Activity window remains open so that you can create another activity. The activity name and owner information is saved in the window so that you can reuse all or part of the information from the previous activity definition.

After you create all the necessary activities, use the Indent button to define the hierarchy. You can select multiple activities to indent under a common summary activity.

Tip: When you indent one or more activities under a specific activity, that activity becomes a summary activity. If you indent items under a milestone, the milestone is irreversibly converted to a summary activity.

Creating a Plan From a Template

If you find that many of your projects have the same or nearly the same key plan elements, you can create a project from a template in which you have predefined all or most of the key plan activities and structure. The use of templates promotes consistency and efficiency, ensures that critical steps are not overlooked, and maximizes reuse.

See About Project Templates for more information about defining project templates and plans.

Creating a Plan From an Existing Project

If you need to create another project that is very similar to a project that you have already created or just completed, you can create a new project from an existing project. In order to do this, select Save as New Project from the actions list.

Tip: If you do not have the ability to create project templates or if you wish to define templates only for your own use, you can create a set of project skeletons that remain in the Defined state. They are projects created exclusively for the sake of creating new projects. Each time you want to create a new project based on one of your project skeletons, you use the Save as New Project action.
Importing a Plan From Microsoft Project

The most efficient way to create a new plan is to first define the plan in Microsoft Project and then import the plan into Windchill ProjectLink. See Exchanging Information with Microsoft Project later in this chapter for more information.

Defining a Project Work Breakdown Structure

A work breakdown structure defines the hierarchy of work activities that must be completed. It can include summary activities, activities, milestones, and sub projects. A work breakdown structure identifies the steps that must be completed in increasing refinement of detail, and it defines the order in which the steps must be started. The structure provides a means of breaking down complex projects into manageable components. In very large projects, one individual might define a top-level structure, and then many individuals might supply the detailed breakdown for the top-level summary activities. You can define a work breakdown structure of arbitrary depth and complexity. But as stated before, it is generally best to add only enough detail to manage the critical dependencies and to provide team with visibility of progress for the key events and activities.

You can expand and collapse sections of a large plan to focus on particular portions. Each summary activity contains its children. The summary activity totals the health status, percentage complete, effort, and cost of its children. A summary activity completes only after its children are each completed. You can define finish to start constraints among any set of activities in the plan by simply referencing activity node numbers (the activity node numbers are in the ID column on the Plan page).

A work breakdown structure can also be defined in a project template. This is useful when you need to regularly create projects with the same or very similar set of steps. Once you have created the plan, you can start the project and execute the plan among a distributed team where each team member that is a resource in the plan can report progress.

If you need to define more than ten or fifteen activities, it is usually most efficient to define the plan in Microsoft Project and to import the Microsoft Project plan into Windchill ProjectLink.

Tip: To collect totaled status information for the project plan, use summary activities to contain several "child" activities. It is also often useful to define a top-level summary activity under which the entire plan is defined. This summary activity serves as a summary for the plan as a whole and can be used as the main plan node for exchanging information with Microsoft Project.

Working With Dates

If the activities do not have an estimated start date specified, they will assume the start date of the project itself unless they are associated with a precedent activity. When the activities that are identified to precede a subject activity have finished, then the subject activity can start. This type of relationship between activities is
called a finish to start precedence relationship. Windchill ProjectLink supports finish to start precedence relationships.

**Tip:** You can update the plan estimated start date, and the changes will be propagated through all the activities in the plan based on the plan hierarchy and precedence relationships. The date changes will be fully propagated only if the activities and milestones do *not* have fixed start and finish date constraints.

You can also set the start date of activities in the work breakdown structure. However, if you want to benefit from the propagation of plan changes based on actual finish dates and the dependencies defined in the plan, you should not specify fixed date constraints. If you are working to some key milestones for which the dates are critical, then you may want to define the milestones independent of the work breakdown structure hierarchy and without precedence relationships. Used in this way, the milestones are some fixed markers used to compare with the executing plan. You can also define deadlines in activities. Deadlines are not automatically influenced by precedence relationships as are start and finish dates.

You cannot explicitly set finish dates in Windchill ProjectLink. Finish dates are calculated based on the estimated start date of the activity and the specified activity duration. If you want to set a fixed finish date, you must first specify a fixed start date and then enter a duration value. The finish date is then set by the combination of the fixed start date and the duration.

**Note:** If you specify fixed finish dates in a Microsoft Project plan and import the plan, the dates are ignored.

The finish date calculation is based on the working days identified for the user and the duration of the activity. The activity is not the elapsed duration but the number of working days required to complete the activity. For example, all resources in a project work Monday through Friday. If you specify an activity to require 15 working days and it starts on a Wednesday, the elapsed duration will be the total of the working days plus the non-working days. The activity planned finish date is equal to the current date plus working days plus non-working days.
The default calendar for each user is defined with Saturdays and Sundays as non-working days.

<table>
<thead>
<tr>
<th>Activity Start Date</th>
<th>Working Days</th>
<th>Non-working Days</th>
<th>Elapsed Days</th>
<th>Activity Calculated Finish Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wednedsay June 4</td>
<td>15</td>
<td>6 (3 2-day weekends)</td>
<td>21 (15 working + 6 non-working)</td>
<td>Tuesday, June 24 (June 4 + 21 elapsed days = June 24)</td>
</tr>
</tbody>
</table>

June 4 is counted as a working day so the added elapsed days should be decreased by one day

As with milestones and deliverables, the activity deadline date is a fixed date by which the activity is expected to finish. This is the date associated with overdue notifications delivered to the owner and resources associated with the activity.

Summary activities contain, summarize, and calculate status for a set of child activities. Summary activities may be included on a timeline and serve as a node that can be replanned by importing a plan from Microsoft Project.

When cost and effort are not tracked, the percentage of work complete status for a summary activity with several child activities is weighted based on the percentage of work complete and the duration of each of the child activities. Refer to the following table to review an example of how the percentage of work complete is calculated from the child activities to the summary activity.

<table>
<thead>
<tr>
<th>Object</th>
<th>% Done</th>
<th>Duration</th>
<th>Health Status</th>
<th>Activity Weighting Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child Activity 1</td>
<td>50%</td>
<td>5</td>
<td>Yellow</td>
<td>.50*5/(5+10+2)=.1471</td>
</tr>
<tr>
<td>Child Activity 2</td>
<td>25%</td>
<td>10</td>
<td>Red</td>
<td>.25*10/(5+10+2)=.1471</td>
</tr>
<tr>
<td>Child Activity 3</td>
<td>75%</td>
<td>2</td>
<td>Green</td>
<td>.75*2/(5+10+2)=.0882</td>
</tr>
<tr>
<td>Parent Summary Activity</td>
<td>38.2%</td>
<td>10</td>
<td>Red</td>
<td>(.1471+.1471+.0882)*100%=38.2%</td>
</tr>
</tbody>
</table>
When cost and effort are tracked, the percentage of work complete status for a summary activity with several child activities is simply the ratio of actual effort for all the activities to the total planned effort. Refer to the following table to review an example of how the percentage of work complete is calculated from the child activities to the summary activity.

<table>
<thead>
<tr>
<th>Object</th>
<th>% Done</th>
<th>Actual Effort Reported (hours)</th>
<th>Estimated Effort (hours)</th>
<th>Activity Weighting Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child Activity 1</td>
<td>50%</td>
<td>16</td>
<td>32</td>
<td>16/(32+50+20)=.1569</td>
</tr>
<tr>
<td>Child Activity 2</td>
<td>20%</td>
<td>20</td>
<td>50</td>
<td>20/(32+50+20)=.1961</td>
</tr>
<tr>
<td>Child Activity 3</td>
<td>90%</td>
<td>18</td>
<td>20</td>
<td>18/(32+50+20)=.1765</td>
</tr>
<tr>
<td>Parent Summary Activity</td>
<td>53%</td>
<td>54</td>
<td>102</td>
<td>(.1569+.1961+.1765)*100%=53%</td>
</tr>
</tbody>
</table>

Note: You must be an exchange administrator to access the system calendar. You can define the company holidays and other non-working days in the system calendar. Non-working days, such as weekends and holidays, defined in this calendar are used to calculate the finish dates for activities based on the start dates and the duration in working days. Each user inherits the system calendar. An individual user calendar can be defined that overrides the working or non-working days defined in the system calendar. However, no access is provided out-of-the-box for users to modify their own calendars. This means that user calendar modifications must be made by the exchange administrator on behalf of a user. Windchill ProjectLink does not support the concept of a project calendar that is distinct for each project instance.
As with a milestone, an activity may be associated with one or more deliverables that must be completed as part of the activity output. You can associate a deliverable with an activity by updating the deliverable and selecting an activity from the list of existing plan activities.

**Tip:** It is generally best to associate a single deliverable with a single activity to more accurately track progress of the individual deliverables through the activities.

If an activity is associated with a deliverable, a **Deliverable** icon appears next to the activity name on the Plan page. Click this icon to view the deliverable’s information page. If multiple deliverables are associated, a similar icon is displayed. Click this icon to view a list of the associated deliverables.

Unlike with milestones, the percentage of work complete for the activity will not reflect the percentage complete of any associated deliverables. The activity percentage complete is entered independent of the associated deliverables because it is defined by the ratio of actual to planned effort.
The activity estimated finish date is automatically defined to be equal to the estimated finish date of the latest finishing deliverable. You can override the activity duration to define a finish date that is earlier or later than the estimated finish of the latest finishing deliverable.

<table>
<thead>
<tr>
<th>Object</th>
<th>% Done</th>
<th>Duration</th>
<th>Finish Date</th>
<th>Status</th>
<th>Risk</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliverable A</td>
<td>50%</td>
<td>5</td>
<td>Feb. 28</td>
<td>Yellow</td>
<td>High</td>
</tr>
<tr>
<td>Deliverable B</td>
<td>25%</td>
<td>10</td>
<td>Mar. 8</td>
<td>Red</td>
<td>Low</td>
</tr>
<tr>
<td>Deliverable C</td>
<td>75%</td>
<td>2</td>
<td>Feb. 26</td>
<td>Green</td>
<td>Medium</td>
</tr>
<tr>
<td>Parent Activity</td>
<td>No contribution</td>
<td>10</td>
<td>Mar. 8</td>
<td>Red</td>
<td>No contribution</td>
</tr>
</tbody>
</table>

The activity health status is always calculated using a "pessimistic" approach. If any child deliverable is red, or any child activity is red, the parent activity health status turns red. If no child is red but one or more is yellow, then the health status of the parent activity is yellow. If the health status of all children is green, then the parent activity is green. There is no propagation of deliverable risk values to an associated parent activity.

The default behavior of the system during the creation of a project is to link deliverables with activities. This behavior is appropriate for most cases and eliminates the need to update both the activity status information and associated deliverable status information. When a deliverable and an activity are associated, any date and status changes that you make to the activity are reflected in the associated deliverable, and any date and status changes you make to the deliverable are reflected in the associated activity. You must select this option when you create the project, and it cannot be changed following project creation.

Tip: If you accept the default option to link deliverables with activities, you can only associate a single deliverable with an activity. However, you can define a hierarchy of deliverables by associating each deliverable with a node in an activity hierarchy.

Defining Project Resources and Assigning Resources to Activities

Windchill ProjectLink supports the creation of person, equipment, facility, and material resources in a project. These resources may be assigned a cost per use, a unit cost (as in the case of a material), and a cost per unit time (such as for a person or equipment resource). The cost per use typically is used to represent the set up cost associated with engaging the resource. For example, the use of a particular piece of equipment or tooling may have a set up cost in addition to the cost per unit time while the equipment is in operation. The cost per use is incurred for each resource associated with an activity when the activity is created.
If you create three activities that each use a resource with a cost per use of $100, the project immediately accrues $300 in costs per use for the three uses of the resource.

The resource maximum utilization value is the percentage of the available resource that can be allocated to the project. Windchill ProjectLink does not currently enforce the maximum utilization value or provide a warning when resource use in a project exceeds the maximum available value. A report of the total utilization of a resource and the utilization across the projects in which a resource is used could be created but is not available out-of-the-box.

Costs for resources are defined and calculated within each project. The same person resource may be assigned different rates in each project in which the resource is engaged.

To create a resource, click **Create Resource** on the **Resources** page. You can specify the rate per hour, the cost each time the resource is independently engaged, and the utilization rate. The utilization rate is used when calculating contributions by multiple resources in a project.

By default, Windchill ProjectLink creates a resource for each project team member. When you create a material resource, the standard rate is interpreted as the unit cost for the resource. For example, if you have a material resource with a standard rate of $15 per unit, enter the $15 as the standard rate per hour where the per hour rate is interpreted as the per unit rate.
When you enter values for the estimated and actual effort for the resource in an activity, the value you enter for hours is actually the number of units of the material consumed.

![Create Resource](image)

Each time you associate a resource with an activity, the resource becomes an active resource that is used by the project. You can view the active or used resources in a project by selecting **Active Resources** from the **Current View** drop-down list on the **Resources** page.

You can also view the estimated and actual costs associated with the resources as they are engaged in activities in the project. Select **Resource cost information** to view the estimated and actual costs per resources and the total resource costs for an entire project.

**Linking and Working with Sub Projects**

Sub projects (also called child projects) are useful in order to break down a large project into separate smaller projects that may be managed and executed by separate teams.

Windchill ProjectLink supports the use of sub projects in a limited capacity. It is essential to understand the relationship of plan information in a sub project to associated parent projects to determine how you can take best advantage of the benefits of a sub project.

From a project space or context view, all projects are peers. That is, there is no sharing or inheritance of project teams, folders, documents, parts, action items, meetings, resources, or access control rules from a parent project to any related sub projects. The only relationship between a project and a sub project is through the project plan.
A node in the parent project plan may identify a sub project relationship with the top-level plan node in another project. A sub project relationship is made as a node in the parent plan linked to the top level plan in a child project. Plan health status, percentage complete, effort, and cost are calculated from the child plan to the node in the parent plan where the child plan is linked. Precedence relationships cannot be established such that changes in the parent plan propagate down to the child. That is, a propagated change in the start date of the parent plan cannot influence the start date of the child plan. Propagation only occurs from child to the parent. For example, if the sub project estimated finish date is delayed and the parent plan includes a precedence constraint on the sub project linked, then those activities in the parent plan that follow the completion of the child project plan cannot start until the child plan is completed.

**Tip:** The sub project must exist before it can be linked. But you can define a summary activity in the parent project to act as a placeholder until you define the project that will be linked as a sub project.

The child project or plan cannot be automatically started when the sub project reference in the parent plan meets its start criteria. If the parent plan must influence the start of the sub project plan, include an activity in the parent plan just before the sub project to start the sub project plan.

**Tip:** It is not possible to define dependency relationships from activities in the parent plan to activities within the sub project.

**Tip:** If you need to create dependency relationships between parent plan elements and child plan elements, it is best to define and manage the entire plan in the parent. In this case, while no plan is created in the sub project, it can still be used as a focused collaboration space with a unique team, folders, action items, and possibly deliverables. A project manager in the sub project can also be specified as project manager in the parent project and can be given responsibility for defining, executing, and updating a portion of the plan in the parent project (representing what might have been defined in the child). You can manage a large plan by assigning responsibility for each node in the master project plan to the project manager of a sub project. The project manager can define a hyperlink in the sub project to the plan node in the parent project and then update the key plan items under that node.

**Executing a Project**

After you complete the creation and definition of a project and its plan, you are ready to execute the project. This section explains how to start a project and how project members participate in an executing project. The system behavior during execution and update of a project depends on two factors in the definition of the project:

- Whether you are reporting effort or cost
- Whether you are manually or automatically executing the project

**Tip:** Select the option to track cost if you need to keep track of hours of effort for project resources and the cost associated with the resource efforts. This option changes how you report progress in activities and tasks.

If you chose one of the options to automatically execute a plan, activities are automatically started when their start conditions are met. If you chose the option to automatically execute activities and deliver tasks, tasks are automatically created and delivered to the project participants to report progress.

**Reporting Effort and Cost**

If you need to report effort or cost in a project, select the option to track cost during Step 4 of the **Create Project** window. When the track cost option is enabled, the Create and Update Activity windows include fields in which to enter effort values for the resources associated with the activity. The actual cost for activities is calculated by the product of the actual effort (hours) for the activity and the rate per hour for the resource assigned to the activity as well as the one-time cost per use for each resource used in the activity. When a project is in cost tracking mode, only estimated and actual effort is entered. The cost and percentage complete values are calculated based on the effort (that is, these values
cannot be directly entered). For more information, see Reporting and Monitoring Effort and Cost.

If you are not reporting effort, then you can directly update the percentage complete for the activity (the field for entering resource effort (hours) is not available).

**Automatic versus Manual Execution of a Project**

If you selected **Automatically execute activities and deliver tasks** during Step 4 of the Create Project window, tasks are automatically generated and delivered to each of the resources assigned to an activity. Each resource updates the effort or percentage complete in the delivered task. The task values roll up to the activity and the activity to the summary activities and finally to the project as a whole.

If you are automatically executing a project and tracking cost, then the estimated and actual effort is defined in each of the tasks and the cost for the activity is calculated from the resource rates.

**Automatically Executing a Project Plan**

This section explains how you can use Windchill ProjectLink to automatically execute a project plan. Windchill ProjectLink supports several options to manage the execution of a project plan within Windchill ProjectLink. This functionality is unique to Windchill ProjectLink and complementary to Microsoft Project. Microsoft Project is a great tool for planning a project, but it is not as suited to managing or facilitating project execution among a distributed project team.

Windchill ProjectLink, in contrast, is designed to take a plan defined in Microsoft Project or from a Windchill ProjectLink project template and automatically deliver project work when it is ready to start for each of the assigned resources in the plan activities. This automated delivery and project activity management helps reduces the burden on project managers so that they can focus on managing project risks, deliverables, and resources.

An integrated workflow engine drives Windchill ProjectLink plan execution. This engine starts the activities as soon as they can be started (based on activity precedence and date constraints) and delivers the work associated with the activities to the assignees. E-mail notifications are automatically delivered to activity resources as soon as the activity starts. Activity assignees can enter actual effort as the activity work progresses and update estimated effort based on the latest information. Estimated and actual effort is immediately rolled up from the tasks to the parent activities and finally to the project plan.

Both the plan as a whole and the individual activities in a plan can be suspended so that no tasks can be completed and delivery of subsequent tasks is prevented until planning or resource issues are resolved. Once all problems have been resolved, the plan and activities can be resumed.
Plan Execution Options

When a project is defined, the project creator can choose the project execution mode most appropriate for the project.

The following project plan execution options are available.

- Manually control project execution
- Automatically execute activities
- Automatically execute activities and deliver tasks

These options represent an increasing level of plan execution automation. Any one of the options can be chosen when creating a project during Step 4, of the Create Project window.

The automated options (the latter two options) are most appropriate for project plans that are based on project templates or imported plans where few if any changes in the plan structure are expected. This execution mode is especially useful for projects that are executed in rapid succession where all the same steps must always be executed in the same order with the same dependencies. In these types of projects, typically only the resources, start dates, and durations change.

For example, a company that manufactures custom hydraulic cylinders in several varieties may have a project template that contains a complete project plan for each cylinder variety. Each time a customer requests a new custom cylinder, a new collaboration project based on this template can be created to facilitate the completion of the order and the exchange of information among the manufacturer, supplier, and customer. A manufacturer might create hundreds of such projects a month. Because Windchill ProjectLink can automate the delivery of the tasks to the participants, the manufacturer does not need an army of project managers to ensure that the projects are being properly and efficiently executed.

It is possible to preset the plan execution option in the project template so that the complexity of these options is hidden from the user. Once an option is selected and the project is created, the option cannot be modified.

Affects of the Project Execution Control on the Plan Behavior

The following sections details the plan behavior under each of the execution options.

Manually Control Project Execution (Default)

This option enables a project manager and a project team to work with a project plan in a static mode similar to how the team might work with a distributed version of Microsoft Project. Project managers can create new activities at any time and at any location in the plan. Activity owners and project managers can also update any activity attributes (name, description, duration, start date, finish date, status, percentage complete, and so on) at any time.
Single or multiple resources for activities can be associated with an activity but the resources cannot individually report effort or status. The activity owner on behalf of all the resources must report status and effort. If tracking effort and cost is important, it is best to associate only a single resource with the activity and to assign this resource as the activity owner as well (this is the default behavior).

Windchill ProjectLink rolls up the plan values for status, percentage complete, effort, and cost from the activity level up. Precedence relationships can be defined and are enforced to determine start and finish dates based on supplied durations. Only activity owners and project managers can update an activity. Activity owners and project managers can override or cancel the override of any activity attributes. Under this option, no activity control states are exposed (start, suspend, cancel). No activity tasks are generated under this option.

Automatically Execute Activities
If this option is enabled, activities automatically start when precedence or date constraints are met but no work items (assigned resource tasks) are generated for the activities. Only the owner of the activity or the project manager update activities under this option. However, the activity owner cannot update status, percentage complete, actual effort, and actual cost until the activity is started.

This option is useful when it is critical that activities are not prematurely started or updated but where automated task generation and delivery to multiple resources is not critical.

Automatically execute activities and deliver tasks
This is the most sophisticated option in which the plan execution is entirely automated by the Windchill ProjectLink workflow engine. This option is best for plans that change little following the plan start, where rapid sequencing of the project activities is essential, and where effort must be individually captured for multiple resources assigned to the project activities.

Under this option, activities are automatically started when the project plan is started and all the activity start conditions have been met. Work items (tasks) are automatically generated and e-mailed to each of the assigned resources. Activity status information (health status, risk, actual effort, planned effort) can only be modified when the activity is running. When the activity is in the defined state, the activity duration, start date, precedence relationships, name, and resources can be modified.

The following examples illustrate how a project participant and work assignee interacts with activities and work items when the option is set to automatically execute activities and deliver tasks.
The plan in the preceding example is not started. To start the plan, click **Start** to begin execution of the plan. Click **Complete** to complete the plan.

All plan activities with no dependents or date constraints immediately start when the plan is started. A started activity is evident by the 0% value in the **Done** column. This icon indicates work items assigned to the logged in user for the activity. The assignee can update and/or complete this task. Assignees can also update estimated effort which is rolled up to total estimated effort for the parent activities and the project plan. In addition, the assignee can update the actual accrued hours for the task. This field is displayed only if the project is set to track costs. Finally, assignees can modify the status and risk and either update the task to communicate progress or complete the task if all assigned work is done.

The next activity begins because the activity finish-to-start constraint is satisfied, and task is automatically generated and delivered to assignee.

Project managers and participants can view all open tasks for a project team to assess open work and progress.

### Project and Plan States

The project space as a whole and the plan within a project have separate states. A project space can be in a Running state while the project plan is in a Defined state. For example, a number of project managers may be collaborating in a Running project to refine the plan before obtaining approval to start and execute the plan.

The following table defines the relationship between the project and the plan states and identifies what transitions are allowed for the various project states.

<table>
<thead>
<tr>
<th>Project State</th>
<th>Allowed Plan States</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defined</td>
<td>Defined</td>
<td>Initial states when project is created.</td>
</tr>
<tr>
<td>Running</td>
<td>Defined, Running, Suspended, Completed</td>
<td>The plan can be changed manually by the project manager.</td>
</tr>
</tbody>
</table>
The following table indicates the permissions that are available based on the plan state:

<table>
<thead>
<tr>
<th>Plan State</th>
<th>Allowed Plan Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defined</td>
<td>Full for project managers.</td>
</tr>
<tr>
<td>Running</td>
<td>Full for project managers, read-only for members, update for item owners</td>
</tr>
<tr>
<td>Suspended</td>
<td>Full for project members, read-only for members</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Read and resume for project managers, read-only for members</td>
</tr>
<tr>
<td>Completed</td>
<td>Read and restart for project managers, read-only for members</td>
</tr>
</tbody>
</table>

**Starting the Project**

When you create a project, you have the option to deliver invitations to the project participants at the same time that you create it or you can wait to start the project until you have fully populated the project with the information that you want available to the participants when they join the project. The default system behavior is to deliver invitations to the project members as soon as the project is started.

If you do not choose to select this option, the project is not immediately started when it is created. No invitations are sent to the participants.
When you are ready to start the project, select Start from the project actions list next to the project name to begin the project and to deliver invitations to all the participants.

Updating Activities

Project managers and activity owners can view the activities both within a particular project and across projects. For example, a project manager can view all the uncompleted activities in a project while activity owners can view only the uncompleted activities in a project for which they are responsible.

Users can also view all the activities in which they are resources across all projects in which they are team members by selecting My Open Work from the Current View drop-down list on the Reports page of the Home tab. Deliverables and milestones owned by the user, activities in which the user is an owner or a resource, and action items for which the user is responsible are all included in this list. These items plus tasks that are delivered in the automated project execution mode can be viewed on the Assignments page. You can sort all the lists by any column in ascending or descending order. The last sorting used is saved so that you will see the same view the next time you visit the page.

You can update the activity status information or ownership. When the project is defined to not track project cost, you can directly update the percentage complete to indicate the progress achieved for the activity.

Updating Tasks

In Windchill ProjectLink, a plan is built by assembling activities, milestones, and deliverables. Tasks are not created in the plan. The term task is used in Windchill ProjectLink to refer to automatically generated work assignments for each resource assigned to complete an activity. What is termed a task in Microsoft Project is the equivalent of an activity in Windchill ProjectLink. Tasks are automatically created and delivered to resources assigned to an activity only when
the project is executed under the automatic project execution mode. Tasks are not present in all other project execution modes. See Automatically Executing a Project Plan earlier in this chapter for more information.

Managing and Monitoring Health and Schedule

Health status is a rough indicator of how well individual activities and the project as a whole are progressing according to the planned schedule, cost, deliverables, and functional measures. Windchill ProjectLink has a simple "pessimistic" approach for calculating health status from child to parent activities. Under this approach, the poorest health status of a child activity is reflected in the summary activity. Other factors are not considered when automatically computing health status.

The following table illustrates the behavior of the health status propagation:

<table>
<thead>
<tr>
<th>Activity</th>
<th>Case 1</th>
<th>Case 2</th>
<th>Case 3</th>
<th>Case 4</th>
<th>Case 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child Activity A</td>
<td>Green</td>
<td>Green</td>
<td>Green</td>
<td>Green</td>
<td>Green</td>
</tr>
<tr>
<td>Child Activity B</td>
<td>Green</td>
<td>Green</td>
<td>Green</td>
<td>Green</td>
<td>Green</td>
</tr>
<tr>
<td>Child Activity C</td>
<td>Green</td>
<td>Yellow</td>
<td>Green</td>
<td>Red</td>
<td>Green</td>
</tr>
<tr>
<td>Child Activity D</td>
<td>Unavailable</td>
<td>Unavailable</td>
<td>Yellow</td>
<td>Unavailable</td>
<td>Red</td>
</tr>
<tr>
<td>Parent Activity</td>
<td>Green</td>
<td>Yellow</td>
<td>Yellow</td>
<td>Red</td>
<td>Red</td>
</tr>
</tbody>
</table>

Tip: The best practice is typically, to *override*, or to manually enter a value for the health status of the project as a whole; otherwise if any child activity has a health status of red, the health status for the project as a whole is red. When a health status value is manually overridden for a plan node, a gray background is displayed behind the health status indicators. When the health status is manually overridden at the level of the project as a whole, the text "(Overridden)" appears next to the health status indicator in project status bar.

You can restore the automatic calculation of values in any activity, deliverable, or the project as a whole by selecting the available *Calculate* check box.

Managing a Project Plan 9-35
Reporting and Monitoring Effort and Cost

You cannot individually track the effort and cost associated with multiple resources unless you use the automatic plan execution mode with task delivery. For more information, see Automatically Executing a Project Plan earlier in this chapter. If you are not using the automatic execution mode and you have multiple resources assigned to the activity, the owner of the activity must enter the collective hours for the resources. The cost is calculated by apportioning the hours to the resources based on the utilization defined for each resource. See Managing Resources and Resource Costs later in this chapter for more information.

Tip: When tracking effort and cost in manual execution modes, the best practice is to associate a single resource with an activity and make the activity owner and resource the same individual.

An activity in a project where tracking cost is enabled is considered complete when the actual cost is equal to the estimated cost. If the actual cost is equal to the current value for the estimated cost but the activity is not yet complete, update the estimated cost so that it represents a new estimate for the effort to complete the activity. The system will not allow you to enter an actual cost that is greater than the estimated cost. When activity actual effort is equal to the estimated effort and the activity is completed, its health status is set to “unavailable” and a check mark icon is displayed in the percentage complete column to indicate that the activity was completed. The duration displayed for the activity becomes the actual duration and is the sum of the working days between the actual start and the actual finish date.

Windchill ProjectLink does not keep track of individual updates to an activity for comparison. You can manually track the changes to an activity by providing a change log in the status description field for the activity. For example, you might enter the following as part of the running change history text in the status description for an activity:

June 15 2002 - Increased planned effort from 32 hours to 56 hours

Tip: Alternatively, you can export the plan to Microsoft Project and then upload the Microsoft Project plan file to the project as a dated baseline and use this baseline for comparison.

Managing Resources and Resource Costs

You can track the contributions by resources in the project on the Resources page. Resource effort and accruals are calculated for each resource in the project. The accrued costs for each resource are then totaled to reach the total resource cost for the project. The same person may have a separate rate and utilization value in each project in which the user is a member.

Tip: The cost for the equipment resource is the sum of the cost per use and the product of the actual hours and hourly rate. Actual cost = Cost per use + Effort*Actual hours.
If more than one resource is associated with an activity, the effort delivered by each resource is distributed as illustrated in the following table:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Utilization</th>
<th>Effort Contribution Factor</th>
<th>Contributed Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource A</td>
<td>50%</td>
<td>50/(50+25+75)=.333</td>
<td>100*.333=33.3</td>
</tr>
<tr>
<td>Resource B</td>
<td>25%</td>
<td>25/(50+25+75)=.167</td>
<td>100*.167=16.7</td>
</tr>
<tr>
<td>Resource C</td>
<td>75%</td>
<td>75/(50+25+75)=.5</td>
<td>100*.5=50</td>
</tr>
<tr>
<td>Activity</td>
<td>-</td>
<td>-</td>
<td>100</td>
</tr>
</tbody>
</table>

If you need to precisely identify the costs associated with the effort for each resource, define a separate activity for each resource.

The cost per use for a resource is incurred when an activity is defined and a resource with a specified cost per use amount is associated with the activity. If the same resource is used in several activities, the cost per use charge is incurred once for each activity in which the resource is used.

**Managing Risk**

You can associate a risk value and risk description with each activity and deliverable. The risk value is not calculated from child to parent. The best practice is often to capture critical risks as project issues or action items and to define strategies for risk mitigation as part of the action item resolution.
You can access a report of risks within a project as illustrated in the following example:

You can associate risk mitigation plans by uploading a strategy in the Reference table of the activity, deliverable, or milestone information page.
You can also create a Risk Mitigation Plans folder on the Folders page and then create a link in the Reference table to the specific risk mitigation plan.

Creating Baselines

A baseline is a snapshot of an executing project plan at a specific point in time. Windchill ProjectLink does not explicitly support baselines, but you can export a snapshot of an executing project to a Microsoft Project file and then upload the baseline file to a Baselines folder in the same project in Windchill ProjectLink to perform the role of a baseline. You can also save the HTML source associated with a Windchill ProjectLink plan page and then save the HTML file in a folder for dated baseline files. The HTML baseline can then be compared (manually) with the current project values.

Tip: Use the date of the baseline in the name of the baseline document that you upload to Windchill ProjectLink.
Subscribing to Changes

You can subscribe to project events and the system will e-mail notifications to you when the subscribed events occur. Subscriptions are invaluable for keeping appraised of critical completions or delays without constantly visiting a project space.

Notifications are sent for the following subscription event options for deliverables:

- Status change - if the health status for the deliverable changes
- Estimated Finish date change - if the deliverable estimated finish date changes
- Missed deadline - if the deliverable deadline or due date has passed
- Approaching deadline - if the deliverable deadline is within a specified number of days or after the current date. This pro-active notification value can be set in a project template.
- Object deletion - if the deliverable is deleted
- Percent complete change - if the percentage complete value for the deliverable is updated
- State change - if the life cycle state of the document or part associated with the deliverable is changed
- Deadline date change - if the deliverable deadline or due date value is updated
• Past deadline - if the deliverable deadline or due date is a specified number of days prior to the current date. This follow-up notification value can be set in a project template.

• Owner change - if the deliverable is assigned to a new owner

Accessing and Interpreting the Standard Reports

A number of standard reports are available for individual users to manage assignments for which they are responsible as well as for project managers to gauge assignments specific to a project. These reports are located on the Reports pages of the Home and Project tabs. Extended report packages are available from PTC, and custom reports can be created by the PTC Services organization.

Exchanging Information with Microsoft Project

You can use Microsoft Project 2000 together with Windchill ProjectLink to take advantage of the project planning capabilities of Microsoft Project and the plan execution capabilities of Windchill ProjectLink. The easiest way to create a plan from scratch is to first define it in Microsoft Project. You can then import the plan you created in Microsoft Project into Windchill ProjectLink and execute the plan in Windchill ProjectLink. You can use the two products together in several different ways.

Use Windchill ProjectLink Only as a Microsoft Project Plan Repository

Define and maintain the plan and the completion of the plan tasks entirely in Microsoft Project. Share the plan with the project team by uploading the plan to the Windchill ProjectLink project and manage changes to the plan through the check-out and check-in document management capabilities in Windchill ProjectLink. This approach requires that all team members have a Microsoft Project 2000 client so that they can view and optionally edit the Microsoft Project plan that is uploaded to the Windchill ProjectLink project. This approach is appropriate when only project managers need access to the plan, and when you have multiple project managers who need concurrent access to plan updates.

Use Windchill ProjectLink to Provide Access to a Microsoft Project Plan

Define and maintain the plan in Microsoft Project but manage access to the plan in Windchill ProjectLink through check-in and checkout operations in Windchill ProjectLink. Each time the plan is changed, the Microsoft Project plan is checked out by a project manager, modified, and an HTML format of the plan is saved and published to the project. This HTML format is accessible by all project members without requiring that the viewer install or have a license to Microsoft Project. This approach is appropriate when a single or multiple project managers control all updates to the original and executing plan but need to provide team access to snapshots of plan information. Users can subscribe to changes to the HTML published version of the plan so they are notified each time the plan is updated.
Import the Microsoft Project Pan and Execute the Plan in Windchill ProjectLink

Create the initial plan in Microsoft Project, import the plan to Windchill ProjectLink, and manage the execution of the plan henceforward entirely in Windchill ProjectLink. Once the plan is imported and is executing in Windchill ProjectLink, activity and deliverable owners can update the items for which they are responsible and provide immediate visibility to the rest of the team. This approach also reduces the burden on a project manager to keep the plan up-to-date because the responsibility is distributed among the activity owners. Because you can import a Microsoft Project plan at an individual plan node, Microsoft Project can be used to "replan" an unstarted portion of the plan by importing and overwriting the activities under a summary node in the executing plan that is not yet started. This option is the best marriage of the planning capabilities of Microsoft Project and the execution capabilities of Windchill ProjectLink.

Export Snapshots of an Executing Plan to Microsoft Project for Reporting and Printing

You can export a snapshot of an executing plan in Windchill ProjectLink to Microsoft Project to produce a nicely formatted printout or document that is used in a status meeting with management. For example, you can generate a GANTT chart view of a plan snapshot by exporting the plan to Microsoft Project. You can then generate and print the GANNT view or upload the GANNT HTML source to the project for quick access to a snapshot. You can also export a snapshot of a plan to generate a baseline at a specific point in time. The exported Microsoft Project plan file representing the snapshot can be uploaded to a project folder and as a saved baseline for the project.

Use Windchill ProjectLink as a Read-Only Web Accessible Plan

If as a project manager you intend to update all plan activities for all participants, you can create an initial plan in Microsoft Project, import the plan to Windchill ProjectLink to provide visibility of the plan and progress against the plan to the entire project team, and then edit and replace the plan at regular intervals to update progress and status. This approach is useful when a project manager prefers to control all status reporting but is generally an inefficient approach. It burdens the project manager with the task of regularly collecting status from all project resources and then updating the plan. It is not possible to lock a plan to prevent editing of the plan activities by their owners, so it is important to make it clear to all participants that they are not to update their owned activities directly. You can include a statement to this effect as a top node in the project or in the project description.
Relationships Between Microsoft Project and Windchill ProjectLink Objects

The following illustration shows the primary objects and relationships in the Windchill ProjectLink project data model.

The following illustration shows the primary objects and relationships in the Microsoft Project 2000 project data model.
The major differences between Windchill ProjectLink and Microsoft Project 2000 objects are as follows:

- Windchill ProjectLink activities equal Microsoft Project tasks - Windchill ProjectLink uses the industry standard term activity for what Microsoft Project labels a task.

- Windchill ProjectLink tasks equal Microsoft Project assignments - Windchill ProjectLink uses the term task for a work item that is automatically created and delivered to each resource assigned to complete an activity. Tasks are also used by the resource as a reporting mechanism for status and effort. The creation of tasks is not enabled by default. Microsoft Project uses the term assignment for this feature. When using Microsoft Project and Microsoft Exchange together, assignment notifications can be delivered to users.

- Windchill ProjectLink milestones cannot have children - In Windchill ProjectLink, milestones cannot be defined to include child activities or child milestones. In Windchill ProjectLink, a milestone is intended to identify only a point in time at which a significant event has or will occur or a significant project deliverable is or should be complete. In the most proper sense, milestones should have no duration because they mark a point in time not an elapsed period such as is associated with an activity. Microsoft Project milestones with children are converted to summary activities when imported into Windchill ProjectLink. Microsoft Project milestones with non-zero duration are also converted to activities when imported into Windchill ProjectLink.

- Windchill ProjectLink supports deliverables - Windchill ProjectLink supports deliverable objects that can be associated with Windchill ProjectLink activities and/or milestones and target document or parts that represent the deliverable asset. Microsoft Project 2000 does not support deliverable objects.

- Windchill ProjectLink does not support project-specific calendars - Windchill ProjectLink uses a single system calendar for all schedule and cost calculations across all projects and all resources. Microsoft Project can have separate calendars associated with the project as a whole and with each resource in the project.

- Windchill ProjectLink treats duration and work effort independently when tracking cost - Windchill ProjectLink separates the concept of activity duration (calendar working days) and activity effort (hours of resource effort) when using the tracking cost mode. Microsoft Project integrates the concepts of duration and work effort in its Fixed Units and Fixed Duration modes. See Managing Duration and Effort for more information.

- Windchill ProjectLink does not support overtime rates for resources. Windchill ProjectLink does not expose overtime rates for resources. Microsoft Project supports both a standard and an overtime rate for each resource. Each resource also has a standard work week in Microsoft Project. Any effort reported beyond the standard work week is considered overtime.
• Windchill ProjectLink does not support front-loaded or back-loaded effort or cost - Windchill ProjectLink supports prorated effort and cost based on actual effort which is calculated and rolled up immediately. Microsoft Project allows roll-up of effort and cost either at the start or completion of the task. Roll-up of effort and cost can be optionally deferred until an activity is completed so that hours and costs are calculated only for completed activities. Microsoft Project also allows the roll-up of planned effort and cost at the time an activity starts so that the effort and cost (based on estimated values) is immediately reflected as the actual value when an activity starts.

• Windchill ProjectLink supports only finish-to-start and start-no-earlier-than constraints - Windchill ProjectLink supports only finish-to-start precedence relationships between activities and start-no-earlier-than date constraints. Microsoft Project supports finish-to-start, start-to-start, start-to-finish, and finish-to-finish precedence relationships as well as lag and lead values. Typically the finish-to-start and start-no-earlier-than are the only constraints that are useful during project execution. The other constraints are useful only in a planning mode.

• Windchill ProjectLink activity duration can only be expressed in days - Windchill ProjectLink activity duration can be expressed only in days and work effort can be expressed only in hours. Microsoft Project task duration can be expressed in minutes, hours, days, weeks, or months. The finish dates for tasks in Microsoft Project are calculated based on the duration units, the working days and the working hours per day for a resource and the resource utilization.

• Windchill ProjectLink only supports fixed duration activities - All Windchill ProjectLink activities are defined as fixed duration. Microsoft Project task types can be set to fixed duration, fixed units, or fixed work.

Managing Duration and Effort

Windchill ProjectLink manages duration and effort independently when the project is set to track cost.

In Microsoft Project, you define the amount of time planned for an activity (in days, hours, weeks, months) and Microsoft Project calculates the finish date of the activity based on the working days, times, and utilization of the resource. In Windchill ProjectLink, duration represents the number of working calendar days estimated for the activity.

If you are tracking cost, then effort for the activity is entered in hours and is independent of the working days over which the effort will be expended. For example, you could plan for a resource to complete an activity over the course of 10 days in Windchill ProjectLink with the expectation that the resource will work a few hours the first couple days, then work a couple of full days and follow up with some half and quarter days. You might estimate the effort at 35 hours over the course of the 10 days and request that the resource update actual effort at the end of each week for two weeks.
When a Windchill ProjectLink project is set to not track cost, the behavior is similar to fixed unit tasks in Microsoft Project. In Microsoft Project, if you create a fixed unit task (the default type), the work remains constant at 8 hours per resource per day (given the default of 8 hours per working day). So, when the duration is changed, the work changes to preserve the following equation:

\[ \text{work} = \text{resource units} \times \text{duration} \]

The percent work complete is computed as follows:

\[ \% \text{ work complete} = \frac{\text{actual work}}{\text{work}} \]

When the duration changes, the work is updated but the actual work remains unchanged (unless it exceeds the new work value). This means that the percentage of work complete must change.

For example, if a fixed units task lasts for 5 days and has one resource associated with it, then the work will be 40 hours. If it is 50% complete then the actual work will be 20 hours. If the duration changes to 3 days, then the work changes to 24 hours. Since the actual work remains 20 hours, the percent complete changes to \( \frac{20}{24} = 83\% \).

When Windchill ProjectLink is tracking costs its activities behave similar to fixed work tasks in Microsoft Project. If you create a fixed work task in Microsoft Project, the work remains fixed at the original setting. Changing the duration does not cause the work to change. So, when the work changes, the percentage of work complete does not change.

**Note:** In Microsoft Project, the percentage complete will change in this case. Windchill ProjectLink does not track percentage complete. It only tracks percentage of work complete.

For example, if a fixed work task lasts for 5 days, has one resource associated with it, has work set to 40 hours and actual work set to 20 hours then the percent work complete will be 50\% (as expected). If the duration is changed to 3 days, the work, actual work and percentage of work complete all remain constant.

**Tip:** When working with Microsoft Project, if you are tracking cost, then set the Microsoft Project task type to fixed work. If you are not tracking cost, set the Microsoft Project task type to fixed units. Set the duration units to days.
The following table is a brief outline of the key information mappings between Microsoft Project and Windchill ProjectLink. A more extensive listing is provided in Appendix B: Microsoft Project Mappings.

<table>
<thead>
<tr>
<th>Microsoft Project Object</th>
<th>Attribute</th>
<th>Windchill ProjectLink Object</th>
<th>Attribute</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Activity</td>
<td></td>
<td>Name</td>
<td>Export from Windchill ProjectLink sets project title to the value of the project name or summary activity name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ID</td>
<td>Sequential Task ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note</td>
<td>Description Microsoft Project note is limited to 256 characters. Windchill ProjectLink description is limited to 4000 characters. No Rich Text Format (RTF) can be converted from Microsoft Project to Windchill ProjectLink.</td>
</tr>
<tr>
<td>Contact</td>
<td>Activity</td>
<td>Owner</td>
<td>Contact</td>
<td>Export from Windchill ProjectLink sets project author to the value of the project or summary activity owner.</td>
</tr>
<tr>
<td></td>
<td>Resources</td>
<td></td>
<td>Resources</td>
<td></td>
</tr>
<tr>
<td>Predecessors</td>
<td>Predecessors</td>
<td></td>
<td>Predecessors</td>
<td>List of IDs for finish-to-start relationships only. All other relationships ignored.</td>
</tr>
<tr>
<td>Planned Start</td>
<td>Estimated Start</td>
<td></td>
<td>Planned Start</td>
<td></td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------</td>
<td>-------------------------------</td>
<td>--------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Actual Start</td>
<td>Actual Start</td>
<td>Actual Start</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planned Duration (hours)</td>
<td>Estimated Duration (days)</td>
<td>Actual Duration (days)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual Duration (hours)</td>
<td>Actual Duration (days)</td>
<td>Actual Duration (days)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>% Work Complete</td>
<td>% Done</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planned Work Effort (hours)</td>
<td>Estimated Work Effort (hours)</td>
<td>Actual Work Effort (hours)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual Work Effort (hours)</td>
<td>Actual Work Effort (hours)</td>
<td>Actual Finish</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planned Finish</td>
<td>Estimated Finish</td>
<td>Actual Finish</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual Finish</td>
<td>Actual Finish</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text24 (custom field)</td>
<td>Health Status: 0=Unavailable 1=Green 2=Yellow 3=Red</td>
<td></td>
<td></td>
<td>The custom field text24 is used to exchange health status.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Summary Task</th>
<th>Summary Activity</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Fields for summary tasks are analogous to fields for tasks.</td>
</tr>
</tbody>
</table>
Importing a Microsoft Project Plan

You can import a plan into the top-level project plan or any summary activity node from the Windchill ProjectLink plan page.

The following is a list of the tips for successfully importing information from Microsoft Project to Windchill ProjectLink:

• To ensure the best transfer of information, use the Microsoft Project plan template that is delivered with Windchill ProjectLink. Using this plan template will help ensure the best transfer of information between Microsoft Project and Windchill ProjectLink.

• It is generally best to use the start date in Windchill ProjectLink when importing a plan so that the activity dates are relative to the start date in Windchill ProjectLink.

• To ensure that resources and owners (Microsoft Project contacts) are properly associated with users defined in a Windchill ProjectLink project team, always use the e-mail addresses for the resource and contact names when defining the tasks in Microsoft Project.

• Do not use custom calendars. Instead only use the default standard calendar.

• Define all durations in units of days.

• When working with Microsoft Project, if you are tracking cost, set the Microsoft Project task type to fixed work. If you are not tracking cost, set the Microsoft Project task type to fixed units.

• It is generally best not to include work effort in the Microsoft Project plan you want to import. Simply import the plan into Windchill ProjectLink and manage the execution of the plan and the reporting of effort and percentage done in Windchill ProjectLink.
• When importing a plan, it is generally best to use the option to replace the plan information in Windchill ProjectLink rather than to append to it.

• Include only simple text in notes. Do not use images, HTML tags, special characters, or RTF (Rich Text Format).

• Do not include any precedence relationships other than start-no-earlier-than and finish-to-start constraints in the Microsoft Project plan.

• Avoid the use of fixed date constraints. Fixed date constraints appear as overridden date values when imported into Windchill ProjectLink and prevent the propagation of dates based on precedence and hierarchy relationships.

• Importing plans with more than 500 tasks can take a long period of time, sometimes hours depending on the client processor and memory capacity and the server load and capacity. The time necessary to import a Microsoft Project plan increases exponentially with the number of tasks. You can facilitate the import of very large plans by first importing only the top-level summary activities and then separately importing the structure under each top-level summary activity.

• You can also first save the Microsoft Project plan in XML format and then load the XML into Windchill ProjectLink as a two-step approach. This method reduces the points of failure and prevents the need to repeat the XML generation step in case of a server communication failure. Use the Microsoft Project plug-in File option Save as Windchill ProjectLink XML file to convert the Microsoft Project MPP file to the Windchill ProjectLink XML format. Then specify the XML file you just generated instead of selecting a Microsoft MPP file when using the import option in Windchill ProjectLink.

• It is best not to update the percentage of work complete or health status in the Microsoft Project plan summary activities when creating or editing a plan in Microsoft Project. Otherwise these values will show as overridden values rather than calculated values (overridden values are displayed with a gray background fill) in Windchill ProjectLink.
• When you import a large plan into Windchill ProjectLink, the creation of the activities and the propagation of the date and status values are queued in the server. It can sometimes take several minutes before the plan in Windchill ProjectLink is consistent with the plan in Microsoft Project. The propagation is complete when the Windchill ProjectLink plan top level dates, percentage complete, and status are consistent with the Microsoft Project plan just imported.
Exporting a Plan to Microsoft Project

Exporting a snapshot of a plan that you are executing in Windchill ProjectLink is useful when you need to create nicely formatted, printable reports for a status meeting or executive progress briefing. The export mechanism can also be used to create a Microsoft Project plan that you upload to the project document collection to represent a project baseline at a particular point in time. You can export an entire plan or export from a summary activity node level and below.

The exported Microsoft Project plan will include the same columns and health status values as represented in the Windchill ProjectLink plan.

A plan may be exported to Microsoft Project to obtain a GANTT chart view or other reports not supported in Windchill ProjectLink. An executing plan can also be exported to make critical path decisions as Windchill ProjectLink does not support critical path determination.

Editing a Plan in Microsoft Project

Editing a plan is most useful for replanning an unstarted portion of an executing plan in Windchill ProjectLink. For example, a plan may have several summary activities and associated child activities that are started but uncompleted and several summary activities that have not yet started but which need to be replanned. You can execute the edit command for each of the summary activities in Windchill ProjectLink, edit the children of the summary activities, and then replace the summary activity with the new set of plan nodes from Microsoft Project. Editing changes may include adding and removing activities, changing the precedence relationships, and modifying the durations.

The following is a list of tips for successfully editing information from Windchill ProjectLink in Microsoft Project and replacing it in Windchill ProjectLink:

- Only select unstarted summary activity nodes to edit in Windchill ProjectLink, or you will lose historical information associated with completed activities. You also cannot lock the plan while you are editing it, so assigned resources can continue to update started activities. If you need to warn users not to update activities for some period of time, consider including HTML text, such as the following, in the project description that appears on every page:

  `<p><b><font color="#FF0000" size="2" face="Arial">Please do not update any activities at this time--the plan is being modified</font></b></p>`

  You can save this text in a text document or surround this text with the HTML comment tags to hide it as follows:

  `<!-- <p><b><font color="#FF0000" size="2" face="Arial">Please do not update any activities at this time--the plan is being modified</font></b></p> -->`
When this is rendered in the project description it will be displayed as follows:

**Please do not update any activities at this time-the plan is being modified.**

- It is generally best not to edit a plan that is started and is running in automatic execution mode. If you must edit an automatically executing plan, limit changes to unstarted summary activity nodes.

- If any of the activities are associated with deliverables, do not delete and recreate the activities in Microsoft Project. Simply update the existing activities. This way the original deliverables in Windchill ProjectLink can be relinked with same activity when the changes are imported back to Windchill ProjectLink.

- It is generally best not to use the edit capability to update health status and percentage done values or to establish start-no-earlier-than date constraints. These type of updates disrupt the automatic propagation of percentage complete, health status, and date values.

- It is generally best to save back to Windchill ProjectLink using the Replace PTC Windchill ProjectLink with current plan option and the Use original PTC Windchill ProjectLink plan start date option.
About Project Templates

Windchill ProjectLink includes a very rich set of template capabilities that help provide structure, consistency, and completeness to a project. You can define the following information in a project template:

- Folder structure and access control
- "Skeleton" or boiler plate documents and parts
- Pre-defined links to standards or any intranet information or documents for best practices
- Documents that define process for collaborating in a project
- Team roles and/or members or member placeholders
- Discussion topic list
- Skeleton plan and timeline (activities, summary activities, milestones)
- Deliverables (including links to subject objects and activities)
- Life cycle states
- Routing processes

The easiest way to create a new template is to create a project (without starting it) with all of the folder structure, access rules, skeleton documents, team roles and members, deliverables (including links to the document skeletons), plan structure (including activities linked to deliverables), and discussion forum topics. Then to save the project as a template. The template is saved as an XML document that you can then manually edit as needed to make necessary refinements. You can either delete the dummy project once the template is complete or leave it in a Defined state to make new templates.

**Note:** You must be a member of the organization administrator's group for your organization to create a project template. You must be project manager of a project to export the project as a template or to export the project to a file.

See the administrative documentation for information about creating and using project templates.
Managing Context Teams

This chapter describes the team functionality available within Windchill ProjectLink.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Context Teams</td>
<td>10-2</td>
</tr>
<tr>
<td>Creating and Modifying Teams</td>
<td>10-2</td>
</tr>
<tr>
<td>Team Member and Group Information Pages</td>
<td>10-4</td>
</tr>
<tr>
<td>Roles and Groups</td>
<td>10-4</td>
</tr>
</tbody>
</table>
About Context Teams

A context team is a list of the members of a project context. All members of the context can view the context team.

Team members are assigned roles within the context. A context manager, or project manager, role is automatically assigned to the creator of the context; however, the creator can assign the role to other team members. If you are the context manager or the administrator of the organization where the context resides, you can modify the team from the Team page by adding and removing roles, users, and groups. You can define a team using any of the roles that are predefined for your organization or for your context, or you can define new roles that are specific to a context. Then you can add members to one or more roles in the team. Users may have different roles in each context in which they are a participant. In one context, a user can be the context manager while in another context, the user can be a member.

Tip: There is no explicit means of associating responsibilities with roles, but you can create a document in the project that identifies the responsibilities of each of the team roles or members. For more information about roles and groups, see the online help available from the Team page.

Tip: You can create placeholders for members that are needed but unknown at the time the context is created. For example, if you have a role called designers and you know that you need three designers but have identified only one at the time a project is created, you can define placeholders using fictitious e-mail addresses to represent the unknown designers. As soon as resources are identified for these members, you can replace the placeholder user with the actual user.

The team table information can be displayed differently using the available views from the Current View drop-down list.

- Members -- Displays the users and groups invited as team members to participate in a team.

- Members By Role -- Displays the team information organized by role with assigned team members listed under the roles. You can expand and collapse the different roles to view certain information and hide other details.

- All People -- Displays the users in the team with the groups expanded to reveal the names of any group participants. If no groups are a part of the team, this view displays the same information as the Members view.

Creating and Modifying Teams

The following table lists and describes the way in which a context manager can modify a context team:
<table>
<thead>
<tr>
<th>Action</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Members</td>
<td><img src="image" alt="Add" /></td>
<td>Adds users and groups from the system to a particular team and assigns them roles within the team.</td>
</tr>
<tr>
<td>Adding Roles</td>
<td><img src="image" alt="Add" /></td>
<td>Adds organization defined roles or creates new roles that are available only for the specific team.</td>
</tr>
<tr>
<td>Replacing Members</td>
<td></td>
<td>Replaces an existing user with a new user from the system. When you replace a team member in a context, all of the objects in the context currently assigned to or owned by that user are transferred to the new user. See the online help for more information about the implications of replacing a member.</td>
</tr>
<tr>
<td>Removing Members</td>
<td></td>
<td>Removes a user from a role and, potentially, from the team. At least one user must be assigned to the role of the context manager. If you attempt to remove the last confirmed member in that role, you will receive an error message. If a user is completely removed from the team, all objects currently assigned or owned by that user are transferred to the context manager who removed the user. Exceptions include tasks that are instead reassigned to the responsible role.</td>
</tr>
<tr>
<td>Removing Roles</td>
<td></td>
<td>Removes a role from the specific team. You cannot remove the context manager or guest roles from a team.</td>
</tr>
<tr>
<td>Update Project Invitation</td>
<td><img src="image" alt="Edit" /></td>
<td>Updates the invitation that is sent when new users are invited to a project. When the project manager updates the project, the updated invitation is sent to any new team members added in the future.</td>
</tr>
</tbody>
</table>
Team Member and Group Information Pages

Information pages contain specific details about the team member or group. To view a team member or group information page, click the team member or group name.

The team member information page displays some information that is set using the user preferences. These preferences can be changed from the Utilities page of the Home tab. If any of your information is incorrect but cannot be changed as a user preference, see your system administrator.

The following team member details are displayed:

- Name
- E-mail address
- Organization
- Phone Number
- Address
- Local Time Zone

The group information pages display the name and a description of the group. A list of the users assigned to the group is also displayed.

Roles and Groups

Roles

A role relates people in the project context with information and activities managed in that project. Roles help to group people who have similar duties in the context in a way that makes sense for the team. When people are invited to become a member of a project context, the project manager must assign at least one role, such as member or reviewer, to each person. People in a project can be assigned to more than one role. The set of role assignments for each member is displayed on the Team page.

Although some roles and groups are provided when your organization and context are created, additional roles can also be defined for each project from the Team page.

The project manager role has special authority to create and organize the project, invite or remove team members, and manage the operations of the project. In Windchill ProjectLink, the project manager role also manages project tracking information.

The Guest role allows for a person to view data in a context without actually being invited as a participant. The following permissions apply to those assigned to the Guest role for a particular context:
• Will not receive an e-mail invitation to the project.
• The project does not appear in the user’s list of projects.
• Cannot own any project management objects.
• Can access the context through a link or through search results.
• Can access project content unless explicitly excluded through folder or object-specific access control.

Note: Users added to a database without specified e-mail addresses will not appear in the search results returned when adding users to a team.

For information on administrative roles, see the *Windchill Business Administrator’s Guide*.

In Windchill ProjectLink, access to information in a project can be controlled by using roles. When a new file is uploaded or a new folder or part is created, the person who creates that information is responsible for setting the access to the information. Each role in the project is listed in the Access Control window.

Note: This access control is in addition to the access set in the All Members group. All people who have joined the project are automatically included in the All Members group.

Groups

Groups are used to manage access control to information, provide access to e-mail communication, and invite participation in meetings. There are special groups that are used with teams as well as public groups that are created and maintained at the organization context. Meeting attendees can be invited to meetings by group. The following paragraphs describe some of the special groups used with teams.

Each role that is defined has a corresponding group automatically created with the same name. Users added to a role are automatically added to the corresponding group. The context manager can then create access policies for role groups using the Policy Administrator. The policies are enforced whenever the roles are used. One special group that is created is the set of people from an organization that have joined a context. An organization is an entity, such as a company or university. When a user joins a project context, they are automatically added to a group for their organization.

Note: Users not affiliated with an organization will not be added to organization groups.

Note: In Windchill ProjectLink, users must accept the project invitation before they become team members.
The All Members group is the set of all team members in the context. In Windchill ProjectLink, this group is always listed first in the Access Control window. To see the names listed in the All Members group, click the group name in the Access Control window. You can view groups and their users on the Team page.

For example, a context is created, and people from Company A are invited. This context contains the two following groups:

- The All Members group, which contains every invited team member including those from Company A.
- The Company A group, which includes only those team members from Company A.

Later, people from Company B are invited to and join the context. All team members in Company B are added to the All Members group, and the context now contains an additional group called the Company B group which includes only those team members from Company B.
If your site has installed Windchill Foundation & PDM or Windchill PDMLink and Windchill ProjectLink on a single server, you are able to share and exchange information between your PDM system and a project. As a result, you can more easily collaborate with others, both within and outside of your department or your company.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview .........................................................</td>
<td>11-2</td>
</tr>
<tr>
<td>Making PDM Data Available to Your Project Team</td>
<td>11-3</td>
</tr>
<tr>
<td>Examining a Usage Scenario</td>
<td>11-11</td>
</tr>
</tbody>
</table>
Overview

When you are working with integrated Windchill solutions, you can take advantage of common project and program management activities, such as the following:

- You can share data from your PDM system to a project within Windchill ProjectLink. As a result, you can collaborate on the information within the context of a project, where your team’s work can be managed through the use of milestones, deliverables, and resource tracking.

- You can copy or check out design information from the PDM system to a project so that you and others can investigate design possibilities without committing your changes to formal PDM control. If you decide to make your new design or design changes part of your formal change process, you can check parts, documents, and CAD documents back into the PDM system and, if desired, use Windchill ESI to publish them to your ERP system.

- You can invite external participants to join your project, as project team members, without giving them access to your company’s PDM system. For example, if you are collaborating on a new product design, you could invite an engineer from a supplier’s company to participate in collaborative design work to be applied to PDM objects checked out to a project, without giving that engineer access to other PDM data or to your PDM system.

This chapter consists of an extended scenario that illustrates the way in which you and others on your team can use multiple Windchill solutions to make modifications to an existing product. The scenario includes a number of common product development tasks performed by users in a variety of roles. For purposes of demonstration, this extended example assumes that you are the team member assigned to each role and task that is part of the scenario.

Of course, your product data and teams may be significantly more complex than those used in this example, but the principles demonstrated can also be applied to products and projects of greater scope and complexity.

In this scenario, your product team has been asked to create a new product (AL-Bulldozer) from an existing Bulldozer design. The scenario is organized around six tasks:

- **Task 1** - The Engineering Manager creates the new Bulldozer product from the existing Bulldozer design. At the same time, the manager creates the Enterprise Change Request (ECR) and the Enterprise Change Notice (ECN) for the necessary design changes, and assigns the specific activities that must be performed in order to complete the design modifications.

  This task highlights the Save As capabilities and CMII change process available in Windchill.

- **Task 2** - Engineer1 creates a project to coordinate the activities associated with the removal of the bulldozer blade.
This task illustrates how you or another member of your team can use Windchill ProjectLink to create a collaborative environment for design changes that involve multiple users or organizations.

- **Task 3** – A Supplier is given access to information contained within the project in order to make design modifications to the bulldozer bucket.

As shown through this task, your suppliers and customers can be granted access to select information controlled by your PDM system, without being granted direct access to the PDM system itself.

- **Task 4** - Engineer2 modifies the Bulldozer design in Windchill PDMLink, based on the ECN assignment. In this scenario, the ECN calls for modification of the bulldozer toolbox and seat.

This task demonstrates the CMII change process from an end-user prospective.

- **Task 5** - Engineer1 updates the Bulldozer design in the project and completes the removal of the bulldozer blade.

This task shows how, as a member of a collaborative project, you are kept aware of relevant design activities occurring outside of your project. When desired, you can update the information you are referencing to include the latest design changes.

- **Task 6** - The Engineering Manager approves all of the design changes at the completion of the design process. As a result, the updated information is automatically published to an ERP system.

This task demonstrates how design work that you and your team complete in an independent, collaborative environment can be incorporated into your company’s formal change process. It also highlights the way in which Windchill ESI allows Windchill solutions to interoperate seamlessly with ERP systems.

### Making PDM Data Available to Your Project Team

When your site has installed multiple Windchill solutions on a server, you can use Windchill’s clipboard mechanism to share or check out data from a product or library in your PDM system to a project (or from one project to another).

A simple way to move an object is to apply the **Cut**, **Copy**, and **Paste** actions. Both **Cut** and **Copy** move selected objects to the Windchill clipboard; the **Paste** operation determines whether the object will be duplicated, moved, shared, or checked out, based on the icon you select.

For example, within a product, library, or project, you can **Cut** one or more selected objects. The **Cut** operation moves an object from its current location to the clipboard. In order to complete the move, you can then **Paste** the object to a selected folder location.
Within a product, library, or project, you can also use the **Copy** and **Paste** icons to create a new copy of a selected object and either paste a copy of the original item to the selected location or, as described in the following section, paste the object as a shared item:

**Tip:** When you complete a **Copy/Paste** operation within the context of a product, you have essentially completed a **Save As** operation. This operation is not valid for CAD documents.

---

**Sharing PDM Objects to a Project**

The **Copy/Paste** icons and the **Add to Project** action can also be used to share or check out an object from a product or library to a project, or to create a new copy.
of a document or part stored in your PDM system and locate that document or part within a project:

When you share a part, document, or CAD document to a project, all project members have implicit read access. The primary use for a share operation is to provide a project team with read access to selected PDM objects, for purposes of reference. You can also use the Windchill clipboard to initiate sharing of other information, including problem reports, change requests, change notices, product configurations, product instances, and baselines, but these shared objects are accessible only to project team members who have read access to the object in its source location.

**Tip:** Sharing a PDM object version to a project is essentially the same as creating a shortcut to the object within the project. The object continues to reside within the PDM system, but project members can easily view it without having access to your PDM system.

A PDM object can be shared to several projects at the same time. While an object is being shared, it is still subject to modification in the PDM system. As described in Refreshing a Project, you can choose at any time to update your project with the latest iterations of each shared object.

Sharing is especially useful when you do not want to add members of other projects or products to the team in which a document or part was created. For example, you may want to share a design specification document or part prototype design with a manufacturing line team, within the context of a collaborative project, without adding the manufacturing members to the product team. In effect,
sharing allows project members to access only the subset of PDM objects required to complete the work assigned to the project.

From among the list of operations you can perform within a project, the following can be applied to an object you have shared to the project:

- **Details** – View the information page for the selected object. For a PDM object shared to a project, the details page for the object will be displayed from within the PDM system.
- **View** – For documents, view the document content file.
- **Subscribe** – Request e-mail notification when certain events or actions are applied to the selected object.
- **Discuss** – Open the Discussion page to discuss topics related to the object.
- **Add to Notebook** – Add a link to this object in your Notebook.
- **Convert to PDM Checkout** – For one or more parts, documents, or CAD documents that have been shared to a project, check out the shared objects from the PDM database to the project. As shown in the following illustration, the details page for a shared object that has been converted to a checked-out object indicates that the item is checked out from the PDM system to the project:

![Illustration of checked out object](image)

This action cannot be applied to objects that are shared from one project to another, or to problem reports, change requests, change notices, product configurations, product instances, and baselines that have been shared from your PDM system. Your role and your access permissions also determine whether or not this action is available to you; for example, you cannot use the **Convert to PDM Checkout** action on an object to which you do not have update access in the PDM system.
Tip: When you convert a shared object to a checked-out object, the latest iteration of the object is checked out to the project. In some cases, this may not be the iteration that was originally shared.

- **Remove Share** – Remove the shared object from the project.

### Refreshing a Project

Sometimes, a PDM object may be updated within the PDM system after you have shared it to your project. You can use the **Refresh Project** icon to display a list of the latest iterations for all shared objects within a project. You can then select the objects to be updated through a download of their most current iterations.

**Tip:** Only the project manager is allowed to refresh a project.

When you refresh a project, the new iteration for a given object may have children that were not part of the iteration originally shared. Therefore, the **Refresh Project** window includes filtering options that allow you to control the content of the table that displays the refresh candidates. When you are refreshing a project that includes a large number of PDM objects, you can either select all of the objects to be refreshed and click the **Set Refresh** icon, or select only the objects that are not to be refreshed and then click the **Set Exclude** icon:

Tip: When an object is shared, the share link always points to the latest iteration of the object version in the PDM system. Your project, however, tracks the iteration that was initially shared or was downloaded as the result of a **Refresh Project** operation. For example, even if a share link points to object A.2 (the second, and latest, iteration of version A of the object), the project will track
object A.1, if iteration 1 of version A was the object originally shared or most recently downloaded.

Checking Out PDM Objects to a Project

When you use the **Copy/Paste** icons or the **Add to Project** action to check out, copy, or share a PDM object to a project, you first select the new location for the object. The following illustration shows how project location is specified when you select the **Add to Project** action:

Next, you choose whether to share the object or check it out to the project; in this example, the **Selected Action** is **Share**:
As previously described, sharing an object provides project team members with read-only access to the original object. When you check out one or more parts, documents, or CAD documents from your PDM system to a project (or convert a shared object to a checked-out object), project-specific versions of those objects are created within your project. These project-specific versions can be modified by project team members, and the objects are locked in the PDM system to avoid concurrent modification and prevent synchronization problems.

You can also use the Copy/Paste or Add to Project functionality to create new parts and documents, with unique name and number attributes, within a project:
When the copy is later checked in, it does not affect the original part or document. However, when a checked-out part, document, or CAD document is checked in, the check-in operation creates a new iteration of the original object.

Your project team can work with PDM objects checked out to the project as follows:

- Modify existing parts, documents, and CAD documents
- Create new parts, documents, and CAD documents
- Edit and change structures during the project design collaboration
- Reconcile all or a subset of the changes with the source PDM system by using the **Send to PDM** action.

**Note:** CAD documents can be easily viewed and modified in a workspace you create within the context of a project. However, CAD documents that have been published by the Pro/INTRALINK Gateway cannot be checked out to a project.

Modifications to objects checked out from your PDM system are only visible to project team members, within the context of the project.
Using Actions and Icons

When you share or check out PDM objects to a project, the actions and icons available to you, as well as the results of the actions you apply, are based on the following object characteristics:

- The results of an action are determined by the type of the object you have selected. For example, when you create an object, the list of templates you can use for object creation is different for parts than for documents. Similarly, a change object can be shared to a project, but it cannot be checked out to a project, nor can a share relationship to a change object be converted to a PDM checkout.

- Actions differ based on whether an object is native to the current context, has been checked out to the current context, or has been shared. For example, if you are working in a project and you apply the Delete action to a part created within that project (a native object), the part is removed from the project. If you Delete a part shared to the project from your PDM system, the action simply removes the share. If you apply a Delete action to a part checked out to the project from your PDM system, the action un-does the checkout and removes the object from the project. When you are working in your PDM system and apply Delete to a selected object, that iteration is removed from the PDM database.

- The actions and icons available to you when you have selected a specific object are determined by your access permissions to that object. For example, you must have read access to a PDM object in its source location in order to view it from within a project. Similarly, you must have update access to a PDM object within the PDM system in order to check it out to a project or to convert it to a checked-out object when it has been shared.

You can also configure product and project spaces so that objects cannot be shared outside of that space. In this way, you can determine how broadly to share information by removing share privileges on all or selected objects, as appropriate.

Examining a Usage Scenario

The following scenario demonstrates how you might accomplish a number of product development activities necessary to complete a new product design (AL-Bulldozer), using Windchill design collaboration capabilities. As noted above, for ease of demonstration, these examples assume that you are assigned each of the roles and are completing each of the tasks described.

Setting Up Your Environment for This Scenario

If desired, you can install the Pro/ENGINEER Wildfire assemblies and other product data described in this chapter and execute the described procedures on your system.
The data files and specific setup instructions are located in the Windchill\loadFiles\BullDozerDemoData directory. You should also consult the Read This First document for any additional installation instructions.

**Task 1. Creating a Product From an Existing Product**

For purposes of this scenario task, assume that you have been assigned the Engineering Manager role on your product team, and that your team will create a new Bulldozer product from an existing Bulldozer product, reusing existing data in order to reduce costs. After the new product has been created, you will assign the tasks necessary for modification of the Bulldozer design.

**Step 1. Creating a New Product and Making Work Assignments**

The following steps illustrate new product creation:

1. First, you must log on to Windchill, using the user ID and password associated with the Engineering Manager role. Whether or not this is your actual job title, it is the role to which you have been assigned on the product team. When you log on, Windchill recognizes your association with the Engineering Manager role, and grants you the access permissions associated with that role when you are working within the context of your team’s product.

   Whenever you log on, Windchill opens to the last location you visited before exiting the system. If your home page is not displayed when you log on, you can select the Home tab to navigate there. Your home page displays your current task assignments, the objects you have recently updated, and any objects that you have checked out.

2. Select the Product tab to display a list of products that you are authorized to access.

   **Tip:** Windchill has stickiness capabilities that allow you to navigate among tabs and menus, and then quickly return to the area in which you were previously working. In this case, if the Product tab did not open to a list of products because of a previous navigation, you could select the Products List menu to display the list.

3. Click the Create Product icon at the top of the Products table.

4. In the Create Product window, enter a product name (for example, AL-Bulldozer) and a product number (for example, AL-PDM-100-0001), and then click OK.
You have now created a new product container that will hold all of the information related to your new Bulldozer design, and a product object that will represent the end item of your product structure.

Step 2. Adding Members to the Product Team

The following steps demonstrate how you can identify the users who are authorized to access your product:

1. To see information for a specific product, select the Product tab, the Products List menu, and the desired product (in this case, AL-Bulldozer) from the list of products. This allows you to view product information on the AL-Bulldozer details page.

2. From the product details page, click the Team link (below the tabs) in order to add team members. Windchill displays the list of roles and associated team members predefined in the product template that was used to create the product.

3. Add Engineer1 and Engineer2 as members of the product team.
   a. If the Member role is not currently defined for the product, select the Add Roles action from the top of the table, select Member from the list of roles, and click OK to add the role.
   b. Select Add Members from the drop-down menu next to the Member role. Search for the users (in this case, Engineer1 and Engineer2) to add to the role.
   c. Click OK to add the users.

Engineer1 and Engineer2 have now been added as members of the product team.
4. Add the Engineering Manager as Change Administrator I, Change Administrator II, and Change Administrator III
   
a. If the Change Admin I, Change Admin II, and Change Admin III roles are not currently defined for the product, select the Add Roles action from the Actions list at the top of the table, select Change Admin I from the list of roles, and click OK to add the role. Repeat this operation for Change Admin II and Change Admin III.
   
b. Select Add Members from the drop-down menu next to the Change Admin I role. Search for the user or users (in this case, Engineering Manager) to add to the role. Repeat this operation for Change Admin II and Change Admin III.
   
c. Click OK to add the users.

   The Engineering Manager has now been added to the Change Administrator I, II, and III roles within the product team.

Step 3. Creating an Assembly From an Existing Assembly

After the new AL-Bulldozer product has been created, you can copy the parts and associated CAD documents to be modified for the new design from the original Bulldozer product. As a result, the new AL-Bulldozer product will contain only the parts and assemblies that are actually being modified and will reference the remainder of the design from the original Bulldozer product.

In a number of cases, the easiest way to create a design from an existing one is to use the Save As capabilities in Windchill. The following steps demonstrate how this is done:

1. From the Product tab, click the Products List link.
2. Within the product list, select the Bulldozer product.
3. Click the Product Structure menu to display the original Bulldozer product (PDM-100-0001) and its components.
4. Select the Bulldozer product from the table, and use the Show Documents action to display the associated CAD documents.
5. Click the (information) icon for the associated CAD document (PDM-100-0001.asm) to navigate to the details page for the assembly.
6. On the details page for CAD document PDM-100-0001.asm, select the Save As action from the drop-down menu. You can then use the Save As window to identify the parts within the assembly structure that are to be copied to the new AL-Bulldozer product.

Tip: Selecting the Save-As action from the CAD document details page allows you to copy an entire or partial CAD document structure and its associated parts to a new structure with new names and numbers. With a
Copy/Paste operation, you can copy individual parts and documents, assigning them new names and numbers.

7. The first step in the Save As process itself is to identify the dependent information to be included in the Save As operation. In this way, you ensure that all existing part and document relationships are maintained. For purposes of this scenario, you would make the following selections from the Rules section of the Save As window:

- **Configuration Specification = Latest.** When you set the Configuration Specification field to Latest, you indicate that you want to use the latest available configuration of the assembly. You can use other Configuration Specification settings to select previously stored baselines or checked-in configurations.

- **Dependency Type Processing = CAD Document Centric.** This field indicates whether the CAD document or the part structure is to be used for determining the configuration. By selecting CAD Document Centric, you specify that the CAD document structure is to be used for this purpose.

- **Baseline For Docs, Baseline for Parts.** These fields identify the baseline name that should be used if the Configuration Specification field is set to Baseline.

- **Include Dependents = Required.** This field is used to identify the dependent objects that are to be included in the configuration. When you select Required, only the objects necessary to regenerate the assembly are included. The All option includes every object that has a relationship to the assembly. The None option includes only the assembly itself.

- **Include Parts = All.** When you set this field to All, you include all Windchill parts to which the CAD documents are associated. The Selected option includes only the parts for objects selected in the table. If you specify None, no Windchill parts are included.

- **Include Drawings = None.** This field allows you to indicate whether the CAD drawings associated with the assembly and its dependents should be included in the configuration. In this example, the None option indicates that no CAD drawings are to be included.

- **Include Instances = All.** This field allows you to specify whether or not Pro/ENGINEER family table instances should be included in the configuration.
After these fields have been set, click **Refresh Object List** to update the **Object List** table.

8. The second step of the Save As process is to identify the parts and CAD documents to be modified and reused in the new design.

   **Tip:** When your team needs to modify only a small portion of an existing configuration, as in this example, it is easiest to first mark all the parts and CAD documents as reused, and then rename only the objects to be modified and copied to the new design.

   To perform this task, select the **All** check box in the table (if all objects are not currently selected). After you select **All**, a checkmark appears in the checkbox for each object. Next, select the **Reuse** action at the top of the table.

   Now, you can select the items to be copied to the new design from the table:

   - The Bulldozer assembly (in this example, PDM-100-0001.asm); for purposes of this scenario, you would **not** copy the product associated to the Bulldozer assembly, because the AL-Bulldozer assembly will later be associated with the AL-Bulldozer product.
   - The Frame assembly to which the toolbox belongs (in this example, PDM-100-0003.asm) and the part associated to it.
– The Bucket (in this example, PDM-010-0007.prt) and the part associated to it.
– The assemblies to which the bucket belongs (in this example, PDM-100-0005.asm, PDM-100-0006.asm, and PDM-100-0007.asm) and the parts associated to them.

9. Next, select the **Naming Options** action at the top of the table. For purposes of this example, set the following values in the **Save As Options** table:

   - **Number – From * To <prefix>-**
   - **Name – From * To <prefix>-**
   - **File Name – From * To <prefix>-**

To complete the renaming of the objects to be copied and modified, click **OK**, then click **New** and verify that the **Number**, **Name**, and **File Name** values for the items have been updated.

**Tip:** The **Number** and **File Name** values must be unique and, therefore, you must change them for newly created objects. There is no uniqueness constraint on **Name**, so changing it is optional.

10. In the **Save As** window, reselect the items you selected in Step 8 and then select the **Location** action. For this example, you would select the AL-Bulldozer product and a subfolder, if desired, as the location for the Save As operation. Click **OK** and verify that the new location of the items is the desired product (in this case, AL-Bulldozer).

**Tip:** Use the **Current View** drop-down menu to manage table content, restricting the list of objects displayed to those meeting the criterion you have chosen.

11. Click **OK** at the bottom of the **Object List** table. The objects involved in the Save As process are then copied to the new product, with their new names and numbers. Windchill displays a status message to let you know that the Save As operation was successful.

**Step 4. Associating the Top-Level Assembly to the Product**

After the parts and associated CAD documents to be modified for your new design have been copied to the new product, the following illustrates how the top-level CAD assembly is associated with that product:

1. In order to associate the top-level CAD assembly with the product, you must create a workspace in the context of the product.
   a. On the **Product** tab, select the product (AL-Bulldozer) from the **Product List** in order to navigate to the product details page.
   b. Select **Create Workspace** from the **Workspaces** menu.
c. Enter a name for the workspace and ensure that the context is set to the desired product (AL-Bulldozer).

   **Tip:** A workspace name cannot contain any special characters.

d. Click **OK** to create the workspace.

2. From the **Folders** menu, select the appropriate folder (if it was defined during the Save As operation) to navigate to the top-level CAD assembly to be associated with the product.

   **Tip:** To improve navigation efficiency and performance, Windchill has implemented table views that allow the filtered display of object types. To view only the CAD documents contained within a folder, select **CAD Documents** from the **Current View** drop-down menu (located at the top of the table).

3. Click the  
   (information) icon or select **Details** from the **Actions** list for the desired CAD document (in this case, AL-Bulldozer) in order to access the object’s details page.

   This is the top-level assembly that will be associated with your new product.

4. Select **Associate** from the drop-down menu on the CAD document details page.

5. You must now search for the product that will be associated to the CAD document. Select **Product** as the object type in the **Search for** drop-down menu, and then click **Search**.

   **Tip:** Selecting an object type from the **Search for** menu constrains the search results to that object type, improving search performance.

6. Enter the **Name** or **Number** of your new product (in this case, AL-Bulldozer) and click **Search**.

7. Select your product from the list of search results and click **OK**. Windchill then returns to the **Associate** page, with your product selected.

8. On the **Associate** page, ensure that the **Active Link** for the product (AL-Bulldozer) is set to the correct CAD document (AL-PDM-100-0001.asm) and then click **OK**. The top-level CAD assembly is now associated to your new product.
During the associate process, the CAD assembly was checked out to the workspace you created. In order to complete this task, you must check the assembly back into the product, as follows:

a. In the CAD document details page for the top-level assembly (in this case, AL-Bulldozer), select **Check In** from the drop-down menu.

b. In the check-in window, select the top-level assembly and select **Include Parts/Docs**. Both the product and the CAD document will be listed.

c. Click **OK**.

Your new product and its top-level assembly are now checked into the appropriate product context and are associated. To verify the association, go to the details page for the product and click the **Product Structure** link. Select the product (in this case, AL-Bulldozer) and the **Show Documents** menu at the top of the table. The top-level assembly (in this example, AL-Bulldozer) should be listed as an associated CAD document.

**Step 5. Creating Work Assignments for Product Modifications**

As the Engineering Manager for this task, you must next create an Enterprise Change Request (ECR) and an associated Enterprise Change Notice (ECN) for the modifications to be applied to the new design. For purposes of this example, you
will use the Windchill PDMLink CMII closed-looped process to manage the change process. The following illustrations show the workflow for this process.

To minimize the number of users necessary to complete the change process, assume that, as the user assigned the Engineering Manager role, you have also been assigned the Change Administrator I, Change Administrator II, and Change Administrator III roles. Consequently, the following example illustrates execution of the CMII fast track change process without including separate logins for multiple user IDs.

1. From the home page, search for the new AL-Bulldozer product and select it from the search results by clicking on the name link. This displays the details page for the product.
**Tip:** There are two levels of searching available in Windchill. In the lower right corner of the global page header, you can click the **Search** link to initiate a search of the entire Windchill system. In addition, various Windchill pages include a search capability that allows you to search within the specific context of the page. Either search mechanism may be used for this step.

2. From the drop-down **Actions** list, select **Create an ECR**.

3. Fill in the ECR form with the following information. Fields beginning with an asterisk (*) are required values:
   a. Assign an **ECR name** (in this example, Change to new bulldozer).
   b. Select an **ECR classification** (in this example, Cost Reduction).
   c. Provide an **ECR description**.
   d. Assign a **Priority level**.
   e. Go to the **Affected Data** tab to add the top-level bulldozer assembly.
      i. Select the **Add Affected Data** action.
      ii. Select **CAD Documents** from the drop-down menu on the search page.
      iii. For purposes of this example, search for items with the name AL-PDM*.
iv. Select the top-level assembly AL-PDM-100-0001.asm from the search results.

v. If the AL-Bulldozer product is contained in the list, select and remove it.

f. Return to the **Description** tab, select **Now** for the **Submit** value, and click **OK**.

For purposes of this scenario, assume that you have also been assigned the change administrator role for each phase of the CMII change process. To complete the first step of the change process, the ECR change administrator must analyze the request and determine what action should be taken.

1. To analyze and define the ECR activity, navigate to the **Home** tab and, from the **Assignments** table, select the **Analyze ECR** item with a **Subject** that matches the name you assigned to the ECR.

2. On the **Analyze ECR** page, review the ECR and select **Fast Track** as the action to be taken. Click **Task Complete**.

The ECR analysis task is now complete, and the ECR has been routed to Change Administrator II (CAII) for the creation of the ECN. For purposes of this scenario, assume that you have been assigned the CAII role as well, and that you will create the ECN, as follows.

1. To view the Create ECN task, navigate to the **Home** tab (you may need to refresh the page in your Web browser). From the **Assignments** table, select the Create ECN task with a **Subject** that has the same name as the ECR.

2. Follow the instructions on the **Create ECN** page to complete the task:
a. Select the URL to navigate to the ECR.

b. Select Create ECN from the drop-down menu on the ECR details page.

c. Enter a Name, Description, and Due Date on the ECN form.

3. Assign the three tasks that must be performed to complete the ECN.

   Task 1: Removal of the Blade by Engineer 1
   
   i. Go to the Implementation Plan tab and select Add New Task.
   
   ii. Add the Task Name (Remove Blade).
   
   iii. Add a description, such as the following:
   "Create a project, and send the AL-Bulldozer to the project; only the AL-Bulldozer should be modifiable. Within the project, remove the Blade and send the AL-Bulldozer back to the PDM system. Do not forget to refresh your project before proceeding with the modification."
   
   iv. Assign Engineer1 (eng1) as the Author of the task.
   
   v. Assign the Engineering Manager (mgr) as the Designated User (Reviewer) of the task, and click ADD to complete the creation of the task.
   
   vi. Expand the Remove Blade task to display its details.
   
   vii. Select Add Affected Data to associate the bulldozer assembly.
   Search for CAD documents with the name AL-Bulldozer or the number AL-PDM-100-0001. Select the assembly from the search results and click Add Select Items.

   The first ECN task is now defined for Engineer1.

   Task 2: Modification of the bucket by the Supplier
   
   For purposes of this scenario, the user assigned to the Engineering Manager role is to be assigned the task of coordinating activities with the supplier. To create this coordination task, you would begin by selecting Add New Task from the Implementation Plan tab.
   
   i. Specify the task name (Request Supplier Design Update of Bucket).
   
   ii. Add a description such as the following:
   "Create a project, invite the Supplier, and send the Lower Arm assembly to the project. Only the AL-Bucket should be modifiable. Within the project, create an action item for the supplier."
   
   iii. Assign the Engineering Manager (mgr) as the Author of the task.
   
   iv. Assign the Engineering Manager as the Designated User (Reviewer) of the task and click ADD to complete the task creation.
v. Expand the Request Supplier Design Update of Bucket task to display its details.

vi. Select **Add Affected Data** to associate the bucket assemblies (AL-PDM-100-0007.asm, AL-PDM-100-0006.asm, AL-PDM-100-0005.asm, and AL-PDM-010-0007.prt), and click the **Add Select Items** button.

The second ECN task is now defined for the Engineering Manager.

---

Task 3: Modification of the toolbox and seat cushion by Engineer2.

i. Select **Add New Task** from the **Implementation Plan** tab to create the task.

ii. Specify the task name (in this example, Modify Toolbox and Add Seat Cushion).

iii. Add a description such as the following:

"In bulldozer assembly AL-PDM-100-0003.asm, interchange the existing toolbox (PDM-030-0001.prt with PDM-030-0002.prt), add the seat cushion (PDM-010-0024.prt), and check it in to the product."

iv. Assign Engineer2 (eng2) as the Author of the task.

v. Assign the Engineering Manager (mgr) as the Designated User (Reviewer) of the task and click **ADD** to complete the task creation.

vi. Expand the Modify Toolbox and Add Seat Cushion task to display its details.

vii. Select **Add Affected Data** to associate AL-PDM-100-0003.asm and the text file, and click **Add Select Items**.
The third ECN task is now defined for Engineer2.

4. Return to the **Description** tab, select **Now** in the **Submit** field, and click **OK** to complete the definition of the ECN.

5. Navigate to the **Home** tab and select the Create ECN task. Click **Task Complete**. The ECN and associated tasks have now been created and distributed to the task Authors.

**Task 2. Creating and Working in a Collaborative Project**

This task demonstrates the use of a Windchill ProjectLink project to manage a large design change that involves participants from multiple organizations. In this example, assume that you have been assigned the role of Engineer1, who has the following tasks:

- Update the AL-Bulldozer design by removing the bulldozer blade.
- Invite other participants to the project in order to address aspects of the bulldozer design that will be affected by the blade removal.

The following are specific steps for completion of this scenario task:

1. Log on as Engineer1 and review your tasks in the **Assignments** table on the home page.
2. From your assignment list, select the Complete ECN task for the removal of the bulldozer blade.

3. Select the related link on the Complete ECN Task form to display the ECN form.

4. Expand the Remove Blade task in the Task list to review the details.

5. To create a collaborative project, navigate to the Project tab and select the Create Project action at the top of the table. Create a project named Bulldozer Blade Removal.

   a. Click Next to add members to the project.

   b. Click Next to add a description of the project that will be sent to the new members.

   c. Click Next to define the project details. Enter a number for the project and select Activities, then click OK to create the project.

You have now created the collaborative project to be used for removing the bulldozer blade and updating the associated bulldozer systems, including the hydraulics and controls. The following, specific steps demonstrate how you can add product data to the project. In this case, certain parts of the design are to be updated by the project members, while other objects are provided only for reference.

1. Search for the AL-Bulldozer assembly, and click the (information) icon next to the AL-Bulldozer CAD document listed in the search results in order to view the details page.

2. Select Add to Project from the Actions drop-down menu on the details page.

   Adding a product, project, or CAD document to a project is a two-step process. The first step requires choosing the project and project location to which the objects will be added. In the second step, you must identify which objects are to be added to the project, as well as the actions that can be applied to each of them.

3. As a first step, select the project and project location to which the objects from your PDM system will be added:

   a. Search for the project you created (Bulldozer Blade Removal) by clicking Select next to the Project Name field. Windchill displays the Select Project window, from which you can search for existing projects. For purposes of this example, you will search for and select the Bulldozer Blade Removal project and then click OK to complete the selection.

   b. You can select a target folder by clicking Select next to the Location field. In the Select Folder window, select Default and then click Open to display the available folders. Click OK to complete the operation.

   c. Click Next to proceed to the next step.
4. The second step in adding a product, part, or CAD document to a project requires that you identify the specific dependent objects to be added to the project, as well as the actions that can be applied to each. The Paste dependency definition form allows you to identify the necessary objects and dependencies:

- **Configuration Specification** = Latest. This setting indicates that you want to use the latest available configuration of the assembly. You can use other **Configuration Specification** settings to select previously stored baselines or checked-in configurations.

- **View** = <blank>. The setting you specify for this field identifies a configuration view, such as as-designed or as-planned, that should be used for the configuration specification.

- **Dependency Processing Type** = CAD Document Centric. This field indicates whether the CAD document or the part structure is to be used for determining the configuration. By selecting **CAD Document Centric**, you specify that the CAD document structure is to be used for this purpose.

- **Include Parts/CAD Docs** = None. The setting for this field indicates whether or not you want to include the Windchill parts to which the CAD documents are associated. The **Selected** option includes only the parts for objects selected in the table, while the **All** option includes every Windchill part associated with a CAD document. If you specify **None**, no Windchill parts are included.
– **Include Instances = None**. The setting for this field indicates whether or not Pro/ENGINEER family table instances should be included in the configuration. In this case, **None** specifies that the family table instances are not to be included.

– **Include Dependents = Required**. This field is used to identify the dependent objects to be included in the configuration. **Required** includes only the objects necessary to regenerate the assembly, while the **All** option includes every object that has a relationship to the assembly. The **None** option includes only the assembly.

– **Include Drawings = None**. The setting for this field indicates whether or not the CAD drawings associated with the assembly and its dependents should be included in the configuration.

– **Include Documents = None**. The setting for this field determines whether or not documents referenced by the assembly and its dependents should be included in the configuration.

After these options have been set, click **Refresh Item List** to update the table.

5. From the object list, select the AL-Bulldozer assembly (AL-PDM-100-0001.asm) and then select the **Set Check Out** action at the top of the table. The selected action for the AL-Bulldozer assembly is now set to Check Out, while the selected actions for all other objects are set to Share. As a result, only the AL-Bulldozer assembly will be checked out to the project and can be modified within that context. All other associated objects will have read-only status within the project.

6. Click **OK** to complete checkout and sharing of objects to the project.

After you have completed these steps, you are returned to the AL-Bulldozer details page. When you next navigate to the Bulldozer Blade Removal project on the **Project** tab, you will notice that the AL-Bulldozer assembly has been checked out to the project, while the remaining bulldozer parts have been shared to the project. These shared objects are provided for read-only reference, and act as links to the objects stored in your PDM environment. As noted above, only objects that have been checked out can be modified within the project. In this way, you can effectively manage access to your PDM data, while allowing for efficient collaboration.

Now that the information necessary to remove the blade from the bulldozer has been added to the project, you can optionally invite other project members and assign the project tasks required to complete the design work.

**Task 3. Collaborating with an External Supplier**

This scenario task demonstrates how you can use a Windchill ProjectLink project to invite external users, such as suppliers or customers, into the design process, without providing them direct access to your PDM environment. For purposes of this task, assume that, acting as Engineering Manager, you must set up a project
for your supplier to use in order to modify the bucket of the AL-Bulldozer design to your specifications. After the supplier makes the necessary design changes, you will check the design changes into the PDM system and mark the ECN task as complete.

Step 1. Creating a Project and Tasks for an External Supplier

The following steps provide a specific example of the activities required to create a new project for collaboration with an external vendor and assign that vendor specific tasks necessary to complete the design changes.

1. log on as the Engineering Manager.
2. From your assignment list, select the Complete ECN task for the supplier bucket update.
3. Select the appropriate link on the Complete ECN Task form to display the ECN form.
4. Expand the Supplier Design Update task in the list to review the details.
5. In order to create the new project, to be called Bucket Update, navigate to the Project tab and select the Create Project action. After entering the project name, complete the following to define the project for other members:
   a. Click Next to add members to the project. Add user Supplier as a project member.
   b. Click Next to add a description of the project that will be sent to the new members.
   c. Click Next to define the project details. Enter a number for the project and select Activities, then click OK to create the project.
6. Review the tasks in the Assignment table on the home page. Select the Complete ECN task for the modification of the bucket from the Assignment list.
7. Click the ECN task link on the Complete ECN Task form to display the ECN form.
8. Expand the Modification of Bucket item in the task list to review the details.
9. Click the (information) icon next to the AL-Bucket part listed in the task to navigate to the AL-Bucket details page.
10. Because the supplier will need the Lower Arm assembly for reference purposes, you can select the Used By link on the details page to display all of the assemblies in which AL-Bucket is used.

Select the Lower Arm assembly in the Used By table to navigate to the details of the assembly.
11. Next, select Copy from the Actions drop-down menu on the details page for the Lower Arm assembly, in order to share this object to the project.

12. Complete the following steps to specify the project and project location to which the checked-out and shared objects will be added. Navigate to your project (Bucket Update) by selecting the Project tab. Within the project, select a folder (Design, for example), and select the Paste action icon located at the top of the folder table.

13. As previously described, adding a product to a project requires that you identify the specific objects to be added to the project, as well as the actions that can be applied to each. The Paste dependency definition form allows you to identify the necessary objects and dependencies. In this example, you make the following selections for the dependency criteria:

- **Configuration Specification = Latest.** This setting indicates that you want to use the latest available configuration of the assembly. You can use other Configuration Specification settings to select previously stored baselines or checked-in configurations.

- **View = <blank>.** The setting you specify for this field identifies a configuration view, such as as-designed or as-planned, that should be used for the configuration specification.

- **Dependency Processing Type = CAD Document Centric.** This field indicates whether the CAD document or the part structure is to be used for determining the configuration. By selecting CAD Document Centric, you specify that the CAD document structure is to be used for this purpose.

- **Include Parts/CAD Docs = None.** The setting for this field indicates whether or not you want to include the Windchill parts to which the CAD documents are associated. The Selected option includes only the parts for objects selected in the table, while the All option includes every Windchill part associated with a CAD document. If you specify None, no Windchill parts are included.

- **Include Instances = None.** The setting for this field indicates whether or not Pro/ENGINEER family table instances should be included in the configuration. In this case, None specifies that the family table instances are not to be included.

- **Include Dependents = Required.** This field is used to identify the dependent objects to be included in the configuration. Required includes only the objects necessary to regenerate the assembly, while the All option includes every object that has a relationship to the assembly. The None option includes only the assembly.

- **Include Drawings = None.** The setting for this field indicates whether or not the CAD drawings associated with the assembly and its dependents should be included in the configuration.
Using Integrated Windchill Capabilities - Windchill ProjectLink and Windchill PDMLink

- **Include Documents = None.** The setting for this field determines whether or not documents referenced by the assembly and its dependents should be included in the configuration.

After these options have been set, click **Refresh Table** to update the object list.

14. From the object list, select the AL-Bucket part, AL-PDM-010-0007.prt, and then click the **Set Check Out** icon at the top of the file list table. The selected action for the AL-Bucket part is now set to Check Out, while the selected actions for all other objects are set to Share. As a result, only the AL-Bucket part will be checked out to the project and can be modified within that context. All other associated objects will have read-only status within the project.

Click **OK** to complete the check-out and sharing of objects to the project.

When you next navigate to the Bucket Update project on the **Project** tab, you will notice that the AL-Bucket part has been checked out to the project, while the remaining objects have been shared to the project. These shared objects are provided for read-only reference, and act as links to the objects stored in your PDM environment.

15. Select **Assignments** from the project menu list and click the **Create Action Item** icon in the **Assignments** table.

16. Enter Update Bucket Design as the name, select Supplier as the owner, and enter a description of the assignment (for example, “Update bucket design per markup or specifications.”).

17. Click **OK** to complete the task assignment.

You have now created the project in which the Supplier will make the required design modifications, and assigned the task that the Supplier must complete.

**Step 2. The Supplier Makes Design Modifications Within the Project**

This section provides a specific example of the activities an external supplier might complete in order to collaborate with you and your product team on a particular aspect of your design project.

When the Supplier logs in to the project, Windchill displays the home page for Supplier. From the **Product** and **Project** tabs, the Supplier has access only to the Bucket Update project and the product data you have added to that project.

For purposes of this scenario, the Supplier will complete the following steps:

1. Log on to the system as the Supplier.

2. Select the Update Bucket Design task from the **Assignments** table in order to view the details of the task.
Tip: Typically a supplier would be provided with a markup and set of instructions for the required modifications. In this scenario, the Supplier simply reviews the text of the assigned task.

3. Proceed with the Bucket design modifications in Pro/ENGINEER Wildfire. (These procedures may vary slightly, depending on the Pro/ENGINEER Wildfire version you are using.).
   a. Launch Pro/ENGINEER Wildfire and navigate to the Tools/Server Registry.
   b. Select Add from the Server Register window and enter a server Name and Location.
   c. Click Check to verify the server connection.
   d. After Pro/ENGINEER Wildfire has connected to the server, the list of products and projects to which the Supplier role has access is displayed. Select Bucket Update as the active project within this server, select the name you just provided, and click Set.
   e. Select the File/Open command to navigate to the server and the Bucket Update project. Select the AL-Bucket part (AL-PDM-010-0007.prt) to open it.

4. Modify the AL-Bucket by changing the length to 110 and the cut pattern to 5.
   Tip: If you are prompted to check out the object, accept the warning.

5. Once the modifications are complete, select File > Check-in > Custom Check-in to update the design changes in the project.
   a. Select CAD Model and CAD Viewable in the Custom Check-in window, and click OK. Click OK in the Check-in window.
   b. The Supplier’s design modifications have now been checked into the Bucket Update project.

6. Exit Pro/ENGINEER Wildfire and return to Windchill to mark the Supplier task as complete.
   a. Select Update Bucket Design from the Assignments table on the home page to navigate to the task details page.
   b. Select Update from the Actions drop-down menu on the task details page (alternatively, click the See Actions link, depending upon your system configuration).
   c. Select Resolution from the Step list on the Update Action Item window to change the execution state to Resolved, and click OK.

At this point, the Supplier has completed the task of modifying the AL-Bucket design.
Step 3. Submitting the Updated Bucket Design and Completing the ECN Task

As the Engineering Manager, you are notified that the Supplier has completed the assigned design changes. In this step, you will submit the updated design to the PDM system and mark the ECN task as complete.

1. Log on to Windchill as Engineering Manager, and navigate to the Project tab and the Bucket Update project.

2. Click the link on the AL-Bucket part (AL-PDM-100-0007.prt) and review the updated bucket design in Windchill ProductView.

   Tip: Before proceeding to the next step, select PDM candidate check-in from the Current View drop-down menu on the Folders table in order to restrict the display to those objects eligible for check in to the PDM system.

3. Select the AL-Bucket part (AL-PDM-010-0007.prt) and then select the Send to PDM action from the Actions list.

4. Accept the default settings in the check-in user interface and click OK to check the part back into the PDM system.

5. Navigate to your home page in order to mark the Supplier Bucket Update task as complete.

   a. Select the Complete ECN task in your Assignments table and click the link to the ECN in order to open it.

   b. From the drop-down menu on the ECN page, select Update. Within the Update window, select the Implementation Plan tab and expand the Supplier Bucket Update task. Select Add Resulting Items to search for the AL-Bucket, AL-Upper-Arm, AL-Lower-Arm, and AL-Holder parts (AL-PDM-0010-0007, AL-PDM-100-0007, AL-PDM-100-0005, and AL-PDM-100-0006) to add as the resulting items. Click OK to complete the operation.

   Tip: This step identifies the objects resulting from AL-Bulldozer product design activities; later, all object modifications and new objects resulting from this effort will be published to your ERP system.

6. Navigate to the home page and select the Complete ECN task for the modification of the bucket. Click Task Complete.

You have now completed the submission of the Supplier’s design changes and have marked the ECN task as complete.

Task 4. Making Design Changes in the PDM System

In a typical product development environment there is a combination of concurrent design modifications occurring in the PDM system and in Windchill ProjectLink. This section demonstrates how, as a member of a product team, you can make design modifications within the PDM system in order to complete CMII
change activities while other design activities are being performed in collaborative projects. In a later task, you will see how members of the project teams can be kept aware of changes occurring within the PDM system. For this task, you will be assuming the role of Engineer2.

1. Log on to the system as Engineer2.
2. From your assignment list, select the Complete ECN task with the name Seat and Toolbox Update.
3. Select the appropriate link on the Complete ECN Task form to display the ECN form.
4. Expand the Seat and Toolbox Update task in the list to review the details.
5. Proceed with the design modifications in Pro/ENGINEER Wildfire. (These instructions may vary slightly, depending upon the Pro/ENGINEER Wildfire version you are using.)
   a. Launch Pro/ENGINEER Wildfire and navigate to the Tools/Server Registry.
   b. Select Add from the Server Register window and enter a server Name and Location.
   c. Click Check to verify the server connection.
   d. After Pro/ENGINEER Wildfire has connected to the server, the list of products and projects to which the Engineer2 role has access is displayed.
   e. Select AL-Bulldozer as the active product within this server, select the name you just provided, and click Set.
6. From the Pro/ENGINEER Wildfire Folder Browser, select the server you created in order to open the server home page in the embedded browser.
7. Review the tasks in the Assignments table on the home page. From your list of assignments, select the Complete ECN task for modification of the seat and toolbox.
8. Select the ECN Task link on the Complete ECN Task form to display the ECN.
9. Expand the Modify Toolbox and Add Seat Cushion item in the task list to review the specific task details.
10. Select the AL-Frame part listed in the task, then drag and drop it into your Pro/ENGINEER Wildfire user interface. This opens the AL-Frame assembly in Pro/ENGINEER Wildfire.
11. After the assembly has been opened in Pro/ENGINEER Wildfire, add the Cushion, PDM-010-0024.prt, located in the General library and assemble it to the seat.
Tip: If you are prompted to check out the object, accept the warning.

12. Go back to your assembly and interchange PDM-030-0001.prt with PDM-030-0002.prt. (Assume that both components belong to the same interchange group.)

13. Once the modifications are complete, select File > Check-in > Custom Check-in to update the design changes in the product.
   a. Select CAD Model and CAD Viewable in the Custom Check-in window, and click OK. Click OK in the Check-in window.
   b. The seat and toolbox design modifications have now been checked into the AL-Bulldozer product.

14. Navigate to your home page in order to mark the Seat and Toolbox Update task as complete.
   a. Select the Complete ECN task in your Assignments table and click the link to the ECN to open it.
   b. From the drop-down menu on the ECN page, select Update. Within the Update window, select the Implementation Plan tab and expand the Seat and Toolbox Update task. Select Add Resulting Items to search for the AL-Frame assembly (AL-PDM-100-0003.asm) to add as the resulting item. Click OK to complete the operation.

   Tip: This step identifies the object resulting from AL-Bulldozer product design activities; later, all object modifications and new objects resulting from this effort will be published to your ERP system.

15. Return to the home page and select the Complete ECN task for the modification of the seat and toolbox. Click Task Complete.

You have now completed the submission of your design changes and have marked the ECN task as complete.

Task 5. Updating a Collaborative Project

This section provides further demonstration of the ways in which a project (created in Task 2) can be used as a collaborative environment for design changes that involve multiple users and organizations. Although the design modification tasks for this scenario have been performed sequentially, these tasks are typically performed concurrently in a production environment.

To begin this task, you will return to the Blade Removal project created in Task 2. The steps described below illustrate how changes that have occurred concurrently can be incorporated into the design changes of this project team. In addition, you will use the Pro/ENGINEER Wildfire embedded browser to perform common Windchill activities from within your Pro/ENGINEER Wildfire environment.

1. Log on to the system as Engineer1.
2. Launch Pro/ENGINEER Wildfire and navigate to the Tools/Server Registry.
   a. Select Add from the Server Register window and enter a server Name and Location.
   b. Click Check to verify the server connection.
   c. After Pro/ENGINEER Wildfire has connected to the server, the list of products and projects to which the Engineer1 role has access are displayed. Select Bulldozer Blade Removal as the active project within this server, select the name you just provided, and click Set.

3. From the Pro/ENGINEER Wildfire Folder Browser select the link to the server you created in order to open the server home page in the embedded browser. Select the Project tab and navigate to the Bulldozer Blade Removal project.

4. Click the Refresh Project icon to update shared objects for which design changes have been made in the PDM system. In the Refresh Project window select all of the objects listed in the table, click the Set Refresh icon, and then click OK. The shared objects in the project are updated to reference the latest iterations of the objects in the PDM system.

5. Select the URL for AL-Bulldozer, and drag and drop the AL-Bulldozer assembly into the Pro/ENGINEER Wildfire user interface. This opens the AL-Bulldozer in the Pro/ENGINEER Wildfire session.

   **Tip:** If you are prompted to check out the object, accept the warning.
6. Right-click on Blade (PDM-010-0023) in the model tree and select **Delete**.

7. Once the blade is removed, select **File > Check-in > Custom Check-in** to update the design changes in the product.
   a. Select **CAD Model** and **CAD Viewable** in the **Custom Check-in** window, and click **OK**. Click **OK** in the **Check-in** window.
   b. The updated AL-Bulldozer assembly has now been checked into the Bulldozer Blade Removal project.

Now that the project team’s design changes are complete, the changes are ready for submission to the PDM system.

8. Exit Pro/ENGINEER Wildfire and return to Windchill. Navigate to the Bulldozer Blade Removal project.

9. Select the AL-Bulldozer assembly (AL-PDM-001-0001.asm) and then select the **Send to PDM** action from the **Actions** list.

10. Accept the default settings in the check-in user interface and click the **OK** button to check the assembly back into the PDM system.

11. Navigate to your home page in order to mark the Bulldozer Blade Removal task as complete.
   a. Select the Complete ECN task in your **Assignments** table and click the link to the ECN to open it.
   b. From the drop-down menu on the ECN page, select **Update**. Within the **Update** window, select the **Implementation Plan** tab and expand the Remove Blade task. Select **Add Resulting Items** to search for the AL-Bulldozer part (AL-PDM-001-0001.asm) to add as the resulting item. Click **OK** to complete the operation.

   **Tip:** This step identifies the objects resulting from AL-Bulldozer product design activities; later, all object modifications and new objects resulting from this effort will be published to your ERP system.

12. Navigate to the home page and select the Complete ECN task for the modification of the bucket. Click **Task Complete**.

You have now completed the submission of the Blade Removal and have marked the ECN task as complete.

**Task 6. Reviewing Changes and Publishing Updates to the ERP System**

This task can only be completed if Windchill ESI has been installed and configured with an ERP system.

To complete this scenario, assume that you are again acting in the role of Engineering Manager and that your final tasks are as follows:
• Review all modifications made to the AL-Bulldozer design
• Review all new objects
• Assign distribution targets to the new objects
• Publish all changes to your ERP system

The following is a specific example of how you might complete these tasks. While this scenario assumes that all change activities have been completed satisfactorily, the change management capabilities and workflows in Windchill allow you to reroute objects that require additional changes.

Step 1. Reviewing the New Assembly

The following is a specific example of the steps involved in reviewing the work done to satisfy the ECN described in previous sections:

1. Log on as Engineering Manager and search for AL-PDM-100-0001.asm.
   Click the (information) icon next to the assembly in the search results to access its details page.

2. On the AL-Bulldozer details page, click on the thumbnail icon to open Windchill ProductView. Review the modifications.

3. From the Assignments table on your Home tab, select Task Complete for each of the Review ECN tasks related to bulldozer modification.

Step 2. Assigning Distribution Targets and Publishing to Your ERP System

The following is a specific example of how the completed design can be published to the ERP system:

1. From the Product tab, select the AL-Bulldozer product and then click the Product Structure link.

2. Within the Product Structure table, select all parts and then select Expand All from the Actions drop-down menu. Select AL-PDM-100-0001.asm, AL-PDM-100-0003, AL-PDM-100-0005, AL-PDM-100-0006, AL-PDM-100-0007, and AL-PDM-010-0007 to be published to the ERP system. Click the Update Distribution Targets icon.

3. Select Add to add existing distribution targets to the list, enter an asterisk (*) in the Name field, and click Search. From the search results table, select a distribution target (Berlin in this example). Click OK in the Update Distribution Targets window to complete the definition of the ERP instance to which the parts should be published.

4. The CMII change process requires that the Change Administrator III review and audit the ECN. Assuming that you are also acting as Change Administrator III, return to the home page, select the Review ECN task, and,
after completing your review, click **Complete Task**. Complete the same process for the Audit ECN task. This completes and releases the ECN.

Release of the ECN automatically releases all resulting objects and triggers publication to the ERP system.

5. If you have Site Administrator privileges or are logged in as wcadmin, you can go to **Site > Utilities > Enterprise Systems Activity Log** to see the publication transaction history. Alternatively, you can go to the details page for any of the released parts and click **Distribution Targets** to see that the part has been published.
If your site has installed Windchill Foundation & PDM or Windchill PDMLink and Windchill ProjectLink on a single server, you are able to share and exchange information between your PDM system and a project. As a result, you can more easily collaborate with others, both within and outside of your department or your company.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>12-2</td>
</tr>
<tr>
<td>Making PDM Data Available to Your Project Team</td>
<td>12-3</td>
</tr>
<tr>
<td>Examining a Usage Scenario</td>
<td>12-11</td>
</tr>
</tbody>
</table>
Overview

When you are working with integrated Windchill solutions, you can take advantage of common project and program management activities, such as the following:

- You can share data from your PDM system to a project within Windchill ProjectLink. As a result, you can collaborate on the information within the context of a project, where your team’s work can be managed through the use of milestones, deliverables, and resource tracking.

- You can copy or check out design information from the PDM system to a project so that you and others can investigate design possibilities without committing your changes to formal PDM control. If you decide to make your new design or design changes part of your formal change process, you can check parts, documents, and CAD documents back into the PDM system and, if desired, use Windchill ESI to publish them to your ERP system.

- You can invite external participants to join your project, as project team members, without giving them access to your company’s PDM system. For example, if you are collaborating on a new product design, you could invite an engineer from a supplier’s company to participate in collaborative design work to be applied to PDM objects checked out to a project, without giving that engineer access to other PDM data or to your PDM system.

This chapter consists of an extended scenario that illustrates the way in which you and others on your team can use multiple Windchill solutions to make modifications to an existing product. The scenario includes a number of common product development tasks performed by users in a variety of roles. For purposes of demonstration, this extended example assumes that you are the team member assigned to each role and task that is part of the scenario.

Of course, your product data and teams may be significantly more complex than those used in this example, but the principles demonstrated can also be applied to products and projects of greater scope and complexity.

In this scenario, your product team has been asked to create a new product (AL-Bulldozer) from an existing Bulldozer design. The scenario is organized around six tasks:

- **Task 1** - The Engineering Manager creates the new Bulldozer product from the existing Bulldozer design. At the same time, the manager creates the Enterprise Change Request (ECR) and the Enterprise Change Notice (ECN) for the necessary design changes, and assigns the specific activities that must be performed in order to complete the design modifications.

  This task highlights the Save As capabilities and the CMII change process available in Windchill.

- **Task 2** - Engineer1 creates a project to coordinate the activities associated with the removal of the bulldozer blade.
This task illustrates how you or another member of your team can use Windchill ProjectLink to create a collaborative environment for design changes that involve multiple users or organizations.

- **Task 3** – A Supplier is given access to information contained within the project in order to make design modifications to the bulldozer bucket.

  As shown through this task, your suppliers and customers can be granted access to select information controlled by your PDM system, without being granted direct access to the PDM system itself.

- **Task 4** - Engineer2 modifies the Bulldozer design in Windchill PDM, based on the ECN assignment. In this scenario, the ECN calls for modification of the bulldozer toolbox and seat.

  This task demonstrates the CMII change process from an end-user perspective.

- **Task 5** - Engineer1 updates the Bulldozer design in the project and completes the removal of the bulldozer blade.

  This task shows how, as a member of a collaborative project, you are kept aware of relevant design activities occurring outside of your project. When desired, you can update the information you are referencing to include the latest design changes.

- **Task 6** - The Engineering Manager approves all of the design changes at the completion of the design process. As a result, the updated information is automatically published to an ERP system.

  This task demonstrates how design work that you and your team complete in an independent, collaborative environment can be incorporated into your company’s formal design process. It also highlights the way in which Windchill ESI allows Windchill solutions to interoperate seamlessly with ERP systems.

### Making PDM Data Available to Your Project Team

When your site has installed multiple Windchill solutions on a server, you can use Windchill’s clipboard mechanism to share or check out data from a product, library, cabinet, or folder in your PDM system to a project (or from one project to another).

A simple way to move an object is to apply the **Cut**, **Copy**, and **Paste** actions. Both **Cut** and **Copy** move selected objects to the Windchill clipboard; the **Paste** operation determines whether the object will be duplicated, moved, shared, or checked out, based on the icon you select.

For example, within a product, library, project, cabinet, or folder, you can **Cut** one or more selected objects. The **Cut** operation moves an object from its current location to the clipboard. In order to complete the move, you can then **Paste** the object to a selected folder location.
Within a product, library, project, cabinet, or folder you can also use the **Copy** and **Paste** icons to create a new copy of a selected object and either paste a copy of the original item to the selected location or, as described in the following section, paste the object as a shared item:

**Tip:** Within Windchill Foundation & PDM, objects can be copied or shared to a project using the **Copy to Clipboard** or **Add to Project** actions in the search results table or details page of an object. The **Cut/Copy/Paste** operation in the Windchill Explorer can be used to create shortcuts to objects within Windchill Foundation & PDM.
Sharing PDM Objects to a Project

The **Copy/Paste** icons and the **Add to Project** action can also be used to share or check out an object from a product, library, cabinet, or folder to a project, or to create a new copy of a document or part stored in your PDM system and locate that document or part within a project:

When you *share* a part, document, or CAD document to a project, all project members have implicit read access. The primary use for a share operation is to provide a project team with read access to selected PDM objects, for purposes of reference. You can also use the Windchill clipboard to initiate sharing of other information, including problem reports, change requests, change notices, product configurations, product instances, and baselines, but these shared objects are accessible only to project team members who have read access to the object in its source location.

**Tip:** Sharing a PDM object version to a project is essentially the same as creating a shortcut to the object within the project. The object continues to reside within the PDM system, but project members can easily view it without having access to your PDM system.

A PDM object can be shared to several projects at the same time. While an object is being shared, it is still subject to modification in the PDM system. As described in [Refreshing a Project](#), you can choose at any time to update your project with the latest iterations of each shared object.
Sharing is especially useful when you do not want to add members of other projects or products to the team in which a document or part was created. For example, you may want to share a design specification document or part prototype design with a manufacturing line team, within the context of a collaborative project, without adding the manufacturing members to the product team. In effect, sharing allows project members to access only the subset of PDM objects required to complete the work assigned to the project team.

From among the list of operations you can perform within a project, the following can be applied to an object you have shared to the project:

- **Details** – View the information page for the selected object. For a PDM object shared to a project, the details page for the object will be displayed from within the PDM system.
- **View** – For documents, view the document content file.
- **Subscribe** – Request e-mail notification when certain events or actions are applied to the selected object.
- **Discuss** – Open the **Discussion** page to discuss topics related to the object.
- **Add to Notebook** – Add a link to this object in your Notebook.
- **Convert to PDM Checkout** – For one or more parts, documents, or CAD documents that have been shared to a project, check out the shared objects from the PDM database to the project. As shown in the following illustration, the details page for a shared object that has been converted to a checked-out object indicates that the item is checked out from the PDM system to the project.
This action cannot be applied to objects that are shared from one project to another, or to problem reports, change requests, change notices, product configurations, product instances, and baselines that have been shared from your PDM system. Your role and your access permissions also determine whether or not this action is available to you; for example, you cannot use the Convert to PDM Checkout action on an object to which you do not have update access in the PDM system.

**Tip:** When you convert a shared object to a checked-out object, the latest iteration of the object is checked out to the project. In some cases, this may not be the iteration that was originally shared.

- **Remove Share** – Remove the shared object from the project.

**Refreshing a Project**

Sometimes, a PDM object may be updated within the PDM system after you have shared it to your project. You can use the Refresh Project icon to display a list of the latest iterations for all shared objects within a project. You can then select the objects to be updated through a download of their most current iterations.

**Tip:** Only the project manager is allowed to refresh a project.

When you refresh a project, the new iteration for a given object may have children that were not part of the iteration originally shared. Therefore, the Refresh
**Project** window includes filtering options that allow you to control the content of the table that displays the refresh candidates. When you are refreshing a project that includes a large number of PDM objects, you can either select all of the objects to be refreshed and click the **Set Refresh** icon, or select only the objects that are not to be refreshed and then click the **Set Exclude** icon:

![Refresh Project Window](image)

**Tip:** When an object is shared, the share link always points to the latest iteration of the object version in the PDM system. Your project, however, tracks the iteration that was initially shared or was downloaded as the result of a **Refresh Project** operation. For example, even if a share link points to object A.2 (the second, and latest, iteration of version A of the object), the project will track object A.1, if iteration 1 of version A was the object originally shared or most recently downloaded.

**Checking Out PDM Objects to a Project**

When you use the **Copy/Paste** icons or the **Add to Project** action to copy or share a PDM object to a project, you first select the new location for the object. The following illustration shows how project location is specified when you select the **Add to Project** action:
Next, you choose whether to share the object or check it out to the project; in this example, the Selected Action is Share.
As previously described, sharing an object provides project team members with read-only access to the original object. When you check out one or more parts, documents, or CAD documents from your PDM system to a project (or convert a shared object to a checked-out object), project-specific versions of those objects are created within your project. These project-specific versions can be modified by project team members, and the objects are locked in the PDM system to avoid concurrent modification and prevent synchronization problems.

You can also use the Copy/Paste or Add to Project functionality to create new parts and documents, with unique name and number attributes, within a project:

![Add Items to a Project window](image)

When the copy is later checked in, it does not affect the original part or document. However, when a checked-out part, document, or CAD document is checked in, the check-in operation creates a new iteration of the original object.

Your project team can work with PDM objects checked out to the project as follows:

- Modify existing parts, documents, and CAD documents
- Create new parts, documents, and CAD documents
- Edit and change structures during the project design collaboration
- Reconcile all or a subset of the changes with the source PDM system by using the Send to PDM action.
**Note:** CAD documents can be easily viewed and modified in a workspace you create within the context of a project. However, CAD documents that have been published by the Pro/INTRALINK Gateway cannot be checked out to a project.

Modifications to objects checked out from your PDM system are only visible to project team members, within the context of the project.

**Using Actions and Icons**

When you share or check out PDM objects to a project, the actions and icons available to you, as well as the results of the actions you apply, are based on the following object characteristics:

- The results of an action are determined by the type of the object you have selected. For example, when you create an object, the list of templates you can use for object creation is different for parts than for documents. Similarly, a change object can be shared to a project, but it cannot be checked out to a project, nor can a share relationship to a change object be converted to a PDM checkout.

- Actions differ based on whether an object is native to the current context, has been checked out to the current context, or has been shared. For example, if you are working in a project and you apply the Delete action to a part created within that project (a native object), the part is removed from the project. If you delete a part shared to the project from your PDM system, the action simply removes the share. If you apply a Delete action to a part checked out to the project from your PDM system, the action un-does the checkout and removes the object from the project. When you are working in the PDM system and apply Delete to a selected object, that iteration is removed from the PDM database.

- The actions and icons available to you when you have selected a specific object are determined by your access permissions to that object. For example, you must have read access to a PDM object in its source location in order to view it from within a project. Similarly, you must have update access to a PDM object within the PDM system in order to check it out to a project or to convert it to a checked-out object when it has been shared.

You can also configure product and project spaces so that objects cannot be shared outside of that space. In this way, you can determine how broadly to share information by removing share privileges on all or selected objects, as appropriate.

**Examining a Usage Scenario**

The following scenario demonstrates how you might accomplish a number of product development activities necessary to complete a new product design (AL-Bulldozer), using Windchill design collaboration capabilities. As noted above, for ease of demonstration these examples assume that you are assigned each of the roles and are completing each of the tasks described.
Setting Up Your Environment for This Scenario

If desired, you can install the Pro/ENGINEER Wildfire assemblies and other product data described in this chapter and execute the described procedures on your system.

The data files and specific setup instructions are located in the Windchill\loadFiles\BullDozerDemoData directory. You should also consult the Read This First document for any additional installation instructions.

Task 1. Creating a Product From an Existing Product

For purposes of this scenario task, assume that you have been assigned the Engineering Manager role on your product team, and that your team will create a new Bulldozer design from an existing Bulldozer design, reusing existing data in order to reduce costs. After the new design has been created, you will assign the tasks necessary for modification of the Bulldozer.

Step 1. Creating a New Work Environment and Making Work Assignments

Within Windchill Foundation & PDM, there are numerous approaches that can be used for organizing and managing information. For purposes of simplicity within this example, you will create a subfolder in the Bulldozer cabinet for storing all of the new design information.

First, you must log on to Windchill, using the user ID and password associated with the Engineering Manager role. Whether or not this is your actual job title, it is the role to which you have been assigned on the product team. When you log on, Windchill recognizes your association with the Engineering Manager role, and grants you the access permissions associated with that role.

Tip: Whenever you log on, Windchill opens to the home page of the last role you set before exiting the system. If your home page is not set to the Product Design role, use the Option link to navigate to the role selection page and select the Product Design role. As a result, Windchill sets this as your default role, and the system opens to the Product Design home page.

Complete the following steps to create the subfolder in which new design information will be stored:

6. Select the Windchill Explorer menu to open the Windchill Explorer folder browser.
7. Select the Bulldozer cabinet and the File > New > Folder menu to create the location where all new objects associated with the bulldozer design modification are to be stored.
8. Within the Create Folder window, specify a new folder name (for example, AL- Bulldozer), ensure that the location is set to /Bulldozer, and then click OK.
You have now created a folder that will hold all of the information related to your new Bulldozer design.

**Step 2. Creating an Assembly From an Existing Assembly**

After the new folder has been created, you can copy the parts and associated CAD documents to be modified for the new design from the original Bulldozer-1 folder. As a result, the AL-Bulldozer folder will contain only the parts and assemblies that are actually being modified and will reference the remainder of the design from the original Bulldozer-1 folder.

In a number of cases, the easiest way to create a design from an existing one is to use the Save As capabilities in Windchill. The following steps demonstrate how this is done:

1. Within the Windchill Explorer, navigate to the Bulldozers>Bulldozer-1 folder.

2. Select the Bulldozer CAD document assembly (PDM-100-0001.asm) to view the properties of the selected object.

3. On the details page for CAD document PDM-100-0001.asm, select the **Save As** action from the drop-down menu, and click **Go**. You can then use the **Save As** window to identify the parts within the assembly structure that are to be copied to the new AL-Bulldozer product.

   **Tip:** Selecting the **Save As** action from the CAD document details page allows you to copy an entire or partial CAD document structure and its associated parts to a new structure, with new names and numbers. With a **Copy/Paste** operation, you can copy individual parts and documents, assigning them new names and numbers.

4. The first step in the Save As process itself is to identify the dependent information to be included in the Save As operation. In this way, you ensure that all existing part and document relationships are maintained. For purposes of this scenario, you would make the following selections from the **Rules** section of the **Save As** window:
– **Configuration Specification = Latest.** When you set the **Configuration Specification** field to **Latest**, you indicate that you want to use the latest available configuration of the assembly. You can use other Configuration Specification settings to select previously stored baselines or checked-in configurations.

– **Dependency Type Processing = CAD Document Centric.** This field indicates whether the CAD document or the part structure is to be used for determining the configuration. By selecting **CAD Document Centric**, you specify that the CAD document structure is to be used for this purpose.

– **Baseline For Docs, Baseline for Parts.** These fields identify the baseline name that should be used if the **Configuration Specification** field is set to **Baseline**.

– **Include Dependents = Required.** This field is used to identify the dependent objects that are to be included in the configuration. When you select **Required**, only the objects necessary to regenerate the assembly are included. The **All** option includes every object that has a relationship to the assembly. The **None** option includes only the assembly itself.

– **Include Parts = All.** When you set this field to **All**, you include all Windchill parts to which the CAD documents are associated. The **Selected** option includes only the parts for objects selected in the table. If you specify **None**, no Windchill parts are included.

– **Include Drawings = None.** This field allows you to indicate whether the CAD drawings associated with the assembly and its dependents should be included in the configuration. In this example, the **None** option indicates that no CAD drawings are to be included.

– **Include Instances = All.** This field allows you to specify whether or not Pro/ENGINEER family table instances should be included in the configuration.

After these fields have been set, click **Refresh Object List** to update the **Object List** table.
5. The second step of the Save As process is to identify the parts and CAD documents to be modified and reused in the new design.

**Tip:** When your team needs to modify only a small portion of an existing configuration, as in this example, it is easiest to first mark all the parts and CAD documents as reused, and then rename only the objects to be modified and copied to the new design.

To perform this task, select the **All** check box in the table (if all objects are not currently selected). After you select **All**, a checkmark appears in the check box for each object. Next, select the **Reuse** action at the top of the table.

Now, you can select the items to be copied to the new design from the table:

- The Bulldozer assembly (in this example, PDM-100-0001.asm) and the part associated to it.
- The Frame assembly to which the toolbox belongs (in this example, PDM-100-0003.asm) and the part associated to it.
- The Bucket (in this example, PDM-010-0007.prt) and the part associated to it.
- The assemblies to which the bucket belongs (in this example, PDM-100-0005.asm, PDM-100-0006.asm, and PDM-100-0007.asm) and the parts associated to them.

6. Next, select the **Naming Options** action at the top of the table. Deselect the **Auto Number** and **Save as Number** fields if they are already selected. For
purposes of this example, set the following values in the **Save As Options** table:

- **Number** – From * To <prefix>- *
- **Name** – From * To <prefix>-*
- **File Name** – From * To <prefix>- *

To complete the renaming of the objects to be copied and modified, click **OK** and verify that the **Number**, **Name**, and **File Name** values for the items have been updated.

**Tip:** The **Number** and **File Name** values must be unique and, therefore, you must change them for newly created objects. There is no uniqueness constraint on **Name**, so changing it is optional.

7. In the **Save As** window, reselect the items you selected in Step 5 and then select the **Location** action. For this example, you would select the Windchill PDM context and the Bulldozer>AL-Bulldozer subfolder as the location for the Save As operation. Click **OK** and verify that the new location of the items is the desired folder (in this case, Bulldozer>AL-Bulldozer).

8. Click **OK** at the bottom of the **Object List** table. The objects involved in the Save As process are then copied to the new folder, with their new names and numbers.

**Step 3. Creating Work Assignments for Product Modifications**

As the Engineering Manager for this task, you must next create an Enterprise Change Request (ECR) and an associated Enterprise Change Notice (ECN) for the modifications to be applied to the new design. For purposes of this example, you
will use the Windchill CMII closed-looped process to manage the change process. The following illustrations show the workflow for this process.

To minimize the number of users necessary to complete the change process, assume that, as the user assigned the Engineering Manager role, you have also been assigned the Change Administrator I, Change Administrator II, and Change Administrator III roles. Consequently, the following example illustrates execution of the CMII fast track change process without including separate logins for multiple user IDs.

1. From the home page for the Product Design role, select the Change Manager menu.
2. On the **Change Manager** page, select the **Create ECR** action.

3. Fill in the ECR form with the following information. Fields beginning with an asterisk (*) are required values:

   a. Select the ECR Team as the **Team**.

   b. Assign an **ECR name** (in this example, Change to New Bulldozer).

   c. Select an **ECR classification** (in this example, Cost Reduction).

   d. Provide an **ECR description**.

   e. Assign a **Priority level**.

   f. Go to the **Affected Data** tab to add the AL-Bulldozer assembly.

      i. Select the **Add Affected Data** action.

      ii. Select **CAD Documents** from the drop-down menu on the search page.

      iii. For purposes of this example, search for items with the name AL-PDM*.

      iv. Select the top-level AL-Bulldozer assembly (AL-PDM-100-0001.asm) from the search results.
g. Return to the **Description** tab, select **Now** for the **Submit** value, and click **OK**.

For purposes of this scenario, assume that you have also been assigned the change administrator role for each phase of the CMII change process. To complete the first step of the change process, the ECR change administrator must analyze the request and determine what action should be taken:

1. To analyze and define the ECR activity, navigate to the **Home** tab and click the **Worklist** icon. Select the **Analyze ECR** item with a **Subject** that matches the name you assigned to the ECR.

2. On the **Analyze ECR** page, review the ECR and select **Fast Track** as the action to be taken. Click **Task Complete**.

The ECR analysis task is now complete, and the ECR has been routed to Change Administrator II (CAII) for the creation of the ECN. For purposes of this scenario, assume that you have been assigned the CAII role as well, and that you will create the ECN, as follows.

1. To view the Create ECN task, navigate to the home page and click the **Worklist** icon. Select the Create ECN task with a **Subject** that has the same name as the ECR.

   2. Follow the instructions on the **Create ECN** page to complete the task:
      
      a. Select the URL to navigate to the ECR.

      b. Select **Create ECN** from the drop-down menu on the ECR details page.
c. Enter a **Team** (ECN Team), **Name**, **Description**, and **Due Date** on the ECN form.

3. Assign the three tasks that must be performed to complete the ECN.

   - **Task 1: Removal of the Blade by Engineer 1**
     
     i. Go to the **Implementation Plan** tab and select **Add New Task**.
     
     ii. Add the **Task Name** (Remove Blade).
     
     iii. Add a description, such as the following:

     "Create a project, and send the AL-Bulldozer to the project; only the AL-Bulldozer should be modifiable. Within the project, remove the Blade and send the AL-Bulldozer back to the PDM system. Don’t forget to refresh your project before proceeding with the modification."

     iv. Assign Engineer1 (eng1) as the Author of the task.

     v. Assign the Engineering Manager (mgr) as the Designated User (Reviewer) of the task, and click **ADD** to complete the creation of the task.

     vi. Expand the Remove Blade task to display its details.

     vii. Select **Add Affected Data** to associate the bulldozer assembly. Search for CAD documents with the name AL-Bulldozer or the number AL-PDM-100-0001. Select the assembly from the search results and click **Add Select Items**.

     The first ECN task is now defined for Engineer1.

   - **Task 2: Modification of the bucket by the Supplier**

     For purposes of this scenario, the user assigned to the Engineering Manager role is to be assigned the task of coordinating activities with the supplier. To create this coordination task, you would begin by selecting **Add New Task** from the **Implementation Plan** tab.

     i. Specify the task name (Request Supplier Design Update of Bucket).

     ii. Add a description such as the following:

     "Create a project, invite the Supplier, and send the Lower Arm assembly to the project. Only the AL-Bucket should be modifiable. Within the project, create an action item for the supplier."

     iii. Assign the Engineering Manager (mgr) as the Author of the task.

     iv. Assign the Engineering Manager as the Designated User (Reviewer) of the task and click **ADD** to complete the task creation.
v. Expand the Request Supplier Design Update of Bucket task to display its details.

vi. Select **Add Affected Data** to associate the bucket assemblies (AL-PDM-100-0007.asm, AL-PDM-100-0006.asm, AL-PDM-100-0005.asm, and AL-PDM-010-0007.prt), and click **Add Select Items**.

The second ECN task is now defined for the Engineering Manager.

- Task 3: Modification of the toolbox and seat cushion by Engineer2.
  
i. Select **Add New Task** from the **Implementation Plan** tab to create the task.
  
ii. Specify the task name (in this example, Modify Toolbox and Add Seat Cushion).

iii. Add a description such as the following:

   "In bulldozer assembly AL-PDM-100-0003.asm, interchange the existing toolbox (PDM-030-0001.prt with PDM-030-0002.prt), add the seat cushion (PDM-010-0024.prt), and check it in to the product."

iv. Assign Engineer2 (eng2) as the Author of the task.

v. Assign the Engineering Manager (mgr) as the Designated User (Reviewer) of the task and click **ADD** to complete the task creation.

vi. Expand the Modify Toolbox and Add Seat Cushion task to display its details.

vii. Select **Add Affected Data** to associate AL-PDM-100-0003.asm and the text file, and click **Add Select Items**.
The third ECN task is now defined for Engineer2.

4. Return to the Description tab, select Now in the Submit field, and click OK to complete the definition of the ECN.

5. Navigate to your home page and click the Worklist icon. Select the Create ECN task and click Task Complete. The ECN and associated tasks have now been created and distributed to the task Authors.

Task 2. Creating and Working in a Collaborative Project

This task demonstrates the use of a Windchill ProjectLink project to manage a large design change that involves participants from multiple organizations. In this example, assume that you have been assigned the role of Engineer1, who has the following tasks:

- Update the AL-Bulldozer design by removing the bulldozer blade.
- Invite other participants to the project in order to address aspects of the bulldozer design that will be affected by the blade removal.

The following are specific steps for completion of this scenario task:

1. Log on as Engineer1 and navigate to the Product Design home page. Click the Worklist icon and review your tasks.
2. From your assignment list, select the Complete ECN task for the removal of the bulldozer blade.

3. Select the related link on the **Complete ECN Task** form to display the ECN form.

4. Expand the Remove Blade task in the task list to review the details.

5. To create a collaborative project, navigate to your home page and click the **ProjectLink** icon. In Windchill ProjectLink, select the **Project** tab and select the **Create Project** action at the top of the table. Create a project named Bulldozer Blade Removal.
   a. Click **Next** to add members to the project (optional).
   b. Click **Next** to add a description of the project that will be sent to the new members.
   c. Click **Next** to define the project details. Enter a number for the project and select **Activities**, then click **OK** to create the project.

You have now created the collaborative project to be used for removing the bulldozer blade and updating the associated bulldozer systems, including the hydraulics and controls. The following, specific steps demonstrate how you can add product data to the project. In this case, certain parts of the design are to be updated by the project members, while other objects are provided only for reference.

1. From within Windchill ProjectLink, use the multi-context search capability (the search field located in the blue title bar) to search for the AL-Bulldozer CAD document (AL-PDM-001-0001.asm).

   **Tip:** There are two levels of searching available in Windchill. In the lower right corner of the global page header, you can click the **Search** link to initiate a search of the entire Windchill system (that is, you can search across solutions). In addition, various Windchill pages include a search capability that allows you to search within the specific context of the page. In this step you are using the search mechanism that allows you to search both Windchill PDM and Windchill ProjectLink to find the AL-Bulldozer assembly.

2. Select the AL-Bulldozer CAD document from the search results and then click the **Add to Project** icon at the top of the search results table.

   Adding a product, part, or CAD document to a project is a two-step process. The first step requires choosing the project and project location to which the objects will be added. In the second step, you must identify which objects are to be added to the project, as well as the actions that can be applied to each of them.

3. As a first step, select the project and project location to which the objects from your PDM system will be added:
a. Search for the project you created (Bulldozer Blade Removal) by clicking **Select** next to the **Project Name** field. Windchill displays the **Select Project** window, from which you can search for existing projects. For purposes of this example, you would select the Bulldozer Blade Removal project and then click **OK** to complete the selection.

b. You can select a target folder by clicking **Select** next to the **Location** field. In the **Select Folder** window, select **Default** and then click **Open** to display the available folders. Click **OK** to complete the operation.

c. Click **Next** to proceed to the next step.

4. The second step in adding a product, part, or CAD document to a project requires that you identify the specific dependent objects to be added to the project, as well as the actions that can be applied to each. The **Paste** dependency definition form allows you to identify the necessary objects and dependencies:

   ![Paste dependency definition form](image)

   - **Configuration Specification** = **Latest**. This setting indicates that you want to use the latest available configuration of the assembly. You can use other **Configuration Specification** settings to select previously stored baselines or checked-in configurations.

   - **View** = **<blank>**. The setting you specify for this field identifies a configuration view, such as as-designed or as-planned, that should be used for the configuration specification.
– **Dependency Processing Type = CAD Document Centric.** This field indicates whether the CAD document or the part structure is to be used for determining the configuration. By selecting **CAD Document Centric**, you specify that the CAD document structure is to be used for this purpose.

– **Include Parts/CAD Docs = None.** The setting for this field indicates whether or not you want to include the Windchill parts to which the CAD documents are associated. The **Selected** option includes only the parts for objects selected in the table, while the **All** option includes every Windchill part associated with a CAD document. If you specify **None**, no Windchill parts are included.

– **Include Instances = None.** The setting for this field indicates whether or not Pro/ENGINEER family table instances should be included in the configuration. In this case, **None** specifies that the family table instances are not to be included.

– **Include Dependents = Required.** This field is used to identify the dependent objects to be included in the configuration. **Required** includes only the objects necessary to regenerate the assembly, while the **All** option includes every object that has a relationship to the assembly. The **None** option includes only the assembly.

– **Include Drawings = None.** The setting for this field indicates whether or not the CAD drawings associated with the assembly and its dependents should be included in the configuration.

– **Include Documents = None.** The setting for this field determines whether or not documents referenced by the assembly and its dependents should be included in the configuration.

After these options have been set, click **Refresh Item List** to update the table.

5. From the object list, select the AL-Bulldozer assembly (AL-PDM100-0001.asm) and then select the **Set PDM Check Out** action at the top of the table. The selected action for the AL-Bulldozer assembly is now set to Check Out, while the selected actions for all other objects are set to Share. As a result, only the AL-Bulldozer assembly will be checked out to the project and can be modified within that context. All other associated objects will have read-only status within the project.

6. Click **OK** to complete checkout and sharing of objects to the project.

After you have completed these steps, you are returned to the search results page. When you next navigate to the Bulldozer Blade Removal project on the **Project** tab, you will notice that the AL-Bulldozer assembly has been checked out to the project, while the remaining bulldozer parts have been shared to the project. These shared objects are provided for read-only reference, and act as links to the objects stored in your PDM environment. As noted above, only objects that have been checked out can be modified within the project. In this way, you can
effectively manage access to your PDM data, while allowing for efficient
collaboration.

Now that the information necessary to remove the blade from the bulldozer has
been added to the project, you can optionally invite other project members and
assign the project tasks required to complete the design work.

Task 3. Collaborating with an External Supplier

This scenario task demonstrates how you can use a Windchill ProjectLink project
to invite external users, such as suppliers or customers, into the design process,
without providing them direct access to your PDM environment. For purposes of
this task, assume that, acting as Engineering Manager, you must set up a project
for your supplier to use in order to modify the bucket of the AL-Bulldozer design
to your specifications. After the supplier makes the necessary design changes,
you will check the design changes into the PDM system and mark the ECN task as
complete.

Step 1. Creating a Project and Tasks for an External Supplier

The following steps provide a specific example of the activities required to create
a new project for collaboration with an external vendor and assign that vendor
specific tasks necessary to complete the design changes.

1. Log on as the Engineering Manager.
2. From your home page, click the Worklist icon and the Complete ECN task
   for the supplier bucket update.
3. Select the appropriate link on the Complete ECN Task form to display the
   ECN form.
4. Expand the Supplier Design Update of Bucket task in the list to review the
details.
5. To create a collaborative project, navigate to your home page and click the
   ProjectLink icon. Within Windchill ProjectLink, select the Project tab and
   then select the Create Project action at the top of the table. Create a project
   named Bucket Update.
   a. Click Next to add members to the project. Add user Supplier as a project
      member.
   b. Click Next to add a description of the project that will be sent to the new
      members.
   c. Click Next to define the project details. Enter a number for the project
      and select Activities, then click OK to create the project.
   d. Within Windchill ProjectLink, select the Home tab and review the tasks
      in the Assignment table. Select the Complete ECN task for the
      modification of the bucket from the Assignment list.
**Tip:** In an integrated Windchill PDM and Windchill ProjectLink environment, assigned tasks are accessible in both solutions. In this example the ECN task was assigned within Windchill PDM and is accessed directly from within Windchill ProjectLink.

6. Click the **ECN Task** link on the **Complete ECN Task** form to display the ECN form.

7. Expand the Modification of Bucket item in the task list to review the details.

8. Click the (information) icon next to the AL-Bucket part listed in the task to navigate to the AL-Bucket details page.

9. Because the supplier will need the Lower Arm assembly for reference purposes, you can select the **Used By** link on the details page to display all of the assemblies in which AL-Bucket is used.

   Select the Lower Arm assembly in the **Used By** table to navigate to the details of the assembly.

10. Next, select **Copy** from the **Actions** drop-down menu on the details page for the Lower Arm assembly, in order to share this object to the project.

11. Next, you must specify the project and project location to which the checked-out and shared objects will be added. Navigate to your home page from the ECN, click the **Projectlink** icon, select the **Project** tab, and then select the desired project (Bucket Update). Click the **Paste** icon located on the top of the folder table.

12. As previously described, adding a product to a project requires that you identify the specific objects to be added to the project, as well as the actions that can be applied to each. The **Paste** dependency definition form allows you to identify the necessary objects and dependencies. In this example, you make the following selections for the dependency criteria:

   - **Configuration Specification = Latest.** This setting indicates that you want to use the latest available configuration of the assembly. You can use other **Configuration Specification** settings to select previously stored baselines or checked-in configurations.

   - **View = <blank>.** The setting you specify for this field identifies a configuration view, such as as-designed or as-planned, that should be used for the configuration specification.

   - **Dependency Processing Type = CAD Document Centric.** This field indicates whether the CAD document or the part structure is to be used for determining the configuration. By selecting **CAD Document Centric,** you specify that the CAD document structure is to be used for this purpose.

   - **Include Parts/CAD Docs = None.** The setting for this field indicates whether or not you want to include the Windchill parts to which the CAD
documents are associated. The **Selected** option includes only the parts for objects selected in the table, while the **All** option includes every Windchill part associated with a CAD document. If you specify **None**, no Windchill parts are included.

- **Include Instances = None.** The setting for this field indicates whether or not Pro/ENGINEER family table instances should be included in the configuration. In this case, **None** specifies that the family table instances are not to be included.

- **Include Dependents = Required.** This field is used to identify the dependent objects to be included in the configuration. **Required** includes only the objects necessary to regenerate the assembly, while the **All** option includes every object that has a relationship to the assembly. The **None** option includes only the assembly.

- **Include Drawings = None.** The setting for this field indicates whether or not the CAD drawings associated with the assembly and its dependents should be included in the configuration.

- **Include Documents = None.** The setting for this field determines whether or not documents referenced by the assembly and its dependents should be included in the configuration.

After these options have been set, click **Refresh Item List** to update the object list.

13. From the object list, select the AL-Bucket part, AL-PDM-010-0007.prt, and then click the **Set Check Out** icon at the top of the file list table. The selected action for the AL-Bucket part is now set to Check Out, while the selected actions for all other objects are set to Share. As a result, only the AL-Bucket part will be checked out to the project and can be modified within that context. All other associated objects will have read-only status within the project.

Click **OK** to complete the check-out and sharing of objects to the project.

When you next navigate to the Bucket Update project in Windchill ProjectLink, you will notice that the AL-Bucket part has been checked out to the project, while the remaining objects have been shared to the project. These shared objects are provided for read-only reference, and act as links to the objects stored in your PDM environment.

14. Within the project, select **Assignments** from the project menu list and click the **Create Action Item** icon in the **Assignments** table.

15. Enter Update Bucket Design as the name, select Supplier as the owner, and enter a description of the assignment (for example, “Update bucket design per markup or specifications.”).

16. Click **OK** to complete the task assignment.
You have now created the project in which the Supplier will make the required design modifications and have assigned the task that the Supplier must complete.

Step 2. The Supplier Makes Design Modifications Within the Project

This section provides a specific example of the activities an external supplier might complete in order to collaborate with you and your product team on a particular aspect of your design project.

**Tip:** By default, the integrated Windchill PDM and Windchill ProjectLink system will open to the Windchill PDM home page. When you want an external user, such as Supplier, to go directly to the Windchill ProjectLink environment, you can provide a URL for direct access to the Windchill ProjectLink home page. Even if external users later navigate to the Windchill PDM environment, they will not be allowed to access information unless specific authorization has been granted.

For purposes of this scenario, the Supplier will complete the following steps:

1. Log on to the system as the Supplier.

2. Click the **ProjectLink** icon to navigate to the Windchill ProjectLink home page. Select the Update Bucket Design task from the **Assignments** table in order to view the details of the task.

   **Tip:** Typically a supplier would be provided with a markup and set of instructions for the required modifications. In this scenario, the Supplier simply reviews the text of the assigned task.

3. Proceed with the Bucket design modifications in Pro/ENGINEER Wildfire. (These procedures may vary slightly, depending on the Pro/ENGINEER Wildfire version you are using.):

   a. Launch Pro/ENGINEER Wildfire and navigate to the **Tools/Server Registry**.

   b. Select **Add** from the **Server Register** window and enter a server **Name** and **Location**.

   c. Click **Check** to verify the server connection.

   d. After Pro/ENGINEER Wildfire has connected to the server, the list of products and projects to which the Supplier role has access is displayed. Select Bucket Update as the active project within this server. Select the **Name** you just provided and click **Set**.

   e. Select the **File/Open** command to navigate to the server and the Bucket Update project. Select the AL-Bucket part (AL-PDM-010-0007.prt) to open it.

4. Modify the AL-Bucket by changing the length to 110 and the cut pattern to 5.
Tip: If you are prompted to check out the object, accept the warning.

5. Once the modifications are complete, select **File > Check-in > Custom Check-in** to update the design changes in the project.
   a. Select **CAD Model** and **CAD Viewable** in the **Custom Check-in** window, and click **OK**. Click **OK** in the **Check-in** window.
   b. The Supplier's design modifications have now been checked into the Bucket Update project.

6. Exit Pro/ENGINEER Wildfire and return to Windchill ProjectLink to mark the Supplier task as complete.
   c. Select Update Bucket Design from the **Assignments** table on the home page to navigate to the task details page.
   d. Select **Update** from the **Actions** drop-down menu on the task details page (alternatively, click the **See Actions** link, depending upon your system configuration).
   e. Select **Resolution** from the **Step** list on the **Update Action Item** window to change the execution state to **Resolved**, and click **OK**.

At this point, the Supplier has completed the task of modifying the AL-Bucket design.

**Step 3. Submitting the Updated Bucket Design and Completing the ECN Task**

As the Engineering Manager, you are notified that the Supplier has completed the assigned design changes. In this step, you will submit the updated design to the PDM system and mark the ECN task as complete.

1. Log on to Windchill as Engineering Manager, and navigate to Windchill ProjectLink. Select the **Project** tab and the Bucket Update project.

2. Click the link on the AL-Bucket part (AL-PDM-100-0007.prt) and review the updated bucket design in Windchill ProductView.

   **Tip:** Before proceeding to the next step, select **PDM candidate check-in** from the **Current View** drop-down menu on the **Folders** table in order to restrict the display to those objects eligible for check in to the PDM system.

3. Select the AL-Bucket part (AL-PDM-010-0007.prt) and then select the **Send to PDM** action from the **Actions** list.

4. Accept the default settings in the check-in user interface and click the **OK** button to check the part back into the PDM system.

5. Navigate to your home page (in either Windchill PDM or Windchill ProjectLink) in order to mark the Supplier Design Update of Bucket task as complete.
a. Select the Complete ECN task in your Assignments table (Windchill ProjectLink) or Worklist (Windchill PDM), and click the link to the ECN in order to open it.

b. From the drop-down menu on the ECN page, select Update. Within the Update window, select the Implementation Plan tab and expand the Supplier Design Update of Bucket task. Select Add Resulting Items to search for the AL-Bucket part (AL-PDM-100-0007.prt) to add as the resulting item. Click OK to complete the operation.

Tip: This step identifies the objects resulting from AL-Bulldozer product design activities; later, all object modifications and new objects resulting from this effort will be published to your ERP system.

6. Navigate to the Complete ECN task for the modification of the bucket. Click the Task Complete button.

You have now completed the submission of the Supplier’s design changes and have marked the ECN task as complete.

**Task 4. Making Design Changes in the PDM System**

In a typical product development environment, there is a combination of concurrent design modifications occurring in the PDM system and in Windchill ProjectLink. This section demonstrates how, as a member of a product team, you can make design modifications within the PDM system in order to complete CMII change activities while other design activities are being performed in collaborative projects. In a later task, you will see how members of the project teams can be kept aware of changes occurring within the PDM system. For this task, you will be assuming the role of Engineer2.

1. Log on to the system as Engineer2.

2. Click the Worklist icon and the Complete ECN task with the name Seat and Toolbox Update.

3. Select the appropriate link on the Complete ECN Task form to display the ECN form.

4. Expand the Seat and Toolbox Update task in the list to review the details.

5. Proceed with the design modifications in Pro/ENGINEER Wildfire. (These instructions may vary slightly, depending upon the Pro/ENGINEER Wildfire version you are using.)

a. Launch Pro/ENGINEER Wildfire and navigate to the Tools/Server Registry.

b. Select Add from the Server Register window and enter a server Name and Location.

c. Click Check to verify the server connection.
d. After Pro/ENGINEER Wildfire has connected to the server, the list of products and projects to which the Engineer2 role has access is displayed.

e. Select Windchill PDM as the active product within this server. Select the Name you just provided and click Set.

6. From the Pro/ENGINEER Wildfire Folder Browser, select the server you created in order to open the server home page in the embedded browser.
   a. Navigate to your Worklist and review the Complete ECN task for modification of the seat and toolbox.
   b. Select the ECN Task link on the Complete ECN Task form to display the ECN.
   c. Expand the Modify Toolbox and Add Seat Cushion item in the task list to review the specific task details.

7. Select the (information) icon for the AL-Frame part listed in the task to navigate to the details page for the part, and then drag and drop it into your Pro/ENGINEER Wildfire user interface. This opens the AL-Frame assembly in Pro/ENGINEER Wildfire.

8. After the assembly has been opened in Pro/ENGINEER Wildfire, add the Cushion, PDM-010-0024.prt, located in the Library cabinet and assemble it to the seat.
   
   Tip: If you are prompted to check out the object, accept the warning.

9. Go back to your assembly and interchange PDM-030-0001.prt with PDM-030-0002.prt. (Assume that both components belong to the same interchange group.)

10. Once the modifications are complete, select File > Check-in > Custom Check-in to update the design changes in the product.
    a. Select CAD Model and CAD Viewable in the Custom Check-in window, and click OK. Click OK in the Check-in window.
    b. The seat and toolbox design modifications have now been checked into the AL-Bulldozer product.

11. Navigate to your Windchill PDM Worklist in order to mark the Seat and Toolbox Update task as complete.
    a. Select the Complete ECN task in your Worklist, and click the link to the ECN to open it.
    b. From the drop-down menu on the ECN page, select Update. Within the Update window, select the Implementation Plan tab and expand the Seat and Toolbox Update task. Select Add Resulting Items to search for the AL-Frame assembly (AL-PDM-100-0003.asm) to add as the resulting item. Click OK to complete the operation.
Tip: This step identifies the object resulting from AL-Bulldozer product design activities; later, all object modifications and new objects resulting from this effort will be published to your ERP system.

12. Return to the Worklist and select the Complete ECN task for the modification of the seat and toolbox. Click Task Complete.

You have now completed the submission of your design changes and have marked the ECN task as complete.

Task 5. Updating a Collaborative Project

This section provides further demonstration of the ways in which a project (created in Task 2) can be used as a collaborative environment for design changes that involve multiple users and organizations. Although the design modification tasks for this scenario have been performed sequentially, these tasks are typically performed concurrently in a production environment.

To begin this task, you will return to the Blade Removal project created in Task 2. The steps described below illustrate how changes that have occurred concurrently can be incorporated into the design changes of this project team. In addition, you will use the Pro/ENGINEER Wildfire embedded browser to perform common Windchill activities from within your Pro/ENGINEER Wildfire environment.

1. Log on to the system as Engineer1.

2. Launch Pro/ENGINEER Wildfire and navigate to the Tools/Server Registry.
   a. Select Add from the Server Register window and enter a server Name and Location.
   b. Click Check to verify the server connection.
   c. After Pro/ENGINEER Wildfire has connected to the server, the list of products and projects to which the Engineer1 role has access are displayed. Select Bulldozer Blade Removal as the active project within this server. Select the Name you just provided and click Set.

3. From the Pro/ENGINEER Wildfire Folder Browser, select the link to the server you created in order to open the server home page in the embedded browser. Select the Project tab and navigate to the Bulldozer Blade Removal project.

4. Click the Refresh Project icon to update shared objects for which design changes have been made in the PDM system. In the Refresh Project window, select all of the objects listed in the table, click the Set Refresh icon, and then
click OK. The shared objects in the project are updated to reference the latest iterations of the objects in the PDM system.

5. Select the URL for AL-Bulldozer, and drag and drop the AL-Bulldozer assembly into the Pro/ENGINEER Wildfire user interface. This opens the AL-Bulldozer in the Pro/ENGINEER Wildfire session.

**Tip:** If you are prompted to check out the object, accept the warning.

6. Right-click on Blade (PDM-010-0023) in the model tree and select Delete.

7. Once the blade is removed, select File > Check-in > Custom Check-in to update the design changes in the product.
   a. Select CAD Model and CAD Viewable in the Custom Check-in window, and click OK. Click OK in the Check-in window.
   b. The updated AL-Bulldozer assembly has now been checked into the Bulldozer Blade Removal project.

Now that the project team’s design changes are complete, the changes are ready for submission to the PDM system.

8. Exit Pro/ENGINEER Wildfire and return to Windchill. Navigate to the Bulldozer Blade Removal project.

9. Select the AL-Bulldozer assembly (AL-PDM-001-0001.asm) and then select the Send to PDM action from the Actions list.

10. Accept the default settings in the check-in user interface and click OK to check the assembly back into the PDM system.
11. Navigate to your Worklist in order to mark the Bulldozer Blade Removal task as complete.
   a. Select the Complete ECN task in your Worklist and click the link to the ECN to open it.
   b. From the drop-down menu on the ECN page, select Update. Within the Update window, select the Implementation Plan tab and expand the Remove Blade task. Select Add Resulting Items to search for the AL-Bulldozer part (AL-PDM-001-0001.asm) to add as the resulting item. Click OK to complete the operation.

   Tip: This step identifies the objects resulting from AL-Bulldozer product design activities; later, all object modifications and new objects resulting from this effort will be published to your ERP system.

12. Navigate to your home page and select the Complete ECN task for the modification of the bucket. Click Task Complete.

You have now completed the submission of the blade removal and have marked the ECN task as complete.

Task 6. Reviewing Changes and Publishing Updates to the ERP System

This task can only be completed if Windchill ESI has been installed and configured with an ERP system.

To complete this scenario, assume that you are again acting in the role of Engineering Manager and that your final tasks are as follows:

- Review all modifications made to the AL-Bulldozer design
- Review all new objects
- Assign distribution targets to the new objects
- Publish all changes to your ERP system

The following is a specific example of how you might complete these tasks. While this scenario assumes that all change activities have been completed satisfactorily, the change management capabilities and workflows in Windchill allow you to reroute objects that require additional changes.

Step 1. Reviewing the New Assembly

The following is a specific example of the steps involved in reviewing the work done to satisfy the ECN described in previous sections:

1. Log on as Engineering Manager and search for AL-PDM-100-0001.asm.

   Click the  (information) icon next to the assembly in the search results to access its details page.
2. On the AL-Bulldozer details page, click on the thumbnail icon to open Windchill ProductView. Review the modifications.

3. From your Worklist, select Task Complete for each of the Review ECN tasks related to bulldozer modification.

Step 2. Assigning Distribution Targets and Publishing to Your ERP System

The following is a specific example of how the completed design can be published to the ERP system:

1. Open the Product Information Explorer.

2. From within Product Information Explorer, select File > Open. Search for part AL-PDM-100-0001.asm and open it.

3. Assembly AL-PDM-100-0001.asm and its direct part children are now visible in Product Information Explorer. Apply steps 4 through 6 to AL-PDM-100-0001.asm, AL-PDM-100-0003, AL-PDM-100-0005, AL-PDM-100-0006, AL-PDM-100-0007, and AL-PDM-010-0007.

4. Select a part and then select the Selected > Define Distribution Targets menu. This opens the Distribution Targets page for the part.

5. Select Add Distribution Target, enter an asterisk (*) in the Name field, and click Search. From the search results table, select a distribution target (Berlin in this example). Click OK to complete the definition of the ERP instance to which the parts should be published.

Close the Distribution Targets page for the part.

6. The CMII change process requires that the Change Administrator III review and audit the ECN. Assuming that you are also acting as Change Administrator III, return to the Worklist page, select the Review ECN task, and, after completing your review, click Complete Task. Complete the same process for the Audit ECN task. This completes and releases the ECN.

Release of the ECN automatically releases all resulting objects and triggers publication to the ERP system.

7. If you have Business Administrator privileges or are logged in as wcadmin, you can go to Site Map > Business Administration > Enterprise Systems Transaction Log to see the publication transaction history. Alternatively, you can go to the details page for any of the released parts and click Distribution Targets to see that the part has been published.
Available Project Templates

The following table lists and describes the out-of-the-box templates available in Windchill ProjectLink:

<table>
<thead>
<tr>
<th>Template</th>
<th>Folders</th>
<th>Team Roles</th>
<th>Life Cycle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>Designs</td>
<td>Project Manager</td>
<td>Default</td>
</tr>
<tr>
<td></td>
<td>General Specifications</td>
<td>Reviewer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Guest</td>
<td></td>
</tr>
<tr>
<td>Custom</td>
<td>BOM Contracts</td>
<td>Project Manager</td>
<td>Default</td>
</tr>
<tr>
<td></td>
<td>Designs</td>
<td>Reviewer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>General Plans</td>
<td>Guest</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Prototypes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>References</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Requirement Specifications</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Standards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design</td>
<td>Contracts</td>
<td>Project Manager</td>
<td>Default</td>
</tr>
<tr>
<td></td>
<td>Designs</td>
<td>Reviewer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>General Plans</td>
<td>Guest</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Prototypes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>References</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Requirements</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Specifications</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Standards</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Template</td>
<td>Folders</td>
<td>Team Roles</td>
<td>Life Cycle</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------</td>
<td>-----------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>General</td>
<td>Contracts, Designs, General Plans, References, Reports, Specifications</td>
<td>Project Manager, Reviewer, Guest</td>
<td>Default</td>
</tr>
<tr>
<td>Manufacturing</td>
<td>BOM Contracts, Designs, General Plans, Prototypes, References, Reports, Requirements, Specifications, Standards</td>
<td>Project Manager, Reviewer, Guest</td>
<td>Default</td>
</tr>
</tbody>
</table>
Microsoft Project Object Mapping

The following table identifies how objects and attributes are mapped when exchanging information (importing and exporting) between Windchill ProjectLink and Microsoft Project:

<table>
<thead>
<tr>
<th>Microsoft Project Object</th>
<th>Attribute</th>
<th>Windchill ProjectLink Object</th>
<th>Attribute</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td></td>
<td>Project or Project Plan</td>
<td></td>
<td>Windchill ProjectLink has two top-level project objects—a project and a project plan.</td>
</tr>
<tr>
<td>Project title</td>
<td></td>
<td>Project name</td>
<td></td>
<td>Export from Windchill ProjectLink sets project title to the value of the project name or summary activity name.</td>
</tr>
<tr>
<td>Project subject</td>
<td></td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project author</td>
<td></td>
<td>Project creator</td>
<td></td>
<td>Export from Windchill ProjectLink sets project author to the value of the project or summary activity owner.</td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------</td>
<td>-----------------------------</td>
<td>-------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Manager</td>
<td>Project owner</td>
<td>Export from Windchill</td>
<td></td>
<td>ProjectLink sets project author to the value of the project owner.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ProjectLink sets project</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>author to the value of the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>project owner.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project company</td>
<td>Project</td>
<td>The name of the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>organization</td>
<td>organization under which</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>the project was created in</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windchill ProjectLink</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(the host organization).</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Export from Windchill</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ProjectLink maps project</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>organization to project</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>company.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Category</td>
<td>Currently, there is no</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>mapping between these</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>attributes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keywords</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hyperlink base</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>N/A</td>
<td>Template</td>
<td>This is the name of the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>template on which the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windchill ProjectLink</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>project is based.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N/A</td>
<td>Project</td>
<td>The project description is</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>description</td>
<td>a field that appears on each</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>page of the project in</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windchill ProjectLink</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project summary notes</td>
<td>N/A</td>
<td>The project summary notes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>notes are not exposed in</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windchill ProjectLink;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>however, this information</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>is maintained after an</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>import from Microsoft</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Project and available if</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>that plan is exported to</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microsoft Project in the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>future.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------</td>
<td>------------------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>N/A</td>
<td>Project scope</td>
<td>Project number</td>
<td>A field designed to reference a project account number or any number associated with a financial tracking application.</td>
<td></td>
</tr>
<tr>
<td>N/A</td>
<td>Business unit</td>
<td>Site</td>
<td>Field designed for the name of the business unit with which the project is associated.</td>
<td></td>
</tr>
<tr>
<td>N/A</td>
<td>Phase</td>
<td>Execution control</td>
<td>Represents the state of maturity of a project in its life cycle.</td>
<td></td>
</tr>
<tr>
<td>N/A</td>
<td>Manual</td>
<td>Automatic start of activities</td>
<td>In the manual mode, the project plan behaves just as it does in Microsoft Project. No activities are automatically started, and no tasks are automatically created and delivered to resources.</td>
<td></td>
</tr>
<tr>
<td>N/A</td>
<td>Automatic start of activities</td>
<td></td>
<td>In this mode, project activities are automatically started when all constraints have been satisfied, and e-mail notifications are sent out to assigned resources. No tasks are delivered to resources.</td>
<td></td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------</td>
<td>------------------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>N/A</td>
<td>Automatic start of activities and delivery of tasks</td>
<td>In this fully automatic mode, activities are automatically started when the start constraints are satisfied, and tasks are automatically created and delivered to each assigned resource.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creation date</td>
<td>Creation date (hidden)</td>
<td>Export from Windchill ProjectLink takes the value for creation date and maps it to the creation date in Microsoft Project. The creation date is not exposed in Windchill ProjectLink.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last modification date</td>
<td>Last modification date</td>
<td>Set by each application independently.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last access date</td>
<td>N/A</td>
<td>Not exposed in Windchill ProjectLink.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N/A</td>
<td>Initiation date</td>
<td>Defined as the date at which invitations were first delivered to the initial project participants.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start date</td>
<td>Estimated start date</td>
<td>Export from Windchill ProjectLink sets Microsoft Project start date to Windchill ProjectLink plan start date. Import is set by user option.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual start date</td>
<td>Actual start date</td>
<td>Export maps Windchill ProjectLink plan actual start to Microsoft Project actual start.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Schedule from date</td>
<td>N/A</td>
<td>All Windchill ProjectLink activities are by default scheduled from the plan start date.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------</td>
<td>-------------------------------</td>
<td>------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Start date</td>
<td>Start date</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Finish date</td>
<td>Start date</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Current date</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Finish date</td>
<td>Estimated finish date (calc)</td>
<td></td>
<td>Import using the Windchill ProjectLink start date will cause this to be calculated in Windchill ProjectLink. Import using the Microsoft Project start date will conserve the finish dates in Microsoft Project. Export will conserve the finish dates in Windchill ProjectLink.</td>
</tr>
<tr>
<td></td>
<td>Actual finish date</td>
<td>Actual finish date</td>
<td></td>
<td>Export maps Windchill ProjectLink plan actual finish to Microsoft Project actual finish.</td>
</tr>
<tr>
<td></td>
<td>N/A</td>
<td>Budget</td>
<td></td>
<td>Associated with project as a whole.</td>
</tr>
<tr>
<td></td>
<td>Planned cost</td>
<td>Planned cost (calc)</td>
<td></td>
<td>Not imported or exported-always calculated by both systems.</td>
</tr>
<tr>
<td></td>
<td>Actual accrued cost</td>
<td>Actual cost (calc)</td>
<td></td>
<td>Not imported or exported-always calculated by both systems.</td>
</tr>
<tr>
<td></td>
<td>% complete</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>% work complete</td>
<td>Done</td>
<td></td>
<td>Imported into Windchill ProjectLink plan as % done. Exported to Microsoft Project as % work complete.</td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------</td>
<td>------------------------------</td>
<td>-------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calendar</td>
<td>N/A</td>
<td>N/A</td>
<td>Not imported or exported-All Windchill ProjectLink calculations are associated with the common system calendar.</td>
<td></td>
</tr>
<tr>
<td>24 hour</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Night shift</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default standard</td>
<td>Default</td>
<td>Default</td>
<td>Not imported or exported-The default calendar settings in Windchill ProjectLink are those of the standard calendar in Microsoft Project.</td>
<td></td>
</tr>
<tr>
<td>Priority (0-1000)</td>
<td>Priority (0-1000)</td>
<td>Exported and imported.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard rate</td>
<td>Standard rate/hour</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overtime rate</td>
<td>N/A</td>
<td>Overtime rates are not exposed in Windchill ProjectLink.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date format</td>
<td>Based on locale</td>
<td>The displayed date format is automatically determined based on the locale set in the browser of the plan viewer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assignment units format</td>
<td>N/A</td>
<td>Windchill ProjectLink always uses percentage.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percentage</td>
<td>Percentage</td>
<td>Not exported or imported.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decimal</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duration entry units</td>
<td>N/A</td>
<td>All durations are expressed in days in Windchill ProjectLink.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minutes</td>
<td>Days</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------</td>
<td>-----------------------------</td>
<td>-----------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
<td>Days</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Days</td>
<td>Days</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Weeks</td>
<td>Days</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Months</td>
<td>Days</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Work effort entry units</td>
<td>N/A</td>
<td>All work effort is expressed in hours in Windchill ProjectLink.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Minutes</td>
<td>Hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hours</td>
<td>Hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Days</td>
<td>Hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Weeks</td>
<td>Hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Months</td>
<td>Hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default task type</td>
<td>N/A</td>
<td>All Windchill ProjectLink activities are defined as fixed duration tasks in MicroSoft Project.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed duration</td>
<td>Fixed duration</td>
<td>Fixed duration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed units</td>
<td>Fixed duration</td>
<td>Fixed duration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed work</td>
<td>Fixed duration</td>
<td>Fixed duration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New tasks start on</td>
<td>N/A</td>
<td>All Windchill ProjectLink activities start on Windchill ProjectLink plan start date unless otherwise constrained.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Project start date</td>
<td>Estimated start date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current date</td>
<td>N/A</td>
<td>Will be converted to planned start date.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------</td>
<td>-----------------------------</td>
<td>--------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>New task defaults</td>
<td></td>
<td>New task defaults</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Effort-driven</td>
<td></td>
<td>N/A</td>
<td>All tasks in Windchill ProjectLink are effort-driven.</td>
<td></td>
</tr>
<tr>
<td>Autolink on insert</td>
<td></td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Split in-progress tasks</td>
<td></td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Honor constraint dates</td>
<td></td>
<td>N/A</td>
<td>Export from Windchill ProjectLink sets this to true. Not imported.</td>
<td></td>
</tr>
<tr>
<td>Show that tasks have estimated durations</td>
<td></td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Durations are estimated</td>
<td></td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default fixed cost accrual</td>
<td></td>
<td>N/A</td>
<td>All Windchill ProjectLink costs related to activity work effort are accrued as actual effort is entered (prorated).</td>
<td></td>
</tr>
<tr>
<td>Prorated</td>
<td></td>
<td>Prorated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accrue at start</td>
<td></td>
<td>Prorated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accrue at finish</td>
<td></td>
<td>Prorated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Activity</td>
<td>Name</td>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Plan node ID</td>
<td>Plan node ID</td>
<td>Adjusted when importing Microsoft Project plans into a summary activity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Microsoft Project Object</strong></td>
<td><strong>Attribute</strong></td>
<td><strong>Windchill ProjectLink Object</strong></td>
<td><strong>Attribute</strong></td>
<td><strong>Comments</strong></td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------</td>
<td>----------------------------------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Contact</td>
<td>Owner</td>
<td>Owner</td>
<td></td>
<td>Import sets owner to value of contact field. If the contact field is not set then the owner is set to the resource. If there are multiple resources then the owner is set to the project owner.</td>
</tr>
<tr>
<td>Note</td>
<td>Description</td>
<td>Description</td>
<td></td>
<td>Export of description is complete. Import covers only the first line of the note.</td>
</tr>
<tr>
<td>Type</td>
<td>N/A</td>
<td>N/A</td>
<td>Fixed duration</td>
<td>All Windchill ProjectLink activities are mapped to fixed duration tasks</td>
</tr>
<tr>
<td>Fixed duration</td>
<td>Fixed duration</td>
<td>Fixed duration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed units</td>
<td>Fixed duration</td>
<td>Fixed duration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed work</td>
<td>Fixed duration</td>
<td>Fixed duration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Effort-driven (true/false)</td>
<td>True</td>
<td>True</td>
<td></td>
<td>All Windchill ProjectLink activities are mapped to tasks with Effort-driven value=true. Effort-driven value is set to true on export.</td>
</tr>
<tr>
<td>Scheduling ignores resource calendars (true/false)</td>
<td>False</td>
<td>False</td>
<td>All Windchill ProjectLink scheduling ignores resource calendars.</td>
<td></td>
</tr>
<tr>
<td>Resource list</td>
<td>Resource list</td>
<td>Resource list</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------</td>
<td>-----------------------------</td>
<td>---------------------------</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>Name</td>
<td></td>
<td>Resources are exported to Microsoft Project from Windchill ProjectLink. Upon import from Microsoft Project, attempts will be made to match defined resources to existing resources in Windchill ProjectLink. Any unmatched resources will be created in Windchill ProjectLink.</td>
</tr>
<tr>
<td></td>
<td>Units</td>
<td>N/A</td>
<td></td>
<td>The resource units are not exposed in Windchill ProjectLink; however, this information will be maintained after an import from Microsoft Project and available if that plan is exported to Microsoft Project in the future. Imported values will be used in cost computation.</td>
</tr>
<tr>
<td></td>
<td>Planned start date</td>
<td>Planned start date</td>
<td></td>
<td>Import using the Windchill ProjectLink start date will cause this to be calculated in Windchill ProjectLink. Import using the Microsoft Project start date will conserve the finish dates in Microsoft Project, which may require adjustments to the duration if the system calendars are different. Export will conserve the finish dates and durations in Windchill ProjectLink.</td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------</td>
<td>-----------------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>Estimated</td>
<td>N/A</td>
<td></td>
<td></td>
<td>Completed activities are exported from Windchill ProjectLink as not estimated. Unfinished activities are exported from Windchill ProjectLink as estimated. Not imported.</td>
</tr>
<tr>
<td>Planned finish date</td>
<td>Estimated finish date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent work complete</td>
<td>% Done</td>
<td></td>
<td></td>
<td>If Windchill ProjectLink project is defined to track cost, the percent complete is calculated based on the ratio of actual to estimated effort.</td>
</tr>
<tr>
<td>Actual duration</td>
<td>Actual duration</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planned effort (hours)</td>
<td>Estimated effort (hours)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual effort (hours)</td>
<td>Actual effort (hours)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority (0-1000)</td>
<td>Priority (0-1000)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Predecessors</td>
<td>Predecessors</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finish to start</td>
<td>Finish to start</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finish to finish</td>
<td>N/A</td>
<td>Ignored upon import from Microsoft Project.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start to start</td>
<td>N/A</td>
<td>Ignored upon import from Microsoft Project.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start to finish</td>
<td>N/A</td>
<td>Ignored upon import from Microsoft Project.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------</td>
<td>-----------------------------</td>
<td>----------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Lag</td>
<td>N/A</td>
<td></td>
<td>N/A</td>
<td>All lag values are mapped to zero from Windchill ProjectLink to Microsoft Project.</td>
</tr>
<tr>
<td>Constraint type</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>As soon as possible</td>
<td>As soon as possible</td>
<td></td>
<td></td>
<td>By default, all unconstrained dates are mapped to &quot;as soon as possible.&quot;</td>
</tr>
<tr>
<td>As late as possible</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finish no earlier than</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Finish no later than</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Must finish on</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Must start on</td>
<td>N/A</td>
<td></td>
<td></td>
<td>Upon import from Microsoft Project this is treated as a manually overridden start date. See manually overridden start date below for more detail.</td>
</tr>
<tr>
<td>Start no earlier than</td>
<td>Manually overridden start date</td>
<td></td>
<td></td>
<td>Upon import from Microsoft Project this is converted to a manually overridden start date. Export from Windchill ProjectLink is converted to start no earlier than constraint.</td>
</tr>
<tr>
<td>Start no later than</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deadline date</td>
<td>Deadline date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Microsoft Project Object</strong></td>
<td><strong>Attribute</strong></td>
<td><strong>Windchill ProjectLink Object</strong></td>
<td><strong>Attribute</strong></td>
<td><strong>Comments</strong></td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------</td>
<td>---------------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text 26</td>
<td>Risk</td>
<td></td>
<td>Risk</td>
<td>Imported from Microsoft Project as text26 field and exported as text26.</td>
</tr>
<tr>
<td>Text 25</td>
<td>Risk description</td>
<td></td>
<td>Risk description</td>
<td>Imported from Microsoft Project as text25 field and exported as text25.</td>
</tr>
<tr>
<td>Calendar type</td>
<td>N/A</td>
<td></td>
<td>N/A</td>
<td>Winchill ProjectLink will base all calculations on the system calendar.</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>Night shift</td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>24 hour</td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>WBS Code</td>
<td>N/A</td>
<td></td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td>Description</td>
<td></td>
<td>Description</td>
<td>The first line of text will be imported from Microsoft Project. The full description will be exported from Windchill ProjectLink.</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>N/A</td>
<td></td>
<td>N/A</td>
<td>A hyperlink can be created in the description field of a Windchill ProjectLink activity.</td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------</td>
<td>-------------------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>Summary Task</td>
<td>Summary Activity</td>
<td>Summary Activity</td>
<td></td>
<td>The same values as for tasks exist for summary activities. Status, percent complete or effort, duration and finish date, are rolled up from children to parent summary activity by default. Note: Start date is not rolled up from child activity. The summary starts as soon as any constraints are satisfied. That is, as soon as all preceding activities have completed and any fixed start date constraint is satisfied.</td>
</tr>
<tr>
<td>Milestone</td>
<td>Milestone</td>
<td>Milestone</td>
<td></td>
<td>A milestone in Microsoft Project that has children is converted to a summary activity when mapped to Windchill ProjectLink. A milestone in Microsoft Project that has resources assigned to it will be imported as a milestone in Windchill ProjectLink, and the resource assignments will be ignored.</td>
</tr>
<tr>
<td>Recurring Task</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
<td>Windchill ProjectLink does not support the automatic generation of recurring activities. Each activity must be individually created.</td>
</tr>
<tr>
<td>Resource</td>
<td>Resource</td>
<td>Resource</td>
<td></td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Initials</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>E-mail address</td>
<td>E-mail address</td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------</td>
<td>-----------------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td>Label</td>
<td>Label</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td>Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Work</td>
<td>Person</td>
<td>Person</td>
<td>Work</td>
<td>In Microsoft Project, a work resource is any resource for which work effort is tracked.</td>
</tr>
<tr>
<td>Material</td>
<td>Material</td>
<td>Material</td>
<td></td>
<td></td>
</tr>
<tr>
<td>N/A</td>
<td>Equipment</td>
<td>Equipment</td>
<td></td>
<td>Mapped to an Microsoft Project Work resource.</td>
</tr>
<tr>
<td>N/A</td>
<td>Facilities</td>
<td>Facilities</td>
<td></td>
<td>Mapped to an Microsoft Project Work resource.</td>
</tr>
<tr>
<td>Group</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Workgroup</td>
<td>N/A</td>
<td>N/A</td>
<td>Workgroup</td>
<td>Windchill ProjectLink provides e-mail notification of tasks when automatic start of activities and delivery of tasks is turned on.</td>
</tr>
<tr>
<td>Default</td>
<td>N/A</td>
<td>N/A</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td>N/A</td>
<td>N/A</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>E-mail</td>
<td>N/A</td>
<td>N/A</td>
<td>E-mail</td>
<td></td>
</tr>
<tr>
<td>Web</td>
<td>N/A</td>
<td>N/A</td>
<td>Web</td>
<td></td>
</tr>
<tr>
<td>Maximum units</td>
<td>Maximum units</td>
<td>Maximum units</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard rate</td>
<td>Standard rate</td>
<td>Standard rate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overtime rate</td>
<td>N/A</td>
<td>N/A</td>
<td>Overtime rate</td>
<td>An overtime rate attribute is defined for a resource per project in the Windchill ProjectLink database, but it is not exposed by default in the user interface.</td>
</tr>
<tr>
<td><strong>Microsoft Project Object</strong></td>
<td><strong>Attribute</strong></td>
<td></td>
<td><strong>Windchill ProjectLink Object</strong></td>
<td><strong>Attribute</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Cost per use</td>
<td>Cost per use</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Accrue at</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Prorated</td>
<td>Prorated</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Accrue at start</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Accrue at finish</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Base calendar</td>
<td>Standard</td>
<td>System calendar</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>24 hours</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Night shift</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Code</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Working calendar</td>
<td>N/A</td>
<td>No calendar is associated with a resource. All resource calculations are based on the working days defined in a single Windchill ProjectLink system calendar.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sub Project</td>
<td>Summary Activity</td>
<td>A sub project in Microsoft Project is mapped to a summary activity in Windchill ProjectLink. A sub project in Windchill ProjectLink is mapped to a summary activity in Microsoft Project.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Microsoft Project Object</strong></td>
<td><strong>Attribute</strong></td>
<td><strong>Windchill ProjectLink Object</strong></td>
<td><strong>Attribute</strong></td>
<td><strong>Comments</strong></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------</td>
<td>---------------------------------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Project Calendar</td>
<td></td>
<td>System Calendar</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Week starts on (day)</td>
<td></td>
<td>N/A</td>
<td>A single system calendar is defined for Windchill ProjectLink. There is no calendar associated with each project or each resource. All calculations for scheduling and effort are based on the working days in the system calendar.</td>
</tr>
<tr>
<td>Sunday</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monday</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tuesday</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wednesday</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thursday</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Friday</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Saturday</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fiscal year starts in (month of year)</td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>Default start time (click time + AM or PM)</td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>Default finish time (clock time + AM or PM)</td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td><strong>Microsoft Project Object</strong></td>
<td><strong>Attribute</strong></td>
<td><strong>Windchill ProjectLink Object</strong></td>
<td><strong>Attribute</strong></td>
<td><strong>Comments</strong></td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------</td>
<td>---------------------------------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Hours per day</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hours per week</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Days per month</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Custom Fields</strong></td>
<td></td>
<td>Windchill ProjectLink Use</td>
<td></td>
<td>Some of the custom fields in a Microsoft Project plan are used to capture Windchill ProjectLink information that cannot be mapped to existing MicroSoft Project plan objects. These custom fields are used to prevent the loss of information when editing and updating a Windchill ProjectLink plan in MicroSoft Project.</td>
</tr>
<tr>
<td><strong>Summary tasks, tasks, and resources</strong></td>
<td>Number20</td>
<td>Summary activities and resources</td>
<td>Windchill ProjectLink object ID (internal object identifier)</td>
<td>Imported from Microsoft Project number20 field for summary tasks, non-summary tasks and for resources and exported as number20.</td>
</tr>
<tr>
<td></td>
<td>Text20</td>
<td>Windchill ProjectLink Java class name</td>
<td></td>
<td>Imported from Microsoft Project text20 field for summary tasks, non-summary tasks, and resources and exported as text20.</td>
</tr>
<tr>
<td><strong>Summary tasks only</strong></td>
<td>Text30</td>
<td>Summary activities</td>
<td>Windchill ProjectLink server address URL</td>
<td>Imported from Microsoft Project text30 field only for summary tasks and exported as text30.</td>
</tr>
<tr>
<td><strong>Microsoft Project Object</strong></td>
<td><strong>Attribute</strong></td>
<td><strong>Windchill ProjectLink Object</strong></td>
<td><strong>Attribute</strong></td>
<td><strong>Comments</strong></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------</td>
<td>---------------------------------</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Text29</td>
<td></td>
<td>Windchill ProjectLink class path to import.jsp /netmarkets /jsp/ msproject/ import.jsp</td>
<td></td>
<td>Imported from Microsoft Project text29 field only for summary tasks and exported as text29.</td>
</tr>
<tr>
<td>Text21</td>
<td></td>
<td>Windchill ProjectLink project name</td>
<td></td>
<td>Imported from Microsoft Project text21 field only for summary tasks and exported as text21.</td>
</tr>
<tr>
<td>Text19</td>
<td></td>
<td>Name of Windchill ProjectLink plan node associated with project edit, import, or export of Microsoft Project plan</td>
<td></td>
<td>Imported from Microsoft Project text19 field only for summary tasks and exported as text19.</td>
</tr>
<tr>
<td>Tasks only</td>
<td>Text28</td>
<td>Activity</td>
<td>List of deliverable identifiers associated with activity (internal Windchill ProjectLink object IDs)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Text27</td>
<td>E-mail address of task owner</td>
<td></td>
<td>Imported from Microsoft Project text27 field only for non-summary tasks and exported as text23.</td>
</tr>
<tr>
<td>Microsoft Project Object</td>
<td>Attribute</td>
<td>Windchill ProjectLink Object</td>
<td>Attribute</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------</td>
<td>-----------------------------</td>
<td>-----------</td>
<td>---------</td>
</tr>
<tr>
<td>Text26</td>
<td></td>
<td>Risk value for task (Very high, high, medium, low, very low)</td>
<td></td>
<td>Imported from Microsoft Project text27 field only for non-summary tasks and exported as text27.</td>
</tr>
<tr>
<td>Text25</td>
<td></td>
<td>Activity risk description text</td>
<td></td>
<td>Imported from Microsoft Project text25 field only for non-summary tasks and exported as text25.</td>
</tr>
<tr>
<td>Text24</td>
<td></td>
<td>Activity status value unavailable, green, yellow, red</td>
<td></td>
<td>Imported from Microsoft Project from text24 fields only from non-summary tasks. Exported to text24 field.</td>
</tr>
<tr>
<td>Text23</td>
<td></td>
<td>Activity status description text</td>
<td></td>
<td>Imported from Microsoft Project text23 field only for non-summary tasks and exported as text23.</td>
</tr>
<tr>
<td>Text22</td>
<td></td>
<td>Activity execution state (defined, running, suspended, resumed, terminated, cancelled)</td>
<td></td>
<td>Imported from Microsoft Project text22 field only for non-summary tasks and exported as text22.</td>
</tr>
</tbody>
</table>